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Welcome 

Welcome to Motion Works ADDmotion II - a powerful, easy-to-usc 
media integration programfor HyperCard. Whether you are a novice 
or an expert in creating interactive animations, multimedia presenta­
tions or training applications, ADDmotion II offers you the tools you 
need to get professional, high-quality results in a fraction of the time 
and cost of other products, and best of all it's integrated with Hyper­
Card. 

Designed by award-winning multimedia professionals, ADDmotion 
II provides the ideal interactive communication tool for the '90s. Its 
extensive import and export capabilities make it a flexible content 
media tool for use with other applications. You can import and 
modify existing content using ADDmotion II's impressive 24 Bit 
Color Paint and Sound Editors with just a few clicks of the mousc. 
This new media can then be easily incorporated into an animation 
using the Media Controller, Cel Sequencer, TimeLines window and 
Path editing tools. You can also add interactivity without being a 
programmer because ADDmotion II guides you every step of the 
way. The program's intuitive pop-up menu-driven scripting lan­
guage makes syntax errors impossible and allows you to concentrate 
on building your animation. The resulting animation can then be 
exported to a variety of playback formats. 

You will find that ADDmotion II works equally well with System 
6.0.7 or System 7 operating software. ADDmotion II is completely 
compatible with Motion Works' ADDmotion software and with 
PROmotion 1.0. This provides ADDmotion and ADDmotion II uscrs 
with an upgrade path to PROmotion for those who need to create 
animations and presentations outside the HyperCard environment. 

About This Manual 
This manual is divided into the following 10 chapters: 

Chapter 1: Getting Started tells you how to become a registered uscr 
of ADDmotion II, what hardware and system software you will need 
to run the program, how to install the program and media content 
provided, and how to use the Help features. 

Chapter 2: Introduction to Multimedia and Animation introduces 
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you to some of the uses for mu~tim~ia, outlines ~he basic conc~pts 
and principles of traditional arumatlon and descnbcs ADDmotion 
II's main program features and tools. 

Chapter 3: Tutorial guides you through a self-paced tutorial where 
you learn how to create an interactive animation for a sample pres-
entation. 

Chapter 4: Paint Tools describes how to use ADDmotion II's Paint 
tools and basic effects. You also learn how to create new actors by 
modifying media content. 

Chapter 5: Paint Options introduces you to a number of ad vanced 
Paint tools. 

Chapter 6: Creating Actors, Props and Sound Effects gives step-by­
step instructions on creating content for your animations. 

Chapter 7: Creating an Animation describes how to combine all of 
the media content into an animation using the Media Controller, Cel 
Sequencer and TimeLines window. 

Chapter 8: Sound Editing tells how to modify sound effects using the 
built-in sound recording and sound effects editing software. 

Chapter 9: Menus and Dialogs documents the use and function of all 
menu items and dialogs not described elsewhere. 

Chapter 10: Tips and Techniques teaches you how to use some of 
ADDmotion II's advanced features to create complex, interactive 
animations and QuickTime movies. HypcrTalk scripting and ad­
vanced Cues are also described. 
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Chapter 7: Getting Started 

This chapter explains: 

• How to become a registered user of ADDmotion II 

• The ADDmotion II package contents 

• What hardware and system software you will need to run 
ADDmotion II and HyperCard V2.1 

• Preparations before you install the software 

• How to upgrade from ADDmotion V1.0 

• How to install ADDmotion II software on your hard disk 

• How to set HyperCard's Application Memory Size 

• How to register and install ADDmotion II Scripts into the 
HyperCardV 2.1 Home stack using the ADDmotion II installer 

• How to remove ADDmotion II from your hard disk 

• How to use the Help features 

Becoming a Registered User 
Complete and mail your registration card! In order to provide you 
with technical support, assign you a serial number and let you know 
about upgrades to the program, we need to know who you arc. 
Please fill out the Product Registration card now and promptly mail 
it to Motion Works. It is included with the ADDmotion II package in 
the pouch containing your program disks. Please also take the time 
to fill out the short questionnaire. Thank you in advance for your 
prompt response. 

Technical Support 
Motion Works will provide you with free technical support for a 
period of 90 days after we have received your registration form. 
Please have your technical questions ready before calling. It will save 
time if you have double-checked your system hardware and soft­
ware and have checked the manual to see if there is an answer to the 
problem. 

Technical support hours are 9:00 AM to 5:00 PM Monday through 
Thursday and 9:00 AM to 3:00 PM Friday, Pacific Standard Time. 

Chapter 1: Getting SlQrttd 1 



Please have the following information ready when you call Motion 
Works Technical Support. 

Version of ADDmotion II: ______________ _ 

Version of HyperCard: ______________ _ 

HyperCard Application Memory Size (see page 5) _____ _ 

Macintosh Model: --------------------
RAM (Memory): ______________________________ _ 

Hard Disk: ____________________ _ 

System Version: __________________ _ 

Finder Version: 

Printer: 

Other Hardware: __________________ _ 

Expansion Boards & Slot Number: ___________ _ 

System [NITs (System Extensions): __________ _ 

Control Panels and Desk Accessories: __________ _ 

Other XCMDs installed: ______________ _ 

Network Type & Software Version: ___________ _ 

ADDmotion 1\ Package Contents 

Your ADDmotion II package contains: 
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• Disk pouch 

• ADDmotion II Manual (you're reading it now) 

• Miscellaneous information inserts 

The disk pouch includes: 

• Product Registration card 

• ADDmotion II Program disk 

• ADDmotion II Tutorial disk 

• HyperCard 2.1 disk containing the HyperCard 2.1 program and 
the Home stack 

• Media Sampler disk 

• Principles of Animation disk 



H any items are missing from your package, please make a list of 
these items and contact Motion Works U.S.A. at (415) 541-9333 
or send a fax to (415) 541-0555 (please include your name, 
address, and telephone and fax numbers.) 

Media Sampler Disk 
Motion Works wants to provide you with enough media content 
(Actors, Props and Sounds) to get you up and running quickly using 
ADDmotion II, so we have included the Media Sampler disk with 
this package. The Media Sampler stack on the disk contains Actors, 
Props and Sounds that can be used in your animations. You are 
welcome to use them as is or modify them to suit your individual 
requirements. 

Motion Works' Prime Time contains over 100 Actors, Props and 
Sounds which can be imported into your presentations, as well as 
several samples of animation and multimedia. This clip-media 
collection covers the fields of business, education and entertainment 
and is available on CD ROM or BOOK disk. It can be ordered from 
Motion Works or purchased from your ADDmotion II dealer. 

Hardware and System Software 
You can use ADDmotion II on any model of Macintosh computer 
that has a hard disk and a minimum of 2 MB memory available to 
HypeICard. 

Required System Version: 
System 6.0.7 and Fmder 6.1.7 or a newer version are required to use 
ADDmotion II. The 32 Bit QuickDraw V. 1.2 (System File) is re­
quired for Color under System 6.0.7. 

To check your System software, choose About the Finder from the 
Apple Menu. 

IIbout t"o Moelntos". Finder'" 

, ...... : '.1.1 L ............. '." .... ..... 
... _: '.0.7 ...... ~Ior ..... I __ ,. 

,.t.I _.: 2.-
!3,,,,,,, '~'2IC .:~>****>:.;.J 1!iI.,- 2161( E 
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Required HyperCard Version 
Running ADDmotion II requires HyperCard 2.1 or greater. We 
recommend that you use the version of HyperCard and the Home 
stack provided in the ADDmotion II package. 

Required Memory - Black and White 
Running HyperCard and ADDmotion II in black and white requires 
2MB of memory. You can create small animations in 1200-1500K of 
memory, but you may encounter low memory problems. 

Required Memory - Color 
Running HyperCard and ADDmotion II in color requires 4MB of 
memory using System 6.0.7 and Finder 6.1.5. It requires a minimum 
of 4MB of memory using System 7, but Motion Works recommends 
that you have 4 MB to 8MB of memory for larger animations. 

Virus Protection Programs and ADDmotion II 
ADDmotion "manipulates resources within HyperCard stacks and 
some virus protection programs (usually INITs) do not allow for this. 
To combat viruses, developers of many virus protection programs 
have made them more sophisticated by checking to see when re­
sources are being changed, etc. and then alerting the end-user. The 
end-user can then decide whether it is OK to allow the changing of 
the resources. Consequently, Motion Works has found that some 
virus protection programs work fine with ADDmotion " while some 
don't. You will have to experiment with the virus protection program 
that you use to determine its compatibility. 

We have found that Disinfectant 2.]TM or greater and SAM IITM 
(Symantec Utilities) to be the best protection that will work with 
ADDmotion II, but there may be other programs that work equally 
well. 

There arc a few things to look for if ADDmotion II and the virus 
protection program that you usc do not co-operate. The main prob­
lem that you will encounter is a system error when you try to choose 
New Animation or Open Animation from the File menu. ADDmotion 
II creates or changes a resource file when you try to usc either of 
these commands and if any problems exist between ADDmotion II 
and your virus protection program it will probably happen here. If 
this happens, turn the virus protection program OFF and try to usc 
either of these commands again. This should solve the problem. If 



animation objects start to disappear (Actors or Props), or if they 
don't behave as expected or according to the manual, there could be 
a conflict between ADDmotion If and your current virus protection 
program. If so, tum off the virus protection before using ADDmotion 
II. 

Remember to tum your virus protection program ON after you are 
finished using ADDmotion II. If you have problems, call Motion 
Works TecfuUcal Support at (415) 541-9333. 

Setting HyperCard's Application Memory Size 
If you are running ADDmotion II using System 7.0 or MultiFinder, 
you may want to change HyperCard's Application Memory Size. 
The following shows the Application Memory Size set at lOOOK and 
then set at 4500K. 

HyperCard Info _ HyperCard Info 

~ ..,,...-c ... ~ ..,pwe •• 

1C'-4: whe.'1IOft".,...,. • .. : .. ttc.tlltnpr .... tm 

Siu: 1OIK ... 41S1r:(7t7.728btj'~I,d") ., .. : lOtI( ... fisk (711,128 .,.tH ...... ) 

'liMn. K.Ir" DISII ... ,.re ..... V~.; H ...... O ..... ptr"C ...... 

Cr •• t ... : t1on.~ U.I~I.2.5",", Cr •• t~; """'.H-. 13, ''''',:: 4'''''' 
""'''''4: Mon,....., 13, ''' •. 2 4:5 PM " ... .,104: -.Mov 13. I~I. 2 ~1'11 
yH .... ; ..,,....C.,.. 2 I V .... t..! .... PKC .... 2.1 

~1987·91 .,. ... COf'I'IPU'"'. he ()IM7·,1 ..." .. c.r.ut .... ~ 
C ........ : C ......... : 

~ I ~ I 
-......... ,- -- . - r-' , 
I ~,td ••• 1,000 K s.."..... .... I,DOD • J 

Dl ...... I ~M'.II. _~tC 1 OL ...... t Cwnnt ••• _~K 
---~- --

To change the Application Memory Size, highlight the HyperCard 
Application Icon and choose Get Info from the File menu. The 
Application's Get Info box appears. Enter the desired memory size in 
the Application Memory Size (K) box as indicated above, then click 
the close box. The application's memory size will be set for use with 
MultiFinder. If you are having trouble using HyperCard and 
ADDmotion 1\ with other applications while in MultiFinder, allocate 
more ml'mory to HyperCard or close an application. Large color 
animntions will require (4-8 MB of RAM) more memory. 
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Before You Install the Software 
Before you install the disks from the ADDmotion II package, make 
sure that your hard disk contains only one System folder with one 
System and Finder, and only one copy of HyperCard. Make sure to 
copy HyperCard 2.1 from your ADDmotion II package if the one on 
your hard disk is an earlier version. 

To use ADDmotion II most effectively, you should be familiar with 
your Macintosh. Specifically, you should know how to: 

• Set up and use your Macintosh, including mouse techniques 
such as clicking, pointing, dragging, selecting and choosing 
commands from pull-down and pop-up menus 

• Copy files and folders from a floppy disk to a hard disk 

• Make backup copies of floppy disks 

• Work with Macintosh windows such as open, close, scroll, move, 
select and resize. Editing text is also necessary. 

If you are not familiar with the basics of the Macintosh refer to the 
Macintosh Owners Guide. 

Before you copy the disks contained in the ADQrnotion II package, 
you should make backup copies of them in case they are lost or 
damaged. You are authorized to make one backup copy of each 
ADDmotion II disk included in your package. After copying the 
disks, store the originals in a safe place. That way, should anything 
happen to your working disks, the originals will still be intact. 

IMPORT ANT: Do not use the ADDmotion II package disks as working 
disks. Be sure to name each backup disk using the same name as the original 
disk. 

Copying ADDmotion II Onto Your Hard Disk 

6 ADDmolwn 1/ Manual 

Approximately 25MB of hard disk space is required to copy the 
ADDmotion II program and tutorial onto your Macintosh. An addi­
tional 2.5MB is required to copy the Media Sampler and Principles of 
Animation HyperCard stacks. Be sure that your hard disk contains 
enough empty space before starting. 



ADDmotion II Program 

ADDmotion Il.sea 

Jt 
Animate .He Ip 

To copy the ADD motion II Program Onto Your Hard Disk: 
1. Ensure that the ADDmotion II Program disk is locked, then 

insert it into your floppy disk drive. 

2. Double-click the ADDmotion II Program disk icon. 

The contents of the ADDmotion II Program disk appear in a 
window on your screen. 

RDDmollon II Program_ell 
IItftn 

12 

00 
ADOrnotlan II .... 

:0 
¢I l<:i'2l 

3. Double-click the ADDmotion lI.sea icon. 

This is a self-extracting archive and you need only to select a 
destination for the ADDmotion II files. The Select Destination 
Folder dialog appears. 

Selee I Des I/nal/on r older. 
lei HyperCard .... 1 

~ 

10 

=Hard Dllk 

[ [Jpcl ) 
( Desklop I 

I hlrael , 
[ancel I 

4. Select the HyperCard folder on your hard disk as the 
destination, then click Extract. 

The AutoExtractorThl dialog appears and the following items are 
extracted: the Animate.Help file and the ADDmotion II file. 

5. Once the extraction is complete, open the HyperCard folder and 
drag the Animate.Help file into your System folder. 

For those using System 7, place it in either your Preferences or 
your Extensions folder. 
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ADDmotion II Tutorial 

ADDmotion II Tutorial 

Media Sampler 

Media Sampler .sea 

To copy the ADDmotlon II Tutorial Onto Your Hard Disk: 
1. Ensure that the ADD motion II Tutorial disk is locked, then 

insert it into your floppy disk drive. 

2. Double-click the ADDmotion II Tutorial disk icon. 

The contents of the ADDmotion II Tutorial disk appear in a 
window on your screen. 

R[lDmolion II Tulorlal 

1 "om 
19 

LJ 
ADOmotb'l II TIItor'" 

10 
01 I¢IQ: 

3. Drag the ADDmotion II Tutorial folder icon into the HyperCard 
folder on your hard disk. 

The folder is copied onto your hard disk. 

To copy the Media Sampler Onto Your Hard Disk: 
1. Ensure that the Media Sampler disk is locked, then insert it into 

your floppy disk drive. 

2. Double-click the Media Sampler disk icon. 

The contents of the Media Sampler disk appear in a window on 
your screen. 

Media Sampler 
1_ 

~ 

00 
11od\o~"' .... 

R3 
01 112l 

3. Double-click the Media Sampler.sea icon. 

This is a self-cxtracting archive and you need only to select a 
destination for the Media Sampler stack it will create. The Select 
Destination Folder dialog appears. 
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Principles of Animation 

~ 
The Principles of Animation 

Soloct ao,tlnotlon Folder. 
lei Hgpertor ..... I 

D HOOmo Uon II 
o RDDmotion II Jutortol 
D Homp 
<.II HIJPl'd ... d 

IQ = lord II.k 

I fJoCI 

I aOlkto, 

I (HtroCt , 

() I [on,ol I 
~----------------~ 

4. Select the HyperCard folde1' as your destination, then click 
Extract. 

The AutoExtractor™ dialog appears and the following item is 
extracted: the Media Sampler stack. 

NOTE: If you are using Q color monitor, ensure tlult it is set to at ktzst 
256 colors before viewing the content provided in the Medill Sampler 
stack. 

To copy the Principles of AnlrnaHon Onto Your Hard Disk: 
1. Ensure that the Principles of Animation disk is locked, then 

insel't it into youx floppy disk drive. 

1. Double-click the Principles of Animation disk icon. 

The contents of the Principles of Animation disk appear in a 
window on your screen. 

-=- Prtadple. of RnlmoUon 1_ 
IY 

~ no ........ .,_ 

10 
101 Ie:: 

3. Drag the Principles of Animation stack icon into the HyperCard 
folde1' on your hard disk. 

The stack is copied onto your hard disk. 
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Upgrading from ADDmotion V 1.0 
--- --------

If you do not currently have ADDmotion V1.0 installed on your hard 
disk, skip to the next section, Registering and Installing ADDmotion II. 

If you currently have ADDmotion V1.0 installed on your Hard Disk: 

1. Register and Install ADDmotion II as explained in the next 
section. 

Note the small change in the installation procedure in step 4. 

2. You can now dispose of the ADDmotion stack. 

See your Macintosh manual for more information. 

3. Update the AMLoad, AMPlay, AMRelease XCMDs. 

T() Update the AMLoad, AMPlay, AM Relcase XCMDs in each of 
Y(llir ADDmotion V 1.0 stacks, cre.ltc' a new anim.ltion and place 
,111 Actor (lr Prop in it. Close the Animation. This process 
automiltically updates the XCMD's. The new animation can now 
be rcmoved if it is unwanted . 

.t. Send in your ADD motion II registration card. 

Registering and Installing ADDmotion II 

ADDmotio:,n II 

After copying ADDmotion II onto your hilrd disk, follow these steps 
to register and install it. 

1. Double-click the ADDmotion II icon on your hard disk. 

The iollowing installation screen appears. 

ADHDMO"ON n 
AniM.tion and c ...... P.int for Hw....c·rd 't\ If 
nODmotion II Is NOT In~talled. 

",[.I(lI-IOT IOf. II i5 • ,ommircl<il pt'OrJvc\ 
DO "01 DISTRIBUT£ 
\~ I'_-'~n - 1 ~'j2 r lOTION ""Oklo'.:; 
T.O".,,,.lS'JWurl (,604)6SS'YHS 
....... "",', I 0 

~ 
lIome 

)) f_-,-U_U'_'_ 

JII /If )/JII/o/lml If MtlllUtl1 



You are now asked to enter your name to personalize your copy of 
ADDmotion II. 

Personalize your coPy of RDDmotion II. 

Name: 

I( OK ]) ( Cancel) 

2. Enter your name, then click OK (clicking Cancel quits 
ADDmotion ll). 

You are asked to enter your organization's name. 

Personalize your coPY of RDDmotion II. 

Organiza lion: 

(001 [ (ancel J 

3. Enter your company's name if you wish, then click OK 
(personalizing your copy of ADDmotion II by organization is 
optional). 

You have now completed registering your copy of ADDmotion II. 
You are retumed to the installation screen. 

4. Click Install (if you have ADDmotion Vl.O already installed 
into your Home stack, the Install button appears as an Update 
button). 

The Install dialog appears. 

InslallllDDmolion II Inlo HyperCard Home7 

NOTE: By installing ADDmotion I/, your Home card stack script is 
//Iudi/ied. An ADDrnotion 11 call is added to the Startup handler anti an 
ADDmotion II script is appended to the end of the stack script. A billion is 
placed OTl the first card of your /-lome stack that tosgles ADDmotioll JJ on 
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and off. The actual ADDmotion II stack resources - the animation, color 
paint and sound resources - are used through a "start using" call. 

5. Click Yes to proceed with the installation (clicking No will stop 
the installation and leave your Home stack untouched). 

) l 1\ (J(!mo/I/ll/ /I MIII/uill 

When you click Install, the ADDmotion II installer installs the 
scripts and path infonnation necessary to run the program. 

The HyperCard Home stack appears. 

'-.fyperCArd i •• unique .aft".1'e loolth.t .. l1o,",s 
!'-"IU to d., mol'!: "itb yourcompuler 

With HyperCll'd.JDU (fin u!Ie"sman 'documenh 
called..as. Slaclt.nn he.lpJOu do manydiffl'n"nt 
thanp-flJr eumple.. you could use • I'.'\. h1l.eep 
track of your .ppomtmenlS. manae;e your npenst'S. 
learn. newlansuar;e. or play mu.1C from an .who 
c~mPl'c1 ttl .. A few s1acks an Included hprP to set 
yuu started. The l-f:\G!:rCtm By!n booklet explains 
hoff' to UR them. You tan obtain &ddlh~'n.l stach 
hurT. Apple dealen.nod ulerp.!ps 

6. The ADDmotion II icon appears on the first card of your Home 
stack. Click the mouse to set the icon location. 

The following dialog appears. 

7. Click OK. 

HOOmotion II CIIn be turned on lind off by 
clicking the ROOmolion II Icon in your Home 
stllck. HDDmolion II Is cunen tly on. 

I OK 

The ADDmotion II installer continues to install the resources 
needed. When the installation is complete, the following dialog 
ilppears. 

Insldlllliion success lui. 

n OK D 



8. Click OK. 

NOTE: If at any point in the installation procedure you are told that the 
installation was unsuccessful, check to see that you are using HyperCard 
V2.1 and the Home slack provided with your ADDrnotion 11 package. 

When ADDmotion II is installed, your HyperCard File menu 
changes to reflect the additions that ADDmotion II has made. 

. [dit Go Tools 
New Slack ... 
Open Slack... XO 
"ose S tllr.k :.:1lI 
Saue a Copy ... 

New Rnimalion .. . 
Open Rnlmalion .. . 
link Animalion .. . 

Compact StocK 
Prolecl SIOCK ... 
Delele Slack ..• 

Page Setup .. . 
Pr'nl Field .. . 
Prinl Card XP 
Prinl Slock ... 
Print Report... 

Quit HyperCard XQ 

} 

Turning ADDmotion II On and Off 

ADDmotion II 
additions 

ADDmotion II can be turned on and off at any time by clicking the 
ADDmotion II icon in your Home stack. When ADDmotion II is 
running, its icon in your Home stack looks like this: 

ADDmotion II 

Click on this icon to tum ADDmotion II off. When ADDmotion II is 
not running, its icon looks like this: 

~ , 
,,~% 
~ 

ADDmotion II 
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Removing ADDmotion II 
If you want to remove ADDmotion II permanently: 

1. Double-click its stack icon. 

The following screen appears. 

AD"DM01,ON n 
Ani",ation and Calar .... int for H",eo<anl ~ i); 

RDDmotion II is now installed. " 

Licensed to: Peter Brown 
Organizalion: Motion Works 

.... C["OHOT ION II ;s ~ cornm.,..ci~l product 
['0 NOT DISTRIBUT[ 
.;) 1989 - 1992 I"lJT1ON 'w"ORKS 
TtchOlc.1 Support: (604) 6a5 9975 
Yforsl0n 1 0 

2. Cl ick Remove. 

'# 
Home 

n R emo LIe )] [,--_Q-,-U_it_--, 

The Remove ADDmotion 11 dialog appears. 

RemoLle RDDmolion II from HyperCard Home? 

L-_N_o __ --'I I~[===ye=$==~) 

3. Click Yes to remove the scripts, path information and icon from 
your HyperCard Home stack. 

Using the Help Features 
-------------------------------------

Balloon Help 
ADDmotion II supports System 7's Balloon Help. It enables you 
to see descriptions of objects on the screen. 

To use Balloon Help: 

I: ? J 1. Choose Show Balloons from the Help menu. 
~-

2. Position the pointer over an object on the screen - such as an 
icon, a button, or an option in a dialog box. 



A description of the object pops up as a "balloon." 

This tool 'is us.d to 
f't" Ufo parts of tnt 
m~. Doub"'-chck 
to .,. ii~ th. MtJr. 
mog. 

3. You can turn off the balloons by choosing Hide Balloons from 
the Help menu. 

Animated Help 
Animated Help is available for all tool icons and buttons in the 
Media Controller and Paint palette. 

To view the Animated Help: 

1. Place the cursor over the icon or button you want described. 

2. Press and hold the Option-Command keys while clicking and 
holding down the mouse button. 

A visual description of the tool or button pops up and Jnil11Jtcs 
until you release the mouse button. 
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Chapter 2: Introduction to Multimedia and 
Animation 

This chapter introduces you to multimedia and some of the basic 
principles of traditional animation, as well as ADDmotion II's 
approach to animation. 

The best way to learn how to use any program is through explora­
tion. Don't hesitate to try out different techniques when reading 
through this guide. 

Multimedia 

Multimedia combines words, sounds and images to communicate in 
a more persuasive way than any single method can achieve. In the 
fonns of film and television, multimedia has been around for many 
years. Multimedia based on personal computers now allows for the 
user's interaction which in tum increases attention, understanding 
and retention of the information being communicated. With compu­
ter animation programs like ADDmotion II, you can integrate and 
control the various elements of multimedia to make your presenta­
tions more interesting and convincing. Multimedia provides an 
opportunity to learn by doing. 

ADDmotion II makes use of all the elements that make up multime­
dia presentations. From within the program you can create text, 
graphics and animation. You can also import still video, full motion 
video, and sound - all elements of advanced multimedia. 

Potential Uses for Multimedia 
The potential uses for multimedia are unlimited. However, multime­
dia based on personal computers has mainly been applied within the 
following four areas: 

• Education and training 
• Point-of-sales 
• Point-of-information 
• Diagnostics and guidance 
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Education and Training 
Multimedia applications are frequently used in classroom education 
in schools and universities, online job assistance, personal training, 
distance learning and equipment set-up and operation. A multime­
dia education or training application provides the following oppor­
tunities: 

• High flexibility 
• Ease-of-use for professional education or training 

• Increase in understanding and retention of information 

• Easy student administration 

Point-ot-sales 
Multimedia point-of-sale applications are used by the retail, real 
estate, tourism, banking and insurance professions. The purpose is to 
give a professional presentation of the products and services of the 
individual company. Multimedia helps customers in their purchase 
decision-making and provides the following advantages: 

• Easy-to-use, professional and consistent infonnation 

• Self-service, inside and outside the branch 

• 24-hour service 
• Dynamic selection of presented information (user-controlled interac­

tion) 

• Gathering of infonnation for analysis or marketing purposes 

Point-of-information 
Multimedia applications arc now implemented in the public sector 
as well as in the private sector. For example, they can be found 
within libraries, hotels, hospitals, museums, public parks, public 
offices, transportation facilities and tourism information facilities. 
Point-of-information multimedia provides users with many conven­
iences: 

)(1 IlO[)mo/ion II Mal/ual 

• Easy-to-use, professional and up-to-date infonnation 

• Self-service, inside and outside the branch 
• 24-hour service 

• Dynamic selection of presented infonnation (user-controlled interac­
tion) 



Diagnostics and Guidance 
Multimedia applications are used to make diagnoses, error correc­
tions and equipment service in hospitals, airlines, engineering and 
industrial service. They provide the following opportunities: 

• Professiontll and up-ta-date information 
• Correct, fast diagnosis and error correction 

• Flexibility 
• Training opportunities - increase in understanding and retention of 

information 

Animation 

Animation at its most basic is a series of drawings strung together to 
create the illusion of movement. In the hands of artists, the tech­
niques of animation have been used to produce beautiful works of 
art. Animation is only limited by the imagination and skills of its 
creators. The rudiments of animation can be taught relatively 
quickly. What is required then is patience, commitment and effort to 
make the basic principles come alive with fresh ideas. 

Traditional Animation Process 
Traditional animation requires a team of cooperative artists. It 
demands a collective, creative approach, within which the individual 
members must hannonize and communicate well with the others for 
the final product to be successful. Because so many people are 
involved in producing a single piece of traditional animation, its 
creation is very costly. 

A good understanding of the concepts and tenninology of the 
traditional animation process will help you to plan a satisfactory 
finish<.'<l product and avoid last minute fixing. No matter how 
modest or ambitious the project, the traditional animation process 
follows a number of structured procedures. 

Script 
The script is the first stage in all film production. In an animation 
script, the visual action in the plot and perfonnance is far more 
important than the dialogue. 
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Storyboard 
The storyboard is a series of roughly drawn images that convey the 
action described in the script. This scene-by-scene portrayal helps the 
writer, director and animation team to assess the content of the 
project and to correct any deficiencies in the scripted story. 

At this stage of the project vital questions are asked and answered. 
For example, how much time and effort will be required to create the 
different parts? Animations are almost always created by groups, so 
it's important that all participants have the same understanding and 
vision of the project. Typically, the storyboarding process generates a 
great deal of discussion while it provides the producers with an 
opportunity to evaluate assumptions about the animation's goals 
and objectives. 

Soundtrack 
After the script and storyboard are completed, the recording of any 
dialogue or key music is undertaken. Since traditional animation 
relies on perfect synchronization of the picture to the soundtrack, the 
animator must receive the recorded track before beginning to draw. 

Design 
Designers create visual interpretations of all the actors in the script. 
When these interpretations are approved, the actors are drawn from 
many angles on a model sheet which the animators will use as a 
reference. 

Leica Reel 
A Leica reel is a filmed storyboard which can be projected in syn­
chronization with the soundtrack. It helps the director see how the 
film is shaping up and make any changes to its visual aspects before 
animation is begun. 

Line Tests 
Line tests are animation drawings, produced in pencil on paper, 
filmed to the precise timings of each scene. As line tests are ap­
proved they are cut into the Leica reel, replacing the original draw­
ings and giving the director an even better idea of how the final film 
will look. 
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Cleanup 
Cleanup artists take the animation drawings and clean them up, to 
give them a consistent visual style. 

Trace and Paint 
When a cleaned-up line test is approved, each drawing is transferred 
to a sheet of celluloid or acetate - a cel- and painted in the colors of 
the original design. 

Backgrounds 
Background artists produce the animation's backgrounds - every­
thing behind or, sometimes, in front of the actors that does not move. 

Checking 
The finished animation cels are passed to the checker, who makes 
sure that everything is correctly drawn, traced, painted and prepared 
for the cameraman who is to finally film it. 

Final Shoot 
When the checker is satisfied that all the artwork for each scene is 
correct, the artwork is passed to the camera operator who shoots the 
final scene. 

Dubbing 
When the whole film exists in final form, and the director is satisfied 
with it, the editor, with the director, proceeds to choose sound effects 
to go with the action in the film. These sound effects are then laid in 
synchronization with the action, and mixed with the voice track and 
music on one complete soundtrack. 

Answer Print 
Creating an answer print involves merging the sound and picture on 
one piece of film, ready for projection! 

PrinCiples of Animation 
In the early days of animation, a number of principles were discov­
ered that enabled animators to make their productions both more 
realistic and exaggerated. Over time, these methods and terms 
devised by individuals and teams working in the field came to be 
used by most animators in order to facilitate communication. These 
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rinciples are just as valid today in computer animation. Get to 
know the rules first and then experiment outside of them in an effort 
to create an animation that is interesting and unique. 

If you have not yet viewed the Principl~s o~ Animation Hyp:rCard 
stack that was included on a separate disk m your ADDmohon II 
package, we suggest you look at it now. Double-click the stack icon 
in the HyperCard folder on your hard disk to start it running. (If you 
didn't install the stack, insert the disk and double-click its icon.) 
Once you have seen the principles in action, come back to this 
manual and read about them in detail. 

Squash and Stretch 
~, ' Squash and stretch is the tenn animators use to describe the more 

fluid and exaggerated movements they achieve in their animations. 
To understand this principle, you must first think of animated 
characters as more than just lines. They should move and behave like 
fonns that have volume and mass. The idea of characters being 
composed of substances, not empty shapes of air, means that their 
movements can be effectively shown as loose flowing tissue on a 
more rigid internal "skeleton." This interpretation of your characters 
is one of the most important ground rules of animation. 

Squash and stretch helps you to communicate to your audience the 
nature and composition of your actors. This adds depth and realism 
to otherwise rigid or awkward movements that detract from the 
overall integrity of your animations. 

Consider the difference between a bouncing tennis ball and a bounc­
ing cannon ball. Successfully communicating this difference is 
excellent practice for developing animation skills. Use animation to 
tell as much as possible about the characteristics of your actors -
whether they are hard, soft, hollow or solid - as they move across the 
screen. Animating such differences in the nature of the actors im­
proves the communication to your audience. 

AntiCipation 

Anticipation helps to prepare your audience for an actor's next 
movement an~ to expect it before it occurs. The principle is based on 
close observ.atlOns o~ movement in real life. People crouch slightly 
before they Jump or mhale deeply to blowout birthday candles. 
!hese are ~xa~ples of anticipatory actions. A pause before an action 
IS a key pomt m any animation, as the audience is looking for infor-
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mation to maintain the plot and fluidity of the story line. 

You can use anticipation to set the stage for your next action and 
continue to communicate to your audience more information about 
the nature of the actors. An actor's movements should not always 
follow long pauses or periods of anticipation. This would result in a 
choppy or broken flow of action. Anticipation should always be 
relevant to the action it precedes. An actor who begins to walk, or a 
ball that begins to roll slowly across the SO"een does not require an 
anticipatory action. Anticipation can also be used to set the audience 
up for "sight gags" by making them expect the obvious. 

Secondary Action 
An actor's secondary action supports the initial or main action that 
occurs simultaneously, while remaining subordinate to the more 
important action. Use secondary action to add to the richness of the 
scene and enhance an actor's personality in a subtle and natural way. 

Straight Ahead Action and Pose-to-Pose Action 
Straight ahead action and pose-to-pose action relate to the approach 
animators take to an actor's movements. An animator following the 
principle of straight ahead action knows the story point of a scene 
but allows the actor's movements to evolve naturally from the first 
drawing. The scene evolves along with the creative process. An 
animator applying the concept of pose-to-pose action moves an actor 
through a series of previously determined poses between which the 
action flows. The key poses that occur within that series of move­
ments are worked out before the process of animating begins. 

The two approaches can have very different results. Straight ahead 
action allows the actor's "individuality" or "personality" to lead the 
animator through the scene, while pose-to-pose action leaves more of 
the control in the hands of the animator. 

Follow-Through and Overlapping Action 

Use follow-through and overlapping action in combination to keep 
your actors moving from action to action and scene to scene in a 
smooth and connected flow of movement. Slightly exaggerating 
movement adds to the continuous and flowing feel of your 
animations. When your actors start to move, their appendages and 
other elements (clothing or hair) should take a moment to start 
moving. When your actors stop moving, any appendages should 
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continue to move after their bodies have stopped. The importance of 
this flow becomes clear when we string our actor's actions together. 
These more subtle aspects of your animations help to link the motion 
and the actors. 

Slow-In and Slow-Out 
Slow-in and slow-out are terms that refer to a way of moving an 
actor from one pose to the next. You can accomplish this by carefully 
preparing an actor's important poses, then putting most of the 
inbetween drawings close in timing to these poses. If you place more 
inbetween drawings at the end of a movement, the actor will appear 
to slow down. 

Always remember that the more drawings used to produce a move­
ment, the slower the movement will be. Conversely, the fewer 
drawings used to produce a movement, the faster it will be. The 
slow-in and slow-out technique makes your actors' movements 
lively, but if used too much can give a mechanical feel to the action. 

Arcs 
Making actions move along arcs or curved paths helps to give them a 
more natural, fluid feel. While an actor's head is moving from right 
to left it should also move in an arc. Arcs usually do not apply to 
things which are non-organic because that would indicate the 
movement of a living being. 

Animators are tempted to create straight inbetween drawings that 
are halfway between two other drawings, but this tends to kill the 
spirit of the action and make it feel mechanical. Loosen up the 
movements you assign to the many parts of your actors and see how 
things really start to flow. 

Staging 

Staging is where and how you place your actors in relation to the 
props and other actors in the animation. The staging of a scene helps 
to set the mood and create an environment for the action to take 
place, much the same as in theatre or movie making. The surround­
mgs should never upstage the action they are meant to enhance. 

Stagin~ can also refer more directly to actors. How are they to be 
pla~ed In the scene - in a close up or a long shot? The physical 
attnbutes of the actor must also be considered. Do their costumes 

24 ADDrnotion II Manual 



reflect their character? Does their placement reflect their personality? 
Are they lost in the scene? Do they need to be emphasized? The 
consideration of these questions will help your animation take place 
in an enhancing environment. 

"Timing 
Timing is basically the speeds at which different actions take place. 
We must consider what is taking place and if it is necessary to 
increase or decrease the speed at which actions occur. Timing deter­
mines how different actions string together into a series of related 
actions. An actor that is moving through a scene at twice the pace of 
other actors might be a point of focus, but is that in keeping with the 
flow and cadence of the animation? 

Exaggeration 
Animators often over-emphasize their actors' attributes to assist in 
telling something about the story, the actor and the environment in 
which the animation is set. When done properly, exaggeration 
actually makes an animation more believable and convincing. 
Exaggerate your actors' fonn and behavior whenever you need to 
communicate "big" movements in the story. 

Solid Drawing 
Solid drawing can be described as consistency, strength and "real­
ism" in our animations. Consistency greatly helps the audience 
following action and story line in an animation. You can put your 
actors through any task or exaggerate their form and reactions as 
long as they remain recognizable to your audience. Your drawings 
should be definite and clear. Try to "see" what you are drawing 
through practice and careful observation of your subject matter. 

Ideally, you should be able to draw your actors from every angle. If 
you can only draw your actors from two or three angles, your 
animations will take longer and be restricted in the way you can 
stage the action. 

Appeal 

Appeal is the overall image, character, and qualities that your actors 
give to your audience. An appealing actor is one that catches and 
holds the eyes and ears of the audience. Your success in creating 
appeal depends on your ability to recognize who the audience is and 
what they expect. Animators rely on appeal to communicate con-
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cepts, themes and subject matter. Anything can appeal to an audi­
ence, as long as they are not left in the dark or have to guess their 
way through confusing, unconnected scenes. Remember to be 
confident with your drawing and work out your animations so that 
they make sense and add to, not detract from, your story. 

ADDmotion II's Animation Process 
ADDmotion II takes the mystery out of the animation and presenta­
tion process by providing easy-to-use tools to integrate different 
media types. It is a two-dimensional program which enables you to 
simulate frame-by-frame animation. ADDmotion II provides the 
necessary editing tools for creating the paint objects and sound 
effects as well as facilities for compositing or layering multiple 
animated images and sounds. With ADDmotion II, an animated 
sequence may include a number of diverse visual elements that have 
been created separately, such as 20 images, 3D objects and captured 
video, and then compo sited during editing. 

ADDmotion II consists of three integrated modules: 

Paint 
ADDmotion II's 24-bit color Paint module allows you to create 
convincing animated actors (foreground objects) and props (back­
ground objects) using a wide variety of special tools and effects. 

Most animation work is concerned with slight changes of movement 
from drawing to drawing within an actor, so Paint includes "Onion­
Skin," a feature similar to an animator's lightbox. Onion-Skinning 
allows you to see two drawings at the same time, with one superim­
posed on the other. 

The tools in the Paint palette are the computer equivalent of pencils, 
paint brushes, straight edges, erasers, and a variety of other imple­
ments for creating the graphic images you want. The Patterns palette 
allows you to embellish Paint graphics with a selection of patterns. 

Sound 
Animations and presentations would be lifeless without sound, so 
ADDmotion II includes a complete sound recording and special 
effects editor for choreographing recorded words or sounds and the 
animated picture. 
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Action 
ADDmotion II provides you with a set of tools capable of giving life 
and interactive movement to your creations. Animation relies on 
perfect synchronization of the actors, props, sound effects and cues 
over a length of frames, and ADDmotion II makes this task quick 
and easy. 

With ADDmotion II, your actors can follow paths of action that you 
create. Refinement is as easy as adding, moving, or deleting points 
on the path. A user-definable variety of prop transition effects are 
included to create the environment for the actors' actions and a 
mood for the overall animation. 

Some ADDmotion II Terms and Features 
Actors 
Actors are the movable foreground objects within an animation and 
can consist of one or more cels. If an actor consists of more than one 
cel, each cel picture is representative of one stage of the actor's action 
or gesture. Displayed in succession, cels are seen as a cycle (for 
example a bird flapping its wings). These actors can then be assigned 
paths of action over a series of frames, creating the illusion of move­
ment or animation. 
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Props 
Props are the static background objects within an animation. They 
provide the stage for animating actors. Transitions or visual effects 
can be assigned to props when they are placed in an animation. 

The Media Controller 
The Media Controller is the control center for your animations. The 
controller allows you to play an animation. It also provides a selec­
tion of tools and special functions to create, edit and manipulate the 
Actors, Props, Sounds and Cues that form the animation. The Media 
Controller also gives access to libraries of Actors, Props and Sounds 
that have been previously created. 
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Paths 
A path is a series of points that an actor follows within an animation. 
Each point represents a frame within the animation, and corresponds 
to the actor's position on that frame. Adding or removing path 
points is as simple as pointing and clicking. The speed of the actor is 
partly dependant on the number of points in the path and the dis­
tance between them. 

Sounds 

1604 1 
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ADDmotion II has a built-in sound module to record, edit and add 
special effects to sounds. To record sounds you need an Articulate 
SystemsTN sound digitizer, MacRecorder, or a Macintosh with a 
built-in microphone such as the LC'"M and I1siTN , PowerbookTN 140 
and 170, QuadrasTN or Classic IfTN. Sounds are added to an anima­
tion using the Media Controller or Objects menu. ADDmotion II can 
play back up to 16 sounds simultaneously depending on your 
Macintosh. If you don't have any of these sound recording devices, 
you can obtain sounds from other sources to include within your 
animation, then modify them using the sound editor's special effects. 

Edit WeueForm for Sound: mu.lc 

Size: 14l1K 
20 __ 

71111&. 
( Cancel) I Saue I 
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Cues 
With ADDmotion II's cues you can add interactivity to your 
animations. Cues allow you to control external devices such as CO­
RaM drives, MIDI and videodisc players, and prompt visual effects 
and movement between different animations. 

The Cue Information dialog lets you name the cue, indicate its start 
and end frames, specify a condition to be met by the animation's 
user, and set a command to be carried out when the condition is met. 
To help you create cues, ADDmotion II presents you with pop-up 
menus listing all cue choices. 

Cue Informa1ion ... 

Events 

Name: I Click on note I 

o Do before frame 15 drawn 
t>SI Rcl like Button 0 Use Bounding bOM 

Conllilion - .. - ....... - .. - ................... ___ ... . 

If ... 11 Mou5e Click On "'1 

Stnrt Frnme: E=:J 
[ndFrame: ~ 

I Rctor Nnmed .... 1 .... 1 ....:.n..:..ol....:.e...,;I ____ .... ....11 

. Command·· -- ............ . 

Then: I GOlD Frame .... 1100 ~ 

IQUJ i-
--._. ---.--- ---., •.. -.. ~ - --._ .. ~ _____ .. _.' . __ . ___ . _._._ ... _J 

Events are used to optimize animation speed and memory. Load 
Events sp~cify a point in the animation when Actors, Props and 
~ounds WIll be loaded into memory, staggering the initial loading 
time. S~amp Events take a "snapshot" of the current frame of the 
ammatIon, freezing all visible Actors in place. This allows the re­
m~val of the Actors from SUbsequent frames, resulting in faster 
anImations. 
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Euent Informellon ••• 

Neme: 

Stert Freme 0 

@)Loed Euent 
o Stemp Euent I OK I 

(ceneel) 

o Continuous Stemp Euent 

TImeUnes 
After you build your animations you might need to refine them. The 
TimeLines window allows you to view all of the objects and frames 
of an animation. The Start and End frames of these objects can be 
adjusted by simply clicking and dragging bars on the object line 
handles. The Playback figure can be dragged back and forth to view 
the changes to your animation. 

The TimeUnes window gives you a quick reference to the position of 
a particular item in an animation. You can double-dick the item at 
any lime to modify its information. 

T __ ~_~._ .. _ ..... _ 

t!=.~II. :10 100 
••••••••••••••••••• 1 ••• 

181 fi,~ ... s ( .... .,) I I l;! 

III finoto I I I 
I!!I ~noto2 I I 
181 111._( .... .,) I I 

181 IIlsole. c.&.v) I I 
181 1Il • ......-( .... v) I I 

181 111--- (..av) I I 
I!!I il.ut, ('&'v) I I 
I!!I <JI1I'OISio I I 

18I~""lt I 

181 ~.""...,. I 

1181 ~lfl I I 
Start: £ad: 01 IQ 
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Chapter 3: Tutorial 

The tutorial in this chapter introduces you to the fundamental 
aspects of the program. When you have completed it, you will have 
a solid understanding of the program's environment and the practi­
cal experience you need to begin creating your own dynamic pres­
entations. 

The tutorial's Example Animation is divided into seven progressive 
lessons which provide step-by-step instruction. By following these 
lessons, you willieam first hand how to combine the Actors, Props, 
Sounds and cues that make up the Example Animation. The topics 
are as follows: 

Lesson 1: Creating a Simple Animtltion 
Lesson 2: Creating a Path 
Lesson 3: Using the Cel Sequencer 
Lesson 4: Using the Paint Editor 
Lesson 5: Defining Cues 
Lesson 6: Adjusting the TimeLines 
Lesson 7: Un1cing to HyperCard 

Before You Begin 
This tutorial assumes that you are already familiar with the Macin­
tosh basics. You should also have read ADDmotion II's Terms and 
Concepts in Chapter 2 before you begin. 

Please ensure that your monitor is set to black and white. The 
tutorial was created in black and white and runs more efficiently 
with the correct monitor setting. 

Remember to save your animation frequently. The program will 
save automatically when you quit but a system failure could pro­
duce unpredictable results. 

Lesson 1: Creating a Simple Animation 
A significant advantage of ADDmotion II is its ability to easily 
import content for your animations into your HyperCard stacks. 
Motion Works' objective is to provide an increasing selection of 
content to meet your animation requirements. 
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Example Stack 

In this lesson, you will import existin? Ac~ors, Props and a :>O';lnd 
and coordinate them into a simple animatIOn. Your tasks wIll In-

volve: 

• Viewing the Example Animation 
• Starting a new stack and animation 

• Importing content 

• Placing Props 
• Setting the frame counter 
• Defining Prop transitions 
• Placing an Actor 
• Adding a Sound 

Viewing the Example Animation 
1. Double-click the Example Stack icon in the ADDmotion II 

Tutorial folder. 

The first (and only) card of the stack shows a button named 
Example Animation. 

2. Click the Example Animation button. 

The button disappears and the animation begins (it may take a 
moment to load). Once the three bullet points appear, the 
animation pauses while it waits for a mouse click. 

2. Click INSTRUCTION. 

Piano keys appear and notes start moving across the screen (this 
part of the animation loops indefinitely). 
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3. Click INSTRUCTION again. 

The piano keys and notes disappear and the animation pauses 
while it waits for the next mouse click. Try c1ick!ng 
INSTRUcnON a few more times. 

NOTE: For the purposes of the tutorial, only the INSTRUCTION bullet 
point was scripted. 

4. Click QUIT. 

You are returned to the card level. 

Starting a New Stack and Animation 
1. Choose New Stack from the File menu. 

You are asked for a file destination and name. 
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10 RDDmotion II Tutort ...... 1 

New st.Ck n.me: 
IMy Stock 

Q =Hard Drlue 

[ E I'''' ) 
[ Desktop) 

lJ£J 
[ Cancel) 

o Copy current bllckground 
o Open stack In new window 

, CDrd size: IStDndDrd 9' I 

2. Ensure that the ADD motion II Tutorial folder is open. 

3. Click in the New stack name box, then type My Stack. 

Leave the card size at Standard 9". This is better suited to the 
tutorial's design. 

4. Click New. 

A blank stack titled "My Stack" appears. 

5. Choose New Animation from the File menu. 

You are asked for a name. 

6. Type in My Animation. 

New Rnlmatlon ... 

Nllme: !My Rnlmatlon 

(IIncel [O(J 
7. Click OK. 

36 ADOrno/ion /I Manual 

The Media Controller appears and you are now at the animation 
level. The Media Controller can be moved to any convenient 
location by dragging the bar at the top of it. 



My Stect II 

I 

11 I II 1EI11~1EI 
[IJBm ~~ 
Iillillllill !~ 
~ [EI ~! 

8. Choose Animation Options from the Media menu. 

The Animation Options dialog appears. New animations default 
to 200 frames in length though they can be set as high as 5000. 
Speed refers to the "frames per second" display rate. 

Anlmellon Opllons ... 

Anlmellon Nllme: IL.M....:y:..R_n_l_m_II_II_on ______ ....J 

~
~:~~~~~s: 0 I 
Props: 0 I 
Sounds: 0 I 
Cues: 0 I 
~ent~ ___ J 

Frames: ~ 
Speed: I 12 ... , 

FF/REW Skip: D III 
Grid Size: I OFF ... , 

o Hide Pelettes 
o Hide Menu Bllr 
OHlda Cunor 
181 Rulo Repley 
o Mouse Bullon 10 SlOp 
181 Commend-I.) 10 Slop 
181 Show Frllme Counl 
o Show Frllme Rele 
o Leeue le.t Freme 
o Preserue Imege 
o Multlflnder Anlmellon 
o Allow Cerd Clicks 

Beckground Color D Cencel J I OK ~) 
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9. Set the Frames and Speed to 118 and t2 respectively. 

These settings have been predetermined for the tutorial. In future 
animations, you should experiment with these and other options 
to detennine their optimum settings (you can set or change them 
at any time). 

to.Click OK. 

Importing Content 
1. Click the Actor icon on the Media Controller. 

The Select an Actor dialog appears. New animations have no 
library content. At this stage, you will simply import the objects 
you need for your animation. 

Select en Rctor ... 

{} ( New ... 

[Import ... 

1<5 H rio". 
'::t8J::-:p:-:-re:--u-=-le---w-~::::;N=o=ne~) (Cencel ) 

2. Click Import. 

You are asked for a file to import from. 

lei! RDDmolion II Tulorlel ... 1 
D EHamplp \tdlk m 
D My Sleek 

=Herd Drlue 

( rJI~r.' I 
( Desklop I 

[ Cencel I 

'--_______ ---'-'-'0 OF~) 

3. Open the Example Stack. 

The Select an Actor to Import dialog appears. This gives you acces 
to the Example Stack's Actor Library, an alphabetical list of its 
Actors. If you wish to preview them, ensure that the Preview 
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checkbox is ticked (clicking toggles it on/om, and then select the 
Actor you wish to see. 

NOTE: A (b&W) at the end of a I'IIlme indiClltes a l-bit black and white 
Actor or Prop. A (col) indiClltes an 8-bit color Actor or Prop. They have 
been I'IIlmed this way for convenience but you ClIn I'IIlme or rel'lllme your 
Actors and Props however you like. 

NOTE: The preview window sCllles the cels of an Actor, sometimes 
making it appear to jump or move within the window. This is not 
necessarily indicative of the Actor's movement. 

S ... cI .... ctw'. _ ...... 1._ 

! 
----, 

! ......... " ..... , i i 
~to •• (I •• .,1 I ~ i 

I I 
i i 

I<; ~ I_rtlt~ L--_._ ......... .i ........... "" .. 
II!I .......... ....... .,c.~ .• 

Ceneel •••. ,. 

4. Import the note Actor. 

You are asked to confinn the Actor's name (or change it if you 
wish). 

Iclur •• mllt ••• 

Hem.: lam""'!i!D 
~I OKJ 

5. Click OK. 

The Actor is then copied into the Actor Library of your stack. 

6. Click Cancel to close the window. 

7. Repeat steps 1 through 6 and continue to Import the following 
from the Example Slack. Remember to first click the 
apPropriate icon on the Media Controller. 

When importing multiple objects of the same type (eg. the Props), 
it is not necessary to click cancel after each one. 
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Actor - piano keys 

Prop - instruction 
- mondo 
- quit 
- sales 
- service 

Sound- music 

Placing Props 
1. Click the Prop icon on the Media Controller. 

2. Select the mondo Prop, then click Place. 

Placed objects default to the center of the animation screen. Until 
an Actor or Prop is placed in an animation, it is considered to be 
"unemployed" . 

NOTE: To remove a placed object, simply select it and press the delete 
key. Removing an object from an animation will not remove it from the 
library. 

3. Click and drag a solid area of the mondo Prop until its 
bounding rectangle is flush with the bottom of the screen. 

4. Once you are satisfied with its location, double-click the mondo 
Prop. 

The Prop Information dialog appears. 

Prop Inrormation ... 

Prop Name: 1~~~~!I1 
~r-'-"-'-'-------"--""-'-" ,-. 

library PrOP:~!."~d~,(~fr.':'l', __ , __ .. ____ J 

Stllrt frllme: U Horlz pOSlllon:~ 
End Frllme: ~ Uert POSltlDn:~ 

Drawing Mode: I Opaque "'1 
o Locked 

( Tnmsltlons ... 1 
( , 

( [dlt Prop ... I Cllncel 1 OK 
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5. The Start and End Frames should read 1 and 118 respectively. 

The start and end frames are inclusive. In this case, the Prop 
appears on frame 1 and disappears after frame 118. 

NOTE: When an object is placed, its start frame will always default to 
the cu"ent frame number. 

6. Set the Horiz and Vert positions to 69 and 8 respectively. 

The top left comer of the animation screen is 0,0. The registration 
point of Actors and Props defaults to the top left comer of their 
bounding rectangle. The horizontal and vertical positions 
represent the pixel distance between these two points. 

NOTE: Values not within the screen's boundaries will move an object 
outo/view. 

7. Click the Locked checkbox. 

You will be positioning further Props on top of this one, so it is 
best to lock it in place to avoid accidentally moving it later. 

8. ClickOK. 

9. Repeat steps 1 through 8 and continue to place the following 
into your animation. You will also stagger their start frames for 
visual interesL 

Prop - sales (Start: 2, End: 118) 
(Hofiz: 100, Vert: 130) 
(Locked) 

- service (Start: 3, End: 118) 
(Horiz: 100, Vert: 170) 
(Locked) 

- instruction (Start: 4, End: 118) 
(Horiz: 100, Vert: 210) 
(Locked) 

- quit (Start: 5, End: 118) 
(Horiz: 455, Vert: 310) 
(Locked) 

The placed Props seem to "disappear" once you adjust their start 
frames. This is because the Media Controller is still showing 
frame 1. Click the Single Step buttons if you wish to see the Props 
on frames 2 through 5. 
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SeHing the Frame Counter 
1. Click the Reset button on the Media Controller. 

Animations always reset to frame 1 since nothing can be placed on 
frame O. However, viewing an animation as it would appear and 
play on frame 1 requires setting the frame to O. 

2. Double-click the Frame Counter window. 

The Move to Frame dialog appears. 

Moue to rrome ... 

ShuUl rram~ Nulltb~r [G 

3. Type in O. 

4. Click OK. 

NOTE: You can also set the frame to 0 by holding down the Option key 
and then clicking the Reset button. 

[}] 5. Click the Play button on the Media Controller. 

Notice how the Props appear in your animation. Even though 
they are staggered, they stiII enter the screen abrubtly. You will be 
addressing that in the next part of this lesson. 

I]] 6. Click the Stop button on the Media Controller. 

Defining Prop Transitions 
1. Double-click the mondo Prop. 

2. Click Transitions. 
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The Transitions for Prop "mondo (b&w)" dialog appears. You will 
now define a transition for the Prop to help smooth out its 
entrance and create an effect. 



T.o •• 1II0 •• fo .... , ·"'Oftillo ..... ,. _. 

., ,.tor TronllUon 
o ,.It Tronlltton 

Motllolll 
I Sc .. II... ...l 
Slops: ~ 
1, .. 111: I 15 ... 1 

[ Con.ol l I DIC ,,) 

3. Ensure that the Enter Transition button is highlighted. 

4. Set the Method to Scroll. 

5. Click and drag the flashing bounding box straight down below 
the Prop preview. 

This will be the Prop's transitional starting position. 

6. Set the Steps and Speed to 8 and 15 respectively. 

The steps represent how many increments the Prop will take to 
move from the flashing box position to its screen position. The 
speed represents how fast those increments will be played. 

7. Click OK. 

8. Repeat steps 1 through 7 and continue to define the Enter 
Transition for the following: 

Prop - sales (Method: Angular Wipe Top Left) 
(Steps: 8, Speed: 15) 

- service (Method: Angular Wipe Top Left) 
(Steps: 8, Speed: 15) 

- instruction (Method: Angular Wipe Top Left) 
(Steps: 8, Speed: 15) 

NOTE: An Exit Transition is defined in the same manner. However, a 
Prop's end frame must be at letlSt one frame shorter than the animation 
in order to allow for it. 

9. Set the Frame Counter to 0 again and play your animation 
(remember to stop it when you are done). 

Notice the difference the transitions make, in particular, the frame 
1 transition of the mondo Prop. 
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Placing an Actor 
1. Click the Actor icon on the Media Controller. 

2. Select the piano keys Actor, then click Place. 

Actors are placed and positioned in the same manner as Props. 

3. Click and drag the piano keys Actor to the lower right area of 
the animation screen. 

4. Double-click the piano keys Actor. 

The Actor Information dialog appears. 

"etor Inrormltlon._ 

Relor Heme: I 'd&fD 
lIbrnry Attor. ~:pi.~·k;YI·tbgwy _~ no m ___ • 

llb,.'y P.th: ~r~ ____ -~ _________________________ , 
Slart hame: D 
Endfr.me: ~ 
Pllh rolnl Slln: D of: 1 

5 •• ,. 'o.lIIon : 

hDril ~! 

. __ "-~'~ _1~IIJJ 

[0' MDd.: L..I .:::oP:.:;oq::;:U"=--__ '"';..J1 

181 Locke. 
I (dll Retor ... I ~ [ 01( .J 

5. Set the Start and End Frames to 6 and 118 respectively. 

6. Set the horiz and vert to 285 and 120 respectively. 

7. Click the Locked checkbox. 

8. Click OK. 

Adding a Sound 
1. Click the Sound icon on the Media Controller. 

2. Add the music Sound. 

The Sound Information dialog appears. Sounds can punctuate 
specific parts of an animation or be played throughout. 

44 ADOrno/ion 1I Manual 



"-!II_. J-' ze __ .... Z" fr_ 

S,.rt rr._I_1 [J r ... 'ft 
E .... r . IJiiI [J r ...... , r_. L.:..!=...J 181-.,..,--
PrI.n'I:~ - .. r.£B 
CMnnK 0 L.n • c.ft'or 0 ...... 

3. Set the Start and End Frames to 1 and 118 respectively. 

4. Click the Repeat Sound checkbox. 

S. Set the Volume to 3. 

This mayor may not be loud enough, depending upon your 
work environment. You will have an opportunity to adjust the 
volume in Lesson 6: Adjusting the TimeLines. 

6. Click OK. 

The above settings will be apPropriate for some background 
music in your animation. Don't be concerned right now about 
the Sound "skipping" when your animation repeats. This will be 
resolved in Lesson 5: Defining Cues. 

Reviewing· Your Animation 
Reset and play your animation to see what you have created so far. 
Very impressive! You have successfully completed Lesson 1: Creat­
ing a Simple Animation. 

Lesson 2: Creating a Path 

ADDmotion II offers a flexible, path-based animation process. 
While other programs require manually placing graphics in differ­
ent positions over a series of frames, ADDmotion II uses paths (a 
line of points or screen coordinates> to control how Actors will 
move around on-screen. It thereby becomes more intuitive and the 
results are immediate. 

In this lesson, you will place a second Actor into your animation, 
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create a path for it and then duplicate it. Your tasks will involve: 

• Naming an employed Actor 

• Plotting a rough path 
• Moving path points off-screen 

• Refining the path 

• Looping the path 
• Duplicating the Actor 

Naming an Employed Actor 
1. Move to frame 27 (set the frame counter or use the buttons on 

the Media Controller). 

You are going to place a second Actor into your animation starting 
at frame 27. This will allow the piano keys Actor to cycle through 
at least once, for visual interest, before introducing the second 
Actor. 

2. Click the Actor icon. 

3. Place the note Actor. 

4. Click and drag the note Actor to the lower left area of the 
animation screen. 

5. Double-click the note Actor. 

6. Type in note 1 for the Actor Name. 

You wiII be duplicating this Actor later, so it is best to give it a 
name to help identify it. 

NOTE: The same library object can be used many times in an anima­
tion. Each instance of it can be given a unique name, separate and 
distinct from its library name (if no name is specified, it defaults to its 
library name). 

7. The Start and End frames should read 27 and 118 respectively. 

8. Set the horiz and vert to 15 and 260 respectively. 

Do not lock the Actor in place yet. You will be creating a path for it 
in the next part of this lesson which will require changing its start 
position. 

9. Click OK. 

46 ADOrno/ion 1I Manual 



Plotting a Rough Path 
1. Click the Path tool. 

The animation icons on the Media Controller are replaced by 
path icons (they will be dimmed if you don't have an Actor 
selected). 

2. Ensure the note 1 Actor is selected. 

The Actor's single-point path appears. 

Without a defined path, the Actor will remain at this screen 
poSition and cycle through its cels. 

3. Click to the right of the existing path point and continue to 
roughly plot 16-15 points in a wavy line across the screen . 

. r-............. ~ l\d3' ... 00, ~.--/ ~.-e: 
I .• ) 

To adjust a point, click and drag it. To remove a point, simply 
select it and press the delete key. To add a point, first determine 
where you want the new point, then select the point before it. The 
next place you click will then become a new point on the path. 

4. Click the Path Information icon. 

The Path Information dialog appears. The path you just created 
has been saved automatically in the Path Library with the name 
Untitled 1. 

NOTE: Removing an Actor from an animation will not remove the 
path as a library object. 
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s. Type in wavy note for the Path. 

6. Click OK. 

7. Reset and play your animation to see the difference the path 
makes. 

The path causes the Actor to move across to the right side of the 
screen and then remain stationary as it continues to cycle. This is 
because every path point corresponds to a frame. Currently, the 
Actor cycles over more frames than it has points for. You will be 
refining that later in this lesson. 

Moving Path Points Off-screen 
1. Click the Path tool. 

2. Select the note 1 Actor. 

3. Click the Path Options icon. 

The Path Options dialog appears. 

Path OpU.n •••• 

I!:I RII.w RutD Str.1I Window 

o Grid RnimIU •• 

~ Show rr.me for Curren' P.t" Point 

'alhSize: ~ 

I [anCOI] CE;) 

4. Click the Allow Auto Scroll Window checkbox. 

48 ADDmotion /I Mmual 

This will allow you to automatically "push" path points beyond 
the screen's boundaries so the Actor can begin "off-screen". 



NOTE: You CJln also click and drag the ani71Ultion screen around freely 
by holding down the option key. Path points CJln then be "pulled" or 
dragged beyond the screen's boundaries. 

5. ClickOK. 

6. Click and drag the first path point to the left until only a small 
portion of the Actor remains on-saeen. 

The gray section represents the off-screen area. 

7. Once you are satisfied with its location, hold down the Option 
key and double-dick anywhere on- or off-screen. 

This realigns the animation screen. 
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8. Click and drag the last path point to the right until only a small 
portion of the Actor remains on-screen. 

9. Option and double-click to realign the screen. 

Refining the Path 
1. Click the Scale Path icon. 

The Scale Path dialog appears. 

Scote Path .•• 

Current number 01 potnto: t, 

Desired number of points: r::ll=-O --, 

~t::EJ 

2. Type in 30 and click OK. 

This increases the number of path points to 30. 

3. Click the Distribute Points icon. 

The path points are now uniformly spaced. 
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4. Click the Smooth Path icon. 

The path is smoothed out (repeated clicking would eventually 
form a straight line). 

Looping the Path 
1. Hold down the Option key and click and drag the animation 

screen to the right so you can see the beginning of the path 
again. 

2. Select the first path point, then click the Point Information icon. 

The Path Point Information dialog appears (your horizontal and 
vertical values may differ). 

'el~ 'Olnl Infornoellon_. 

hlnl_ .. .., I 

~0r1z:" 181 Loop To Here 

... rl:~ 

[~II 1ted 

3. Click the Loop to Here checkbox. 

4. Click OK. 

This stretches the path line from the last path point across to the 
first, indicating a continuous loop. It may look peculiar but this is 
rwt an error. 

5. Option and double-click to realign the screen. 

6. Reset and play your animation to see the difference the off­
screen points, path refinements and loop make. 

The Actor now starts and ends off-screen, travels a smooth, 
uniform path and loops for the duration of your animation (this 
evens out the "frame to point" ratio mentioned earlier). 

Duplicating the Actor 
1. Move to a frame where the note 1 Actor is showing. 

2. With the Object tool highlighted, select the note 1 Actor. 

3. Choose Duplicate from the Edit menu. 
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Another note 1 Actor appears on top of the first one, offset 
horizontally and vertically by 5 pixels. 

The duplicate Actor has the same eels, Actor information and 
path as the first one. If you did not want the same Actor 
infonnation and path, you would have simply placed another 
"note" Actor from the Actor Library, rather than duplicate the 
"note 1" Actor in your animation. 

4. Double-click the duplicate Actor. 

5. Type in note 2 for the Actor Name. 

6. Set the Start and End Frames to 47 and 118 respectively. 

This will delay the introduction of the note 2 Actor until the note 
1 Actor is part way across the screen. Depending on the frame 
showing, the note 2 Actor will either move to its current screen 
position or it may "disappear" from the screen. 

7. Click the Locked checkbox. 

Now is a good lime to lock the Actor in place, since its path and 
starting position are finalized. Remember to lock the note 1 Actor 
as well . 

8. Click OK. 

Reviewing Your Animation 
Reset and play your animation to see how it looks at this point. Well 
done! You have successfully completed Lesson 2: Creating a Path. 

Lesson 3: Using the Cel Sequencer 
The Cel Sequencer is a powerful feature that allows complete control 
over an Actor's characteristics on any frame or path point within an 
animation. Consequently, a single Actor can accomplish the tasks of 
many and conserve valuable memory. 

In this lesson, you will use the eel Sequencer to control the cels of an 
Actor. Your tasks will involve: 
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• EXilmining the Cel Sequencer modes 
• Controlling individual eels 
• Controlling ranges of eels 

Examining the Cel Sequencer Modes 
1. Move to .&ante 6, the frame on which the piano keys Actor first 

appears. 

2. Select the piano keys Actor. 

3. Click the Path tool. 

4. Click the Cel Sequencer icon. 

The Cel Sequeneer appears. 

The three icons down the left side represent eel Size, eel to Show 
and Cel Opacity respectively. The default mode is eel to Show. 
Frame 6 (the current frame number) is highlighted and the eel to 
Show indicates which of the Actor's eels is currently showing (eel 
1 in this case). 

S. Click the Cel Size icon. 

The wording changes and the number indicated is now 100, 
meaning 100% size. 

6. Click the up/down arrows to change the percentage size. 

The Actor updates accordingly. 

7. Set the Cel Size to 100 again before you continue. 

NOTE: The Cel Opacity also works in percentages but any changes 
won't be evident with a black and white monitor setting. Furthennore, 
an Actor's Cel Mode must be set to Sequence Opacity in order for any 
changes in the Cel Sequencer to be referenced. 

8. Click the Cel to Show icon. 

9. Click the up/down arrows to change the eel number. 
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HI.Set the eel to Show to 1 again before you continue. 

Controlling Individual Cels 
1. Extend the Cel Sequencer by clicking the zoom box at the top 

right corner of it. 

C.l s ... .ne.,. 

You can now scroll from frame 6 through frame 118 (the start and 
end frames of the Actor). The Cel to Show goes from cell through 
eel 21 (one complete cycle of the Actor), then repeats itself. There 
is also a preview of the Actor. 

2. Scroll forward and highlight frame 27. 

For visual interest, you will wait for the Actor to cycle through 
once (frames 6-26 inclusive), then you will change some of the 
Cels to Show (frames 27-31 inclusive). 

3. Change the Cel to Show. 

Set it to any eel number (eels 1-21 inclusive). 

4. Continue to highlight frames 28 through 31, then change their 
Cel to Show. 

Set different cel numbers for each. 

5. Reset and play your animation to see the difference in the 
Actor's cycle. 

The Actor starts its regular cycle, plays through the random eel 
numbers, then returns to its regular cycle. More variation is 
needed but rather than change any more eels individually, you 
will work with ranges of eels. 

ContrOlling Ranges of Cels 
1.1f I 1. Select the piano keys Actor. 

2. Click the Path tool. 

ffi 3. Click the Cel Sequencer icon. 
lmmJ 
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4. Click Set Range. 

The eel Sequence Editor dialog appears. You will be applying 
sequences to two different ranges of cels. 

lIelo,: ,lonD k.... ~ 
Hum''',: 21 
Slorl F,ome: , 
lod f .. ,..: 1111 

Random ... 1 
Fro .. : 43 

Hono.: I,om 1I'11III0 ~ tD ~ 
Uol •• ot , .. ,.0 32 1':101:1 

( .""'J CE:J 

The first sequence (frames 32-97 inclusive) will play the eels in 
random order. 

5. Set the pop-up menu to Random. 

6. Set the Selection Range from 32 to 97. 

7. Click Apply but do not click Done yeL 

C.I Sequonco Edllor ... 

RrIDr: plono til' ~ 
N.m Ce .. : 21 

StOrl f,om.: • 

End from.: .11 

Cuele .ouen ..... 1 

.ongo: 'rom Iro ... o ~ ,. ~ 
U.luo ., 'r..... .. Is: ~~ 

( Rpply J C!EJ 

The second sequence (frames 98-118 inclusive) will play the cels 
in reverse order. 

8. Change the pop-up menu to Cycle Reverse. 

9. Change the Range to read from 98 to 118. 

10.Set the Value at frame 98 to 21. 
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Setting the value to 21 ensures that the Actor will start this 
sequence from the end of its cycle (ceI21), not part way through 
it. 

1l.Click Apply. 

12.Click Done to close the window. 

Reviewing Your Animation 
Reset and play your animation to see the affects of the eel Sequencer. 
A regular Beethoven! You have successfully completed Lesson 3: 
Using the Cel Sequencer. 

Lesson 4: Using the Paint Editor 
ADDmotion II's Paint Editor is a complete 24-bit colour paint pro­
gram specially designed for creating and/ or editing Actors and 
Props. A host of special effects and transformations can be applied 
manually to an individual cel or automatically to all eels. 

In this lesson, you will use the Paint Editor to edit the eels of an 
Actor. Your tasks will involve: 

• Examining some important features 

• Editing individual eels 

• Editing all eels 

Examining Some Important Features 
1. Choose Open Actor/Prop hom the Objects menu. 

The Select an Actor to Edit dialog appears. 

2. Open the note Actor. 
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The Actor's paint window appears and the paint palette can now 
be accessed. 



While Props always consist of a single image, Actors may consist 
of one or more cels. Therefore, the paint palette for Actors 
includes cycle arrows (along with the current cel number) at the 
bottom of it. 

NOTE: You am have multiple Actors and Props open at the same time, 
allowing you to cut and paste artwork between them. 

3. Click the cycle arrows to view the eels of the Actor individually 
OR click and hold the arrows to cycle through all the eels. 

4. Choose Onion Skin - Previous Cel from the Options menu. 

Now when you view the eels, you see a double-image - that of 
the current eel and the previous cel (gray-scale or color machine 
settings illustrate this feature more clearly as a lighter, ghost-like 
image). Onion-skinning is extremely useful for aligning or tracing 
artwork. 

5. Choose Onion Skin - None from the Options menu. 

6. Move to eelS of 8. 

7. Choose Insert Cels from the Edit menu. 

The Insert eels dialog appears. 
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Insert Cels •.• 

Number of (els 10 Inserl: IIIIl 
o Dupllcale Cel Conlenls 

[ Cancel J CEJ 

B. Click OK to insert just t cel. 

Now when you view the eels, you see that the blank eel you are 
on has been inserted immediately after eel 5 and all eels have 
been renumbered accordingly. 

9. Move to cel 6 of 9. 

to.Choose Remove Cel from the Edit menu. 

The current eel is removed. 

Editing Individual eels 

1 of' 

1. Resize the paint window by clicking and dragging the grow box 
at the bottom right corner of it (the window will automatically 
sluink back to the most efficient size once you close it). 

You may also want to adjust the proximity of the palette. If so, 
drag the bar at the top of it. 

2. Double-click the pencil tool to zoom in/out to a more 
comfortable working size. 
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3. With the Pencil tool highlighted, move to cels 3 and 6 and 
sketch some motion lines. 

4. When you are satisfied with the changes, choose Keep Paint 
from the Paint menu. 

This saves your changes so far, allowing you to continue 
experimenting with the Paint Editor. Try out some of the other 
paint tools, then choose Revert Paint when you are ready to 
return to this stage. 

Editing All eels 
1. Ensure that nothing is selected in the paint window, then 

choose Scale All Cels - By Percent from the faint menu. 

The Scale All eels By dialog appears. 

Scala HII eels Iy ... 

I!!J!;J Percenl Uerllnlly 

1!!J!;l Percanl Horizontally 

(Cancel] ~ 

2. Set both the Percent Vertically and Percent Horizontally to BO. 

3. Click OK. 

The program automatically scales all eels to the required size. 

4. Close the paint window by clicking the close box at the top left 
comer of it. 

You are asked to save your changes. 
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5. Click Save. 

Notice that both of the note Actors in your animation reflect the 
changes you have been making. This is because they both 
reference the same library Actor you were working on. 

Reviewing Your Animation 
Reset and play your animation to see your newly-edited note Actors. 
What an artist! You have successfully completed Lesson 4: Using the 
Paint Editor. 

Lesson 5: Defining Cues 
lnteractivity is the key to successful multi-media presentations and 
ADDmotion II makes it easy with its menu-driven scripting. Actors 
and Props can behave like buttons to make animations interactive. 
HypertalkTM handlers can be executed to control the playing of CD 
and videodisc players, visual effects and much more. 

In this lesson, you will define the cues that will add interactivity to 
your animation. Your tasks will involve: 

• Pausing the animation 
• Looping the animation 
• Stopping the loop 
• Ending the animation 

Pausing the Animation 
1. Click the Cue icon. 
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The Cue Information dialog appears. The idea is to imply that the 
piano keys and note Actors are directly related to the 
INSTRUCTION Prop. There are actually three cues involved in 
this procedure. 
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This first cue will make your animation pause while it waits for a 
mouse click on a specific object (in this case, the INSTRUCfION 
Prop). 

2. Type in wait for the Name. 

3. Set both the Start and End Frames to 5. 

This cue will be active only on frame 5, the frame on which the 
Props have finished their transitions and the frame before the 
piano keys Actor first appears. 

4. Define the Condition as: 

Wait for 

Prop Named 

Mouse Click On 

instruction (b&:w) 

Pop-up menus suggest the most apPropriate scripting choices. 

5. Leave the Command as: 

Continue 

This means that once the mouse is clicked on the Prop, your 
animation will simply continue. 

6. Click the Use Bounding box checkbox. 

This will enable you to click anywhere within the Prop's 
bounding box to activate it (this is especially important when 
working with text). 

1. Click OK. 

Clulpter 3: TutorjQl 61 



I]] I}] 8. Reset and play your animation to test the wait cue. 

The three bullet points appear as usual but your animation now 
pauses until you deliberately click INSTRUCTION to make it 
continue. 

Looping the Animation 
1. Click the Cue icon. 

Cue Informolion ... 

Nome: I'-If _________ ~ 

D Do before frame Is drawn 
o Rct like Bullon eEl Use Bounding bOH 

. (oluJiliulI . -- -----.~-,-,.-.-.,.-., ._._ ...•. _. 
I If .... 11 Mouse CliCk on .... 1 

Start Frame: D 
Eml frame: EJ 

I Prop Named .... 1 I Instruction (b&w) .... 1 
. Command -~---~---.­
, 'hen: I 6010 Frame 

-._-----

.... fCJ 
OE:J 

This second cue will determine a point in your animation where it 
will always loop. 

2. Type in always for the Name. 

3. Set both the Start and End frames to 118. 

This cue will be active only on frame 118, the frame on which the 
piano keys Actor completes its reverse cycle. That way it is less 
likely to appear that your animation is being interrupted, thereby 
providing a seamless loop. 

4. Leave the Condition as: 

Always 

This means whenever your animation reaches frame 118, it will 
loop. 

5. Define the Command as: 
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Goto Frame 6 

Your animation wiJJ loop back to this frame, the frame on which 
the piano keys Actor first appears. 



6. Click OK. 

IElII1 7. Reset and play your animation to test the always cue. 

Now once you make the piano keys and note Actors appear by 
clicking INSTRUCI10N, your animation loops indefinitely. As a 
result, the Sound no longer "skips" but notice the note Actors 
still "disappear" suddenly whenever the animation loops. You 
will be adjusting this in Lesson 6: Adjusting the TimeLines. 

Stopping the Loop 
1. Click the Cue icon. 

Cue Informetlon ... 

Nlme: ,-11f~ ________ --, 
ODD lIe'Dre 'reme I. dre..,n Stert freme: D 
o Ict lite luttDn 181 U.e IDundlng IIDH (nd freme: IT!!] 

CondltlDn 
I If .... 11 MDu.e Cllct On .... ! 
I 'rDp Nemed .... ! I In.tructlon (lilt..,' .... ! 

ow 

This third cue will allow you to stop the animation loop by 
clicking INSTRUCfION again. 

2. Type in if for the Name. 

3. Set the Start and End Frames to 6 and 118 respectively. 

This cue will be active for the duration of the loop. 

4. Define the Condition as: 

If 

Prop Named 

Mouse Click On 

insbuction (b&w) 

5. Define the Command as: 

GotoFrame 5 

This will make your animation pause again while it waits for the 
next mouse click. 
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6. Click the Use Bounding Box checkbox. 

7. Click OK. 

8. Reset and play your animation to test the if cue. 

The illusion is complete ... repeated clicking of INSTRuCfION 
makes the piano keys and note Actors seem to "show" or "hide." 
Likewise, Actors and Props related to SALES or SERVICE can be 
scripted in the same manner. 

Ending the Animation 
1. Click the Cue icon. 

Cue Inform. lion ... 

Name: Iqull 
~---------------~ 

ODD barDre fr.ml! Is draw. 
I8IlItl lite lull on 0 Use .oundlng bON 

-Co.llillan 

SI.rl Frame: D 
[nd Frellle: IT!!] 

I I If ... 11 Maula Clltk On ... 1 

!~I =.r=OP=N=a=m=all="'~1 ~I =q=UI=t(~bO=W=I====~"'1 
,-Colllmenll-------·--­
II hen: I End Mnlmellon ... 1 
I 

L __________________ -.1 CEJ 

This final cue will allow you to end your animation at any time. If 
you are in an ADDmotion II animation, the animation will simply 
stop. If you arc viewing an ADDmotion II animation by means of 
a HyperCard link (such as the Example Animation button) you 
will actually quit the animation and return to the card level. 

NOTE: You can also end an animation by pressing command-period -
one of the default Animation Options. 

2. Type in quit for the Name. 

3. Set the Start and End frames to 1 and 118 respectively. 

This cue will be active throughout the animation. 

4. Define the Condition as: 

If 

Prop Named 
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Mouse Click On 

quit (b&w) 



5. Define the Command as: 

End Animation 

6. Click the Ad like Button checkbox. 

This will make the Prop highlight when clicked. 

7. ClickOK. 

I]) r1J 8. Reset and play your animation to test the quit cue. 

Now, regardless when you click the quit Prop, the animation ends 
immediately. 

Reviewing Your Animation 
Reset and play your animation to test all the cues one last time. Good 
job! You have successfully completed Lesson 5: Defining Cues. 

Lesson 6: Adjusting the TimeLines 

The TimeLines window provides a comprehensive overview of an 
animation. It features instant access to object information and preci­
sion control for editing start and end frames of object timelines. 

In this lesson, you will examine the TimeLines window and adjust 
the timelines of two Actors. Your tasks will involve: 

• Accessing object infonnation 
• Deactivating an object 
• Adjusting the timelines 

AcceSSing Object Information 
You can select any object or get access to its information instantly 
from within the TimeLines window. 

1. Click the Time Lines icon. 

The TimeLines window appears. 
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2. Resize the TimeLines window by clicking and dragging the 
grow box at the bottom right corner of it (adjust its screen 
position if necessary). 
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The objects in your animation are listed by section and name, in 
the order that they were placed or added (relayered objects 
would be reordered accordingly). 

3. Double-click the music Sound in the TimeLines window. 

Its Infonnation dialog appears. You may want to take this 
opportunity to adjust the volume level. 

4. Click OK. 

Deactivating an Object 
The checkbox next to each object name allows you to deactivate the 
object (clicking toggles it on/off). Deactivating objects is very con­
venient while building, testing or editing animations. 

1. Click the music checkbox. 

Since it is a Sound, there is no apparent change to your animation 
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(Actors or Props would actually disappear from the screen). 

2. Reset and play your animation. 

The animation plays as usual but you no longer hear the music 
Sound. 

3. Click the music checkbox again. 

The music Sound has been turned on again. 

Adjusting the Tlmellnes 
An object's timeIine is a visual representation of its start and end 
frames. In this case, you are going to tidy up the end frames of the 
note Actors so they won't "disappear" suddenly whenever your 
animation loops. 

1. Move the cursor towards the end of the note 1 Actor timeline 
until it changes to a one-directional arrow. 

2. Click and drag the end frame from 118 to 116 (watch the value at 
the bottom of the TimeLines window). 

This will prevent the Actor from beginning another cycle once it 
moves off the right side of the animation screen at frame 116. 

3. Move the cursor towards the end of the note 2 Actor time line 
until it changes to a one-directional arrow. 

-+I 4. Click and drag the end frame from 118 to 106. 

This will prevent the Actor from beginning another cycle once it 
moves off the right side of the animation screen at frame 106. 

The note 1 Actor actually cycles three times while the note 2 Actor 
only needs to cycle twice. The Actors are indistinguishable so the 
number of cycles makes no difference when viewing the 
animation. 

Reviewing Your Animation 
Reset and play your animation to see the note Actors "exit" Properly. 
Way to go! You have successfully completed Lesson 6: Adjusting the 
TimeLines. 
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Lesson 7: Linking to HyperCard 
ADDmotion II's extensive exporting capabilities allow for a variety 
of formats, from standard PICT or PICS files to QuickTime™ Movie 
files and more. Furthermore, by linking your animations to Hyper­
Card you can easily create dynamic, sophisticated stacks. 

In this lesson, you will link your completed animation to a Hyper­
Card button. Your tasks will involve: 

• Linking to a new button 
• Viewing the finished product 

Linking to a New Button 
1. Choose Link - New Button from the File menu. 

You are temporarily returned to the card level. The new button 
named My Animation will move with the cursor until you 
confirm a location for it by clicking the mouse. 

2. Click near the center of the card. 

The button is then placed and you are returned to the animation 
level. 

3. Choose Close Animation from the File menu. 

Viewing the Finished Product 
1. Click the My Animation button to see the finished product. 

Remember it may take a moment to load. 

2. Click INSTRUCTION a few times to test the interactivity. 

3. Click Quit to return to the card level. 

Congratulations! You have successfully completed Lesson 7: Linking 
to HyperCard, the final installment of the tutorial. 
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Chapter 4: Paint Too/s 

This chapter describes the purpose and function of the various tools 
in the Paint palette. You use the Paint tools to create and edit the 
appearance of Actors or Props. 

Paint Palette 
The Paint palette appears whenever you create a new Actor or Prop 
or edit an old one. The top of the palette displays the Paint tools 
available. To select a tool, click inside the box that holds it. The shape 
of the pointer may change depending on the tool you have selected. 

Click the Paint palette's zoom box in the top right corner to display 
the Paint Effects buttons. aiding these icons has the same effect as 
choosing their equivalent items from the Paint menu. 

The following Paint palette examples show how they appear when 
working on an Actor in black and white and in color. When working 
in black and white, the Color Pick-up tool, Foreground and Back­
ground color pop-up palettes are dimmed, and the most recent color 
selection palette does not appear. 

Since Props consist of a single eel, the cel cycle arrows at the bottom 
of the palette do not appear when you are working on Props. 

Cluzpter 4: Paint Tools 69 



0_, 
I I 
~- ... 

Selection Tools 

Marquee Tool 
Use the Marquee tool to select a rectangular area of an image. Drag 
diagonally across the area to select it. 
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To select the entire image, double-click the Marquee tool icon in the 
Paint palette. You can also choose Select All from the Edit menu. 

To shrink the selection to the outside area of the image you are 
selecting, press the Option key while you drag; when you release the 
mouse button, the selection rectangle shrinks around the image 
eliminating the extra white space. 

To move a selection, position the pointer inside the selection until the 
pointer changes to an arrow then click and drag the selection. 

r--------il' I . 
I , , 
I 
I 
I 

:- ----- --~ 
To move a selection straight up or down or directly left or right, hold 
the Shift key down while you drag. To make a copy of the selection, 
hold the Option key down while you drag. 
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To make multiple copies of a selection, press the Command-Option 
keys combination while you drag. 

r---------, 
I 

lasso Tool 
Use the Lasso tool to select a specific part of an image when the area 
is too small for the selection rectangle or when you need to select a 
part of the image that is non-rectangular or between other graphics. 

To use the Lasso tool, click and drag around the area you want to 
select. The line that trails the lasso's tip shows what you are laSSOing. 
When you release the mouse button, the lasso shrinks around the 
image and selects it. The lasso shimmers around the edges. To lasso 
an area without shrinking around the image, hold down the Option 
key while dragging. 

To lasso the whole image, double-click the Lasso icon in the Paint 
palette. The enclosed white space is not selected. 

To move a selection, position the Lasso tool's tip within the selection 
until the cursor changes to an arrow, then click and drag. To move a 
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selection straight up or down or directly left or right, hold the Shift 
key down while you drag. 

To make a copy of the selection, hold the Option key down while you 
drag. 

To make multiple copies of the selection, hold the Command-Option 
keys down while you drag. 

NOTE: To move an image one pixel at a time, select it with the Marquee or 
Lasso tool, then use the arrow keys on your keyboard. To mave it five pixels 
at a time, hold down the Shift key as you press an arrow key. 

Pencil Tool 
Use the Pencil tool to draw thin free-form lines. This is the most 
useful tool for working in Fatbits mode (magnified or detailed work). 

When you are working on a color monitor, the pencil draws in the 
selected color. (If you click on a pixel of the selected color and then 
draw, the pencil draws in the background color.) When you are 
working on a black and white monitor, the pencil draws in the reverse 
of the area on which you first press the mouse button. For example, if 
you press on a black area, the pencil draws in white. 
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To draw straight lines in a vertical or horizontal direction, hold down 
the Shift key while you drag. 

To work in Fatbits mode, double-dick the Pencil icon in the Paint tool 
palette or press down the Command key and click the area that you 
want magnified. To zoom out of Fatbits, press Command-Shift and 
click. 

While the Pencil tool is selected, holding down the Option key 
produces the Hand cursor which you can use to move the work area. 

Brush Tool 
Use the Brush tool to paint with the current pattern and brush shape. 
Choose the Choose Brush item from the Options menu or double­
click the brush in the Tool palette to choose a new brush shape from 
the Select Brush Shape dialog. 

S.I.cl .rulh Sh.p •... 

1..-______ .... 

~ 
I OK I 
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Using different brush shapes and patterns creates different effects 
when painting. To paint straight lines in a vertical or horizontal 
direction, hold the Shift key down while you drag. If you want to 
erase using the brush tool, hold the Command key down while you 
drag. 

• + EB = it mtflllllll , 
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Paint Bucket Tool 
Use the Paint Bucket tool to fill solid areas of an image with the 
selected pattern and color. The hollow parts of outlined and shad­
owed text can be filled in the same manner. 

If there is a gap or space in the outline of an area, paint spills out and 
fills the surrounding area of the image. Choose Undo from the Edit 
menu to correct the mistake. Use Fatbits to check for gaps before 
using the Paint Bucket tool. 
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Spray Can Tool 
Use the Spray Can tool to spray color onto an area of the image. 
When working on a color monitor, you can double-dick on the Spray 
Can icon to bring up settings. When working in black and white, you 
can erase using the Spray Can tool, by holding the Command key 
down while you drag. 

Text Tool 
Use the Text tool to add text to the image. Use it for labels and titles 
within an image or by itself. Adding text has the same effect as the 
other tools, the text becomes part of the image. Immediately after 
typing the text and before clicking anywhere on the screen, you can 
change the text's font, size, style and color. Oicking the Marquee or 
Lasso tools selects the text you have just typed. Clicking anywhere 
else "stamps" the text in the Paint window. 

MOun~ MountaJneeq 

To set the text attributes, choose a Font, Size, and Style from the 
Paint menu. The settings that you make stay in effect until you make 
changes to them again or until you restart the program. 

Selecting a Font 
Choose Font from the Paint menu, and while holding down the 
mouse button, choose one of the available fonts from the hierarchical 
menu. The current font is checked. 
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Selecting Font Size 

Choose the Size hierarchical menu to display a list of all available 
font sizes. The current font size will be checked. The best font sizes 
for the current font will be outlined. Double-clicking on the Text tool 
icon brings up the Text size dialog. 

Selecting Other Font Sizes (TrueType) 

Choose Other from the Size hierarchical menu to display the Choose 
Font Size dialog, then select any size font using the font size up or 
down arrows. The font size will be displayed in real time in the text 
box. ADDmotion II is compatible with ATM (Adobe™ Type Man­
ager) and Apple TrueTypcTM outline fonts. 

Selecting a Font Style 

The hierarchical Style menu displays a list of all available font styles. 
The current font style choices are checked. You can choose a number 
of font styles to create different effects in your paint documents. 

You can also choose to Left Justify, Right Justify or Center your text. 

Eraser Tool 

Usc the Eraser tool to crase or remove part of the image you drag 
over. 

eraser 

Double-clicking on the Eraser tool in the tool palette crases the whole 
image. If you make a mistake, choose Undo from the Edit menu. 

Color Pick-up Tool 

Usc the Color Pick-up tool to select a color from part of the image. 
This tool is unavailable when working in black and white. 

When working in color, Paint displays the 12 most recently used 
colors in the Recent Colors palette. If you select a color using the 
Color Pick-up tool it is added to the palette behind the last color 
selected. Colors arc added from left to right. When the palette has all 
12 spaces filIed, the next color is added in the last space and the first 
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space will be removed. All previous colors are then pushed one 
space back in the palette. 

Holding down the Option key and clicking on an image fills all 
instances of the color you have clicked on with the selected color. 
Holding down Option-Command and clicking on an image fills it 
with the current Gradient. 

You can use the Tab key to toggle between the current tool and the 
Color Pick-up tool. 

Line Tool 
Use the Line tool to draw straight lines. Hold down the Option key 
while you drag to draw lines in the selected pattern. Hold down the 
Shift key while you drag to draw straight horizontal or vertical lines. 
Choose the line thickness from the Line Width pop-up. 

Shape Tools 
Select a border size and pattern from the palette'S pop-ups for the 
shapes you want to draw. 

/1 ,I D ",."". I 
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To draw centered on a given point, choose Draw Centered from the 
Options menu before you drag. To draw borderless shapes, choose 
Draw Filled from the Options menu and hold down the Option key 
as you drag or select 0 from the line width pop-up and then draw. To 
draw multiple shapes, choose Draw Multiple from the Options menu 
before you drag. To constrain shapes, hold down the shift key while 
you drag. 

Rectangle Tool 
Use the Rectangle tool to draw rectangles. Position the cross-hair 
pointer where you want the rectangle to start; then drag diagonally. 
To change the thickness of the rectangle border use the Line Width 
pop-up. To draw rectangles that are filled with the selected pattern 
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and color, choose Draw Filled from the Options menu or double­
click the Rectangle tool in the tool palette. 

Draw filled unchecked and checked 

Rounded Rectangle Tool 
Use the Rounded Rectangle tool to draw rectangles with rounded 
corners. Position the cross-hair pointer where you want the rectangle 
to start; then drag diagonally. To change the thickness of the border, 
use the Line Width pop-up. To draw rounded rectangles that are 
filled with the selected pattern and color, choose Draw Filled from 
the Options menu or double-click the Round Rectangle tool in the 
Tool palette. 

[~~l 
Draw filled unchecked and checked 

Oval Tool 
Use the Oval tool to draw oval shapes. Position the pointer where 
you want the oval to start; then drag diagonally. To change the 
thickness of the oval border use the Line Width pop-up. To draw 
ovals that are filled with the selected pattern and color, choose Draw 
Filled from the Options menu or double-click the Oval tool in the 
Tool palette. 

o 
Draw filled unchecked and checked 

Curve Tool 

Use the Curve tool to draw free-form shapes. Position the pointer 
where you want to start, then drag out your shape. Paint will draw a 
straight line connecting the start and end points of the shape when 
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you release the mouse button. To draw curves that are filled with the 
selected pattern and color, choose Draw Filled from the Options 
menu or double-click the Curve tool in the Paint tool palette. 

Draw filled unchecked and checked 

Polygon Tool 
Use the Polygon tool to create polygons with irregular sides. This 
tool works differently than the other tools. To draw, position the 
mou5C where you want to begin, then click and release. Move the 
mouse to the second point and click; then to the third point and click, 
and as many more as you want. To finish the polygon, doubl~lick 
or click the beginning point again. To change the thickness of the 
polygon border, use the Line Width pop-up. To draw polygons with 
the current pattern, choose Draw Filled from the Options menu. 

Draw filled unchecked and checked 

To draw borders using the current pattern and color, hold down the 
Option key while you drag. 

I Patterns ..... 1 PaHern Pop-up 
The Pattern Fill pop-up palette displays a choice of available patterns 
you can lise for paint and fill operations. 

Selecting Patterns 
To select a pattern, click on the Patterns button, hold down the 
mouse button until the cursor is over the pattern you want, then 
release it. 

To make changes to an existing pattern, choose Edit Patterns from 
the Options menu, click on the pattern, then edit it pixel by pixel. 
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Gradient Fill 
The gradient fill is the pattern on the top row, second from the left. It 
is only available if you are working in color. For information on 
defining the gradient fill, see the Edit Gradient section in Chapter 5. 

I Foreground .... 1 Foreground Color Pop-up 
The Foreground pop-up palette displays a choice of available colors 
for painting in foreground colors. Depending on the Macintosh and 
monitor that you have, this palette can display 2-bit black & white, 
up to 256 gray scales, and up to 256 colors out of a palette of 16 
million. 

Selecting Foreground Colors 
To select a foreground color, click on the Foreground Colors button, 
hold down the mouse button until the cursor is over the color you 
want, then release it. 

Editing Foreground Colors 

To make changes to an existing color, choose Edit Colors from the 
Options menu. Select a color by clicking on it, then choose Edit. You 
can either select a new color by clicking on it in the color wheel, or 
by modifying the existing color by adjusting its hue, saturation, 
brightness or color composition. Use the scroll bar to the right of the 
color wheel to adjust its values. Edit Colors is only available if you 
are working in 16 or 24 bit mode. 

I Background .... 1 Background Pop-up 
The Background pop-up palette displays a choice of available colors 
for painting in background colors. Depending on the Macintosh and 
monitor that you have, this palette can display 2-bit black & white, 
up to 256 gray scales, and up to 256 colors out of a palette of 16 
million. 

Selecting Background Colors 

To select a background color, click on the Background Colors but­
ton, hold down the mouse button until the cursor is over the color 
you want, then release it. 
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Editing Background Colors 
To make changes to an existing color, choose Edit Colors from the 
Options menu. Select a color by clicking on it, then choose Edit. You 
can either select a new color by clicking on it in the color wheel, or 
by modifying the existing color by adjusting its hue, saturation, 
brightness or color composition. Use the scroll bar to the right of the 
color wheel to adjust its values. Edit Colors is only available if you 
are working in 16 or 24 bit mode. 

Line Width Pop-up 
Available line widths are displayed in the Paint palette. Oick on the 
Une Width pop-up, then select one of the nine possible widths. 

Recent Color Pick -up 
Recent Colors are displayed in the Paint palette to allow for a con­
venient selection of one of the 12 most recent colors that have been 
used. To select a color, click one of the palette choices. To assign a 
color as a background color, hold down the Option key while click­
ing. 

Changing Recent Colors 
Click on the color you want to change, then select a new color from 
either the Foreground or Background color palettes. 

I [}<P I <? I 0{> I ¢{] I Cel Cycle Arrows 

Show First Cel 
Click the first arrow (vertical line and left arrow) to show the first cel 
in an Actor's eel cycle. 

Show Previous Cel 
Click the second arrow (left arrow) once to step reverse one cel in the 
Actor'S cel cycle. Hold the arrow down to reverse cycle or animate 
through the eels of the Actor. The left arrow on the keyboard per­
forms the same action. 

Show Next Cel 
Click the third arrow (right arrow) once to step forward one cel in 
the Actor's eel cycle. Hold the arrow down to forward cycle or 
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animate through the cels of the Actor. The right arrow on the key­
board performs the same action. 

Show last eel 
Click the fourth arrow (vertical line and right arrow) to show the last 
cel in an Actor'S cel cycle. 

1 of 1 Cel Counter 
The cel count is displayed by first showing the current Actor cel 
number then the number of total cels in the Actor. Double-click in 
this area to bring up the Insert Ccls dialog. 

Paint Effects 

With Paint you can add special effects to one cel of an Actor or Prop, 
or all the ccls of an Actor. If you select part or all of an image with 
the Lasso or Marquee tool, the Paint menu items reflect a selection. 
For information on special effects for selections, see the next section 
in this chapter. 

If you want to add a special effect to all of an Actor's cels, with no 
selection, choose a special effect from the Paint menu or click the 
equivalent button on the extended Paint palette. The special effect 
will change all of the cels, saving you the steps required to do it one 
cel at a time. 

SpeCial Effects for All Cels of an Actor 

Fill All eels 
Choose this command to fill all of the current Actor's cels with the 
current pattern and color. This is especially useful for changing the 
pattern of a large area. 

Invert All eels 

Choose Invert All Ccls to change the color of the pixels in all of the 
current Actor's cels to colors on the opposite side of the color spec­
trum. If you are working in black and white, white pixels become 
black and blClck pixels become white. 
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TInt All Cels 

Mon'n"Il" ~ Toward Foreground I 
Toward Background 

If working in color: 

Choose Tint - Toward Foreground to tint all of the current Actor's 
cels by adding the foreground color to all pixels. 

Choose Tint - Toward Background to tint all of the current Actor's 
cels by adding the background color to all pixels. 

If working in black and white: 

Choose Tint - Toward White to lighten all of the current Actor's cels 
by removing black pixels. 

Choose Tint - Toward Black to darken all of the current Actor's cels 
by adding black pixels. 

Anti-Alias All Cels 
Choose Anti-Alias All Cels to remove the jagged or stair-step edges 
and outlines from all of the current Actor's cels. Anti-aliasing 
smooths the edges of the cel by creating intermediate pixels. These 
pixels are greyish unless you have given the cels a backgr01,lnd color. 
For example, if the Actor is a flying bird, you might want to pour sky 
blue around it before choosing Anti-Alias All Cels. 

Anti-Aliasing is only available when you are working in color. It is 
especially useful when you are printing the finished animation to 
video or displaying on a video screen. 

Trace All Cels Edges 
Choose Trace All Cels Edges to outline edges of the same color in all 
of the Actor's eels. Repeated tracing adds more outlines to edges in 
all cels. Pressing Command+E has the same effect. 
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Rotate All eels 

Rotate nil eels • Right 
Left 
h(~(~ 

By Degree ... 

Choose Rotate All Cels - Right to turn all of the current Actor's cels 
90 degrees right. 

Choose Rotate All Cels - Left to turn all of the current Actor's cels 90 
degrees left. 

Choose Rotate All Cels - By Degree to turn all of the current Actor's 
cels by the number of degrees specified in the Rotate All Cels by 
Degree dialog box. The number of degrees can be between 1 and 360 
and the cels can be rotated clockwise or counter-dockwise. The Free 
option is only available when part of a cel is selected. 

Flip All eels 

.jmwillliQ'~ Uertical I 
Horizontal 

Choose Flip All Cels - Vertical to flip all of the current Actor's cels 
vertically about their center line . 

Choose Flip All Cels - Horizontal to flip all of the current Actor's cels 
horizontally about their center line. 

Scale All eels 

fnH~ I 
By Percent ... 

Choose Scale All Cels - By Percent to scale all of the current Actor's 
ccls by the values set in the Scale All Cels By Percent dialog box. The 
cel can be scaled by changing the percentage vertically and horizon­
tally. The Free option is only available when part of a cel is selected. 

Tween eel 

The Tween Cel item in the Paint menu lets you rotate, scale, fade or 
flip the image over a specified number of new cels. You select the 
final orientation, size, etc. and Tween Cel creates the intermediate 
steps. 
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To tween an Actor's eel while using Paint: 

1. Choose Tween Cel from the Paint menu. 

The Tween Cel dialog appears. 

Tween Cel ... 

o Rotllte II'M'!;I Degrees ® (9) Clockwise 

0(6 Counter-CW 

o Scale ~ m Percent UerUcally 

~ m Percent Horizontally 

o Fade • Click to set 

o flip Uertlcally 
o flip Horizontally 

o Use Dithering 

Cels TO Crellte: [J II) 

[ Cancel J I OK I 

2. To rotate the eel, check the Rotate box, enter a number of 
degrees from 1 to 360, then choose Clockwise or Counter­
Clockwise. 

3. To scale the cel, check the Scale box, then enter values from 0 to 
100 in the Percent Vertically and Percent Horizontally boxes. 

4. To have the eel change color, check the Fade box, then click the 
Click to Set box to choose a color from the pop-up color palette. 
If your Macintosh has a black and white monitor, click the Click 
to Set box to indicate whether the cel should fade to black or 
white. 

5. Check the Flip Vertically box if you want the eel to flip 
vertically. 

6. Check the Flip Horizontally box if you want the cel to flip 
horizontally. 

7. Enter the number of cels over which you want the action to be 
carried out. 
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8. Check the Use Dithering box to cause scaled and flipped images 
to look more accurate. (Dithering may introduce new colors to 
your artwork.) 

9. Click OK. 

As an example of how the Tween Cel feature works: 

1. Open an Actor. 

The Actor's first eel appears. 

'[]'; note (b&w) ::~0:' 
o 

2. Choose Tween Cel from the Paint menu. 

The Tween Cel dialog appears. 

3. Check the Rotate box, enter 180 degrees, then choose Counter 
Clockwise for the direction of the rotation. 

4. Check the Scale box, then enter 50 in both the Percent Vertically 
and Percent Horizontally boxes. 

5. Enter 4 in the Cels To Create box. 

The dialog should look like this. 
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Tween Cel ••• 

181 Rotllte ~ III Degrees 0 (9) Clockwise 

® l€) Counter-CW 

181 SCllle §J I;l Percent Uertlcllily 

~ III Percent Horizontllily 

o Fllde D Click to set 

o Flip Uerlicllily 

o Flip Horizontally 

o Use Dithering 

6. Click OK. 

Cels To Create: ~ 00 

[ Cllncel 1 I OK I 

Four eels are created, with each one rotating one quarter of 180 
degrees and scaling down one quarter of 50 percent. 
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Special Effects for a Selection of an Actor or Prop 

Fill Selection 
Choose Fill Selection to fill the selected part of the image with the 
current pattern and color. This command is especially useful for 
changing the pattern of a selected part of the image. 

II. 

Invert Selection 
Choose Invert Selection to reverse the color of the pixels in the 
selected part of the image, such that white pixels become black and 
black pixels become whit~. 

Tint Selection 

If you are working in color: 

Choose Tint Selection - Toward Foreground to tint the selected part 
of the image by adding the foreground color to the selected area. 

Choose Tint Selection - Toward Background to tint the selected part 
of the image by adding the background color to the selected area. 

If you are working in black and white: 

Choose Tint Selection - Toward Black to darken the selected part of 
the image. You can repeat the action until the selection is totally 
saturated. 
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Choose Tint Selection - Toward White to lighten the selected part of 
the image. You can repeat the action until the selection is totally 
white. 

Anti-Alias Selection 
Choose Anti-Alias Selection to remove the jagged or stair-step 
appearance from images as they step from one row or colunm to the 
next. Anti-aliasing smooths the edges of a selected image by adding 
intermediate pixels. These pixels are grayish unl~ss you have given 
the selection a background color. Anti-aliasing is only available if 
you are working in color. It is especially useful when you are print­
ing the finished animation to video or displaying it on a video screen. 

Trace Selection Edges 
Choose Trace Selection Edges to outline areas in the selected part of 
the image that are of the same color. Repeated tracing adds more 
outlines. 
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Rotate Selection 

Rotate Seier tlOn • Right 
Left 
Free 
By Degree ••• 

Choose Rotate Selection - Right to tum the selected part of the image 
90 degrees right. 

:--~ ... -,7------' 
I \ 
I,' 

1 

I ~. 1''-: 
I ..... I 
I- 1 : ___ :.:~~ _________________ J 

.-, L. ____ , ______ _ 

NOTE: If you rotate the image right and any part moves off the screen 
during a rotation, you'll lose that part permanently - Undo can't retrieue it. 

Choose Rotate Selection· Left to tum the selected part of the image 
90 degrees left. 

1 
1 
1 

1''': 
I ..• ~ I :-. ,......... : 
I ____ ~_----------------~ 

NOTE: If you rotate the image left and any part moves off the screen during 
a rotation, you'll/ose that part permanently - Undo can't retrieue it. 
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Use Rotate Selection - Free to rotate a selection about its center freely. 
Select a portion of the image using a selection tool, choose Rotate 
Selection - Free, then grab one of the four handles at the comer of the 
selection rectangle and rotate it clockwise or counter-clockwise. 

Choose Rotate Selection - By Degree to tum the selected portion of 
the cel by the number of degrees specified in the Rotate Selection -
By Degree dialog box. The number of degrees can be between 1 and 
360 and the selection can be rotated clockwise or counter-clockwise. 

Flip Selection 

Rotate Selection Iy ..• 

~I;J Degrees 

<i> (9) Clockwise 

o l€) Counter-clockwise 

[ Clncel ) I OK I 

·'rtilfHUiUu I * Uertlcal I I Horizontal 

Choose Flip Selection - Vertical to flip the selected part of the image 
vertically about its center line. 

; ...... ~ ............ :~: ... : .................. . 
1 01- .... 

~ ...... ' \;". V-~ ~" 
.. ~ V :.... . . 

Lao ...... ::::: ................................ . 

:···::~::.;:; .. ······.··.:~·····················l 
...... ~~ . 

-. ':" ~'. J_ ! 
',I : 

~ 1 
u ........................................... ; 
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Choose Flip Selection - Horizontal to flip the selected part of the 
image horizontally about its center line. 

: ---~------2. ----------: 
: .... 1 I : 
• .-' I 

:.-.-.'.:;; . ~~ \'j 
I ______________________ ~ 

I J 

I r 
I 

I 
"" I ····1 

I ". I L _________________ ':.. ____ f 

Scale Selection 

Free I 
By Percent..: 

Choose Scale Selection - Free to scale the selected part of the image 
by grabbing one of four handles and resizing the selection freely. 
You can resize it using any different combination of the handles. This 
will continue to work until you select another tool or choose another 
menu item. 

It·· . ·110 
. ....................... . 

Choose Scale Selection - By Percent to scale the selected part of the 
image by the values set in the Scale Selection - By dialog. The selec­
tion can be scaled by changing the percentage vertically and horizon­
tally. 

Ink Effects 

Scale Selection By .•. 

~I;J Percent Uertlcllily 

~I;J Percent Horizontally 

Cancel ) (t OK D 

Ink effects can be used to overlap or superimpose a selected part of 
an image by making it either opaque or transparent. 
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Opaque 

Select part of an image using the Marquee or Lasso tool, thell choose 
Opaque from the Paint menu. When you move the selection over 
another image in the Paint window, it covers the other image. 

D 
Transparent 

SL'icct part ot dn Image uSing the ~1arqueL' or Ll~S() tool, then choose 
Transp,lrent from the Palilt menu. When you movc the sell'ction ovcr 
,1I1other 11l1,1ge in thl' P,lint \\lI1dow, tllL' other im.lgL' ~h()ws through 
It 

D 
Importing Graphics 
,\DDm()tion II P,lJnt IS L'llmp,ltlbiL' with m,ll1Y popular Macintosh 
pr()gr,lI11s ,md ,11I(1\\s \l'lI tl' Illlf'Llrt dl'ClIllll'nts Il1 PieS, [,ICr, or 
\1,ICP,llnt fllrm,lts 

Import 
Cll(lo"c Illlpl,rt l;raphics frolll the 1',lInt menu, click the appropriate 
tprrll.1t b(l\, "L'iL'd ,I iill' tp IInpllrt, thL'1l click Open. Once d pICture IS 
illlpLlrlL'd Illtl' P,lIllt, It IS trL'.ltl'd ,I~ if VI.lLl h,ld crl\ltl'd it In P,lInt. 



Import ... 

lei HDDmollon II .... 1 
•• 'Il I • 

[) Hnlmals 'f 

[) Color Hawk 
[) Funny Pic ture. 
[) Underwater Bukdrop 

181 P ICT 181 MacPalnt 
181 Pies 

GrllphlCS Preulew 

181 Preulew 

c:::lHard Disk 

( (Ject 

( Delktop 

I Open 

( Cancel 

, 

The Paint Import dialog allows you to see a picture preview before 
you import the file. Check Preview to see the image you will be 
importing. 

Importing Pies Files 
Check PICS in the Import dialog to import a PICS file into the 
current Actor. 

NOTE: l.ilrge PIeS files require more memory. It is suggested that you 
keep your PIeS files small or split large PIeS files into a number of 
smaller PIes files before you import them into an Actor. 

Importing PleT Files 
Check PICT to import a PICT file image into the current Actor or 
Prop. A PICT file can be imported to replace the current cel in an 
Actor or the entire image of a Prop. 

Importing MacPaint Files 
Check MacPaint to import a MacPaint file image into the current 
Actor or Prop. A MacPaint file can be imported to replace the 
current cel in an Actor or the entire image of a Prop. 

Exporting Graphics 
ADDmotion II Paint lets you export Actors as PICS files and Props 
as PICT files. 
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Export 

Choose Export Graphics from the Paint menu, then select the appro­
priate hierarchical menu item. The Export dialog appears. Select a 
destination folder, type in a name for the export file, then click Save. 

Ie HyperCllrd .... 1 
D ~l(lImJlle Shick 
:J Slack I 
D Shick 2 

~ c::J Herd Disk 

1.1 [ [Jl'cl ) 

J [ Desktop) 

<> 
Nllme for ["port file... I S.tllO I 
I Cencel 

Paint Bitmaps 

Keep Paint 
Use Keep Paint (or Command-K) to keep the changes you've made 
to an Actor or Prop. Use Revert to go back to the most recently kept 
version of the picture. If you click the close box in the Paint docu­
ment window, you are asked whether you want to save any changes 
you have made. 

Revert Paint 
Use Revert Paint to restore the most recently kept version of the 
Actor or Prop, throwing away any changes since the last Keep 
command or since you started painting. 
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Chapter 5: Paint Options 

This chapter tells you how to use the Paint features listed in the 
Options menu. Paint tools appear when you create a new Actor or 
Prop or edit an old one. 

Using Fatbits 

Zoom In 
Zoom In lets you focus on a section of an image to do close-in work 
and to edit your image one pixel at a time. To Zoom In at any time 
while using the Pencil tool, hold down the Command key and press 
the mouse button in the Paint window. Zoom In has three levels; 
each time you press the mouse button it will zoom in to a more 
magnified version of the picture. Pressing Command-J has the same 
effect. You can also use the 1, 2,3 and 4 keys to set the magnification 
to 1,2,4 or 8 times. 

Zoom Out 
Zoom Out lets you zoom out of a section of an image after doing 
close-in work. To Zoom Out at any time while using the Pencil tool, 
press Command-Shift and click. Pressing Command-L has the same 
effect. You can also use the 1, 2, 3 and 4 keys to set the magnification 
to 1,2,4 or 8 times. 

Editing Paint Features 

Edit Colors ... 
The Edit Colors menu item lets you change colors using the Color 
wheel. Edit Colors is only available in 16 and 24 bit mode. It will be 
dimmed in any other mode. 

To change a single color: 

1. elide the color that you want to change. 

The color is surrounded by a thin blade line to indicate that it is 
selected. 
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I Done I 

2. Double-click the color or click the Edit button. 

The Apple Color Wheel dialog appears. 

Pltk 8 new tolor ..• 

D 
S.lur.I~~: Ri 
Brightness ~[;J 

Red 65535 i;J 
lireen 65535 i;J 

Blue 65535 GI 
( Centel I I OK 

3. Select a color by clicking in the color wheel. 

Your selection is indicated by a small reverse video dot on the 
location that you clicked. You can adjust the Hue, Saturation and 
Brightness of the color using the up or down arrows, or by typing 
the new settings into the boxes provided. 

4. Click OK when you are finished editing the color. 
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EdH Gradient .•. 
The Edit Gradient option is only available if you are using a color 
monitor. It lets you set the type and angIe of gradient, and to choose 
the two blending colors. 

Once you have edited the gradient, you can use it to fill shapes by 
first choosing the gradient option in the Paint palette's Pattern pop­
up. 

To edit the gradient 

1. Choose Edit Gradient from the Options menu. 

The Define Gradient dialog appears. 

alnnl 6radllnt.. 

* 
o ShIPI Gradient 

2. Click on one of the eight lines and a directional arrow appears 
to indicate the angle for the gradient, or click at the center of the 
lines to indicate you want the gradient to radiate either In or out 
from the center. 

3. Click on the left control arrow of the gradient bar, then select a 
color from the pop-up color palette. 

4. Click on the right control mow of the gradient bar, then select a 
color from the pop-up color palette. 

s. Click the Shape Gradient box if you want the gradient fill to 
adjust to the shape of the object it fills. You must have a radial 
gradient selected to do this (all arrows on lines pointing toward 
or away &om center). 

The preview box displays the selected gradient. 
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6. Click OK. 

Edit Patterns ... 
The Edit Pattern dialog allows you to edit the paint patterns. Click 
one of the patterns, then edit it pixel by pixel in the box to the right 
of the pattern palette. When you restart ADDmotion II, the patterns 
return to their default state. 

Edit Patterns ... 

Choose Brush ... 
To change the shape of the Paint Brush: 

1. Choose Choose Brush from the Options menu. 

The Select Brush Shape dialog appears. Each shape displayed has 
a different effect when you use it. 

Select 8rush Shepe ... 

• • / , I -

100 

2. Select a shape by double-clicking on it or by clicking on it 
once, then clicking the OK button. 
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Shape Effects 

Draw Filled 
Draw Filled fills shapes as you draw them. It uses the current pattern 
to fill the shapes. The tools that it affects (Rectangle, Rounded Rec­
tangle, Oval, Curve and Polygon) change in appearance in the Paint 
palette. When the Draw Filled feature is turned on, a check mark 
appears next to it in the menu. To tum off Draw Filled, choose Draw 
Filled again . 

Draw Filled with the Polygon tool: If Draw Filled is on while you're 
using the Polygon Tool, Paint draws a straight line between the 
polygon's starting and ending points when you double-click to finish 
your polygon. The resulting shape is filled with the current pattern 
and colors. 

Draw Filled with the Curve tool: If Draw Filled is on while you're 
using the Curve tool, Paint draws a straight line connecting the 
starting and ending points of the shape when you release the mouse 
button; then it fills the shape with the selected pattern and colors. 

Draw Centered 
Draw Centered lets you draw from the center point. Draw Centered 
affects the following tools: Line, Rectangle, Rounded Rectangle and 
Oval. When the Draw Centered feature is turned on, a check mark 
appears next to it in the menu. To turn off Draw Centered, choose 
Draw Centered again. 

Draw Multiple 
Draw Multiple draws multiple images as you drag with the mousc. 
Draw Multiple affects the following tools: Line, Rectangle, Rounded 
Rectangle, Oval, Curve and Polygon. When Draw Multiple is on a 
check mark appears next to it in the menu. To tum off Draw Multi­
ple, choose Draw Multiple again. 

Onion Skin 
Onion Skin is only available when editing multi-<el Actors. When 
chosen, it allows the previous or next eel of an Actor to show 
through to the current eel. The other eel always appears behind the 
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current eel at 30% of the saturation of the original. Onion Skin 
provides for a method of tracing or aligning the current eel. 

Onion Skin works in all levels of Fatbits, but some operations might 
become slower when it is turned on. 

Choose Previous Cel or Next Cel, or choose None to turn off the 
feature. 

Registration 

Registration is only available when editing Actors. When checked 
the registration point of an Actor is displayed in the Paint editing 
window. The registration point is the spot that path points are 
anchored to. 
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To change the Registration point: 

1. Make sure Registration is checked under the Option menu. 

2. Open the Actor document window. 

3. Choose Get Info from the Objects menu. 

The following dialog appears, allowing you to change the 
Registration point by moving the horizontal and vertical 
registration lines. 

Info for Rctor 'MlCelil Irtghtl" ... 

eel Slze:1 Wlndolll .... 1 

[R:rittlon] 

(Cencel I 

DO 

4. Click on the line and, holding down the mouse button, move it 
to the desired location. 

The registration point is the point where the two lines intersect. 

5. Release the mouse button. 

6. Click OK. 

To turn off Registration, choose Registration again. 

NOTE: The registration point can also be changed in the Actor Document 
window by holding down the Shift, Option and Command keys while 
clicking with the pendl tool. 
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Chapter 6: Creating Actors, Props and Sound 
Effects 

This chapter explains how to create Actors, Props and Sound Effects 
which you can then add to your animation. Actors can have one eel 
or many, while Props have only one eel. Sounds can be recorded 
using one of several devices, then manipulated within the program 
to create the effect you want. 

Creating a Single-Cel Actor 
Animation is the calculated spacing of drawings that brings gestures 
to life. Most Actors should have at least three eels to give a proper 
flow of movement, but there are instances when an Actor requires 
only one cel. 

Since Actors and Props are treated as different layers, a Prop cannot 
appear in front of an Actor. In the event that an Actor must move 
behind a Prop (eg. a tree), this can be achieved by creating and 
employing an identical single-cel Actor and placing it at the fore­
front. 

To create an Actor: 

1. Choose New AetorlProp from the Objects menu. 

The New Actor dialog appears. 

Nelli Retor ... 

Nlme: 

i)RctDr 
o Prop ( Cllne.1 l I OK J 

NOTE: The dialog defaults to New Actor. 

2. Enter a name for the new Actor. 

3. Click OK. 

The blank Actor window appears. 

4. Use the tools in the Paint palette to draw the Actor. 
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NOTE: Actors such as this sailboat only need one eel to calmly sail 
across a lake. 

5. Click the window's close box when you have completed the 
image. 

You are asked if you want to save changes. 

6. Click Save. 

Creating a Multiple-Cel Actor 

Multiple-cel Actors are often referred to as cycles because they 
consist of a repeating series of drawn cels. When creating a multiple­
cel Actor, it's useful to bear in mind the principles of animation 
outlined in Chapter 2 of this manual. 

To illustrate the procedure of creating a multiple-cel Actor, the 
following example will guide you through the steps of producing a 
duck flapping its wings. Before starting to draw, plan the Actor by 
asking yourself questions about it: How many cels will the duck 
have? Will it be color? Will it be realistic or in a cartoon style? How 
large will it be? Will it fly straight across or up and down? What 
action or rhythm should the duck's wings have? How will its cels 
cycle through the flapping of the duck's wings? 

In this example, the Actor will be a mallard duck with four cels 
showing different wing positions. 
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Creating an Actor's First Cel 
To create the first eel of the Actor: 

1. Choose New ActorlProp from the Objects menu. 

The New Actor dialog appears. 

2. Enter Duck for the name of the new Actor. 

New Actor ... 

Name: ~IO_UC_k ________________ ~ 

@Actor 
QProp 

3. Choose OK. 

Cancel ) I OK B 

The blank Actor window appears. 

With proper planning you can minimize the amount of steps 
that it might otherwise take to create the four different eels of the 
duck. By drawing the body first (mid-section of the duck), you 
can create the parts that will remain the same in all four eels of 
the duck. 

4. Use the Pencil tool in the Paint palette to draw the body of the 
duck in the first cel. 
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Try to draw the shape as shown in the eel window. It doesn't 
have to be perfect. You might want to draw the mid-section first, 
then the head and the tail. 

Take as much time as you want with the first drawing. The idea 
is to rough in the body, then add the detail. Before we insert the 
other three eels, draw and color the parts of the duck that will 
remain similar in all four eels. Now is the time to add things 
such as color and shadow details to give it depth. This will help 
to reduee the flickering and odd movement of pixels in the eel 
drawings. 

5. Use the Paint Bucket tool in the Paint palette to drop different 
colors into the mid-section, bead, neck, feet and tail feathers. 

Head: Make the head dark green and add light green to the top 
to give it some shape. 

Neck: Leave a small white space between the head and the neck. 
Then paint the neck red, with some slight variation in red to give 
it more shape. 

Mid-section: Add some gray lines at the top and the bottom of 
the body to give it some shape. 

Tail Feathers: Add dark and light green, and leave white in the 
back part of the tail feather. 

Beak and Feet: Add dark and light orange for the feet and beak. 
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Duplicating Cel Contents 
The duplicate feature in the Insert Cels dialog allows you to dupli­
cate the contents of the first eel into the new eels that you insert. You 
can use this feature to duplicate parts of Actors without having to 
draw them again or use copy and paste. 

L Choose Insert Cels &om the Edit menu or double-cllck the Cel 
Counter. 

The Insert Cels dialog appears. 

2. Enter 3 for the number of eels to insert. 

3. Check the Duplicate Cel Contents box. 

" CUckOK. 

Insert Cels ••• 

Number of Cels 10 Inserl: [] 

181 Dupllcale Cal Canlants 

( Cancel ] I OK I 

The eel Counter changes to reflect the new eel count. It should 
reference 2 of 4, informing you that the current eel is the second 
of four. H you click the eel forward arrow, the counter and eels 
change, but since the contents are identical no visible changes to 
the Actor appear in the Actor window. 

Using Onion-Skinning to Add Motion 
It is time to add motion to the duck by drawing its wings in different 
flight positions. To move through the air, a bird glides or flaps its 
wings up and down. So start with the wings in the up position, 
work down, then back up to repeat the cycle. This should take four 
steps. Draw aU the eels using the Pencil tool first, then add color. 

1. Click the eel forward arrow to show cell of 4. 
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2. Use the Pencil tool from the Paint palette to draw the wings in 
the upstroke position. 

3. Advance to cel2 of 4 by clicking on the cel forward arrow. 

Animators use acetate eels to view the previous or next eel to 
trace a new eel over it. ADDmotion II's "Onion-skin" feature lets 
you do the same. 

NOTE: The Onion Skin item is only available in the Options menu 
when the Actor you are working on has more than one eel. 

4. Choose Onion Skin from the Options menu and then from the 
hierarchical menu, choose Previous CeL 
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There are three choices: Previous Cel, Next eel or None. 

The image from the first eel appears behind the current eel at 
30% of its actual saturation. This is useful for drawing the new 
image in the current eel, because the onion-skinned eel aets as a 
reference point. 

To trove through the air, a duck glides or flaps its wings up 
and down. As the wings move down, the feathers close and 
push the air downwards and backwards to lift the duck up. 

s. Use the Pencil tool from the Paint tool palette to draw the 
wings in the downstroke position. 

6. Advanee to cel3 of 4 by clicking on the eel forward arrow. 

As the wings of the duck move back up, the feathers separate to 
allow the air to pass through. 

7. Use the Pendl tool to draw the wings showing the feathers in 
the separating position. 
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8. Advance to cel4 of 4 by clicking on the cel forward arrow. 

In the last eel, the wings of the duck should be in a position 
between that of the third eel and the first eel. This will allow for 
smooth rhythm and timing. A duck's wings move up faster than 
they move down, so the wings in the last eel should be very 
close to their position in the first eel. 

9. Choose Onion Skin from the Options menu and then from the 
hierarchical menu, choose Next Cel. 

The image from the first eel appears behind the current eel at 
30% of its actual saturation. This makes it easy to traee the new 
wing positions for the last cel. 
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10. Use the Pencil tool to draw the wings showing them a little 
further back and down slightly. 

Before coloring the eels, test the rhythm of the duck's movement 
and make refinements if the rhythm is off. It is a good idea to 
make these changes to your pencil drawings, rather than spend 
a lot of time adding detail only to find out that you need to 
change the basic drawings. Now you are ready to add color to 
the wings. 

11. Choose Onion Skin from the Options menu and then from the 
hierarchical menu, choose None. 

12. Use the Pendl tool, Paint Bucket or Paint Brush from the Paint 
tool palette to color the wings in all four cels. 

Use a light brown on the feathers and add some grey lines on 
the underside to add shape. Cycle through the eels again to 
view the color and rhythm. 
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If the rhythm and color seem right, save the Actor. 

13. Click the close box in the Actor window. 

The Save dialog appears. 

14. Click Save. 

When given a path, the fouHel Actor appears to fly across the 
scrccn. 

~---------- .• ~----------. 
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Using Tween eel to Add Motion 
Once you have created the first eel of an Actor, you can use the 
Tween Cel feature to rotate, scale, fade or flip that image over a 
specified number of cels. For details, see Tween eel in Chapter 4. 

Creating a Prop 
While Actors can have one or many eels, Props always have only one 
cel. Props fonn the background in front of which Actors move. They 
help to create the setting of your animation. 

To create a Prop: 

1. Choose New Actor/Prop from the Objects menu. 

The New Actor dialog appears. 

2. Click the Prop button. 

The dialog's title changes to New Prop. 

New Prop ... 

Name: 

o Rclor 
® Prop ( Cantel I I OK , 

3. Enter a name for the new Prop. 

4. Click OK. 

S. Use the tools in the Paint palette to draw the Prop. 

6. Click the window's close box when you have completed the 
image. 

You are asked if you want to save changes. 

7. Click Save. 

Recording a Sound 
ADDmotion II lets you record sounds using an Articulate Systems™ 
sound digitizer, MacRecorder or built-in sound input device. 

To create a new sound effect: 
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1. Choose Add Sound hom the Objects menu or click the Add 
Sound icon in the Media Controller. 

The Select a Sound dialog appears. 

NOTE: If the New button is dimmed, your Macintosh might not have a 
recording device such as Articulate Systems or a built in microphone 
available on some Macintosh mode/so You might also want to check to 
see that the MacRecorder Extension is in the System Folder. 

2. Click New. 

The New Sound dialog appears, allowing you to record a new 
sound. 

[J[!]@][IJ <])>> 
Selecl 0 S [ Concel ) -_. St", P .... p ..... 

bouncing I I 0:02 I Soue I drum roll 0 miwtH 227 

engine n 
.•• l· ... :::~::~-:. ..... ;,~ , , , 

hemmer ( Remoue ) 
racing car 
spuller (Import...) 

tommy gun 
~ , Rdd , SMnplin9 R:.t. 22 kHz 

[81 Preuiew ( None ) ( Cancel ) 
Siu. 127?J t.at t., 
ltf'l9th. 0 uconds 

3. Click Record to start recording a new sound. 

4. Click Stop to stop recording the sound, or Pause to pause 
recording. 

5. Click Play to hear your new sound. 

For infonnation on editing sounds, see Chapter 8. 
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Chapter 7: Creating an Animation 

lbis chapter expIains how to create an animation using Actors and 
Props which you import or produce with ADDmotion II's Paint. The 
Media Controller contains the tools you need to manipulate the 
various parts of your animation to get the results you want. 

The Media Controller 
The Media Controller has controls similar to a VCR. Use the Media 
Controller in Play Only mode to play, stop, pause or rewind your 
animations. The Media Controller defaults to the Build mode (with 
Media tools available> when you create a new animation. You will 
spend most of your time using the Media Controller in Build mode 
to create, edit and play your animations. 

Media Controller in Ploy Only Mode 
If the Media Controller is in Build mode, you can click the zoom box 
to set it to Play Only mode. 

Loop Ninalion OnIOff 
DI1.gBar SOll'ldOn/Off 

OoseBox : Opent.4e. Toob 

FrameColl'ller l'nImeRale 

Reset Go To Lest Frame 

PlayReverse PlayForwd 

step Frame Reverse Step Frame FCII"treI'd 

FestR ..... d FuiForwd 

Pause NWnefion 

St op Anirneti on 

Close Box 
Click the close box to hide the Media Controller. 

Drag Bar 
Use the Drag Bar to move the Media Controller around the screen, 
by clicking on the bar, dragging the Controller to the desired loca-
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tion, then releasing the mouse button. When you open ADDmotion 
II, the Media Controller appears where it did when you last quit the 
program. 

Open Media Tools 
Click this button to hide or display the Media tools. 

Frame Counter 
The Frame Counter displays the current frame number. When an 
animation is playing, the Frame Counter increments one frame at a 
time until the end of the animation. If you press Stop or Pause, the 
frame counter stops. If Loop Animation is On, the animation starts 
again at the beginning after it reaches the end. Double-click the 
Frame Counter to display the Move to Frame dialog, allowing you to 
go to any frame of the animation. 

Reset 
Click this button to go to frame 1 of the animation. Press the Option 
key and click this button to go to frame O. 

loop Animation On/Off 
If Loop animation is On, the animation plays over and over again in 
a continuous loop until you stop it. If it is Off, the animation plays 
once and stops on the last frame of the animation. 

ffi] Sound On/Off 
Toggle this button to turn the Macintosh sound speaker On or Off. 

Go To last Frame 
Click this button to go to the last frame of the animation. 

Play Reverse 
Click this button to play the animation in reverse. 

Stop Animation 
Click this button to stop the animation. 

Play Forward 
Click this button to play the animation. 
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Step Frame Reverse 
Click this button to step the animation one frame in reverse. 

Pause 
Click this button to pause the animation on a particular frame. Click 
it again to resume the animation. 

Step Frame Forward 
Click this button to step the animation one frame forward. 

Fast Rewind (Skip) 
Click this button to play the animation in reverse by the number of 
Skip frames. The number of Skip frames is set in the Animation 
Options dialog. You can click the Fast Rewind button while an 
animation is playing to slow it down. 

Fast Forward (Skip) 
Click this button to play the animation by the number of Skip 
frames. The number of Skip frames is set in the Animation Options 
dialog. You can click the Fast Forward button while an animation is 
playing to speed it up. 

Media Controller in Build Mode 
If the Media Controller is in Play Only mode, click the Open Media 
box at the top right comer to set it to Build mode. 

Path Tool Object Selection Tool 

Place Actor Place Prop 

AddCue Add Sound 

Add Evenb Sho ..... TimeLines 

Bring to Front Bring Closer 

SendtoBeck 

Send Farther 

The Media options available to you depend on whether you have 
selected the Path tool or Object Selection tool. First click on the 
Object Selection tool. 
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Object Selection Tool 
The Object Selection tool (also known as the Pointer tool) allows you 
to move and manipulate placed Actors and Props. You can further 
manipulate them using various dialogs. 

To get the Actor Information dialog to appear, double-click a placed 
Actor or choose Get Info from the Media menu with an Actor se­
lected. Use this dialog to change an Actor's information. You can 
display and change a Prop's information in a similar way. 

(Refer to Actor/Prop lnfonnation Dialogs in Chapter 9 for details.) 

Place Actor 
Click the Place Actor icon to place a new Actor starting on the 
current frame in the animation. When you click this icon the Select 
an Actor dialog appears allowing you to select an Actor from the 
library. 

(Refer to Select an Actor Dialog in Chapter 9 for details.) 

Place Prop 
Click the Place Prop icon to place a new Prop starting on the current 
frame in the animation. When you click this icon the Select a Prop 
dialog appears allowing you to select a Prop from the library. 

(Refer to Select a Prop Dialog in Chapter 9 for details.) 

Add Cue 
Click the Add Cue icon to add a new Cue to the animation. The Cue 
Information dialog appears, allowing you to enter a Cue name, 
conditions and commands. Cues give you control over events such 
as the playing of CD and videodisc players, visual effects and move­
ments between different animations, and pauses in your animation. 

(Refer to Cues in Chapter 9 for details). 

Add Sound 
Click the Add Sound icon to add a sound to the animation. The 
Select a Sound dialog appears, allowing you to select or record a 
sound. 

(For more information on sound, see chapters 6 and 8.) 
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Add Events 
Click the Add Events icon to add load and stamp events to the 
animation. The Event Information dialog appears. 

A load event loads any Actors, Props and Sounds that are currently 
unloaded and used between one load event and another. There is an 
implicit load event on the first frame of the animation. This means 
that a complex animation with many objects to be loaded will take 
some time to open unless load events are added. 

A stamp event allows your animation to run faster by turning the 
image on the current frame into a Prop. This allows you to freeze the 
action of one frame and animate Actors over this background. Any 
Prop transitions interrupt a stamp event. 

A continuous stamp event does a stamp event on each frame of the 
animation that it is active. 

(Refer to Load and StIlmp Events in Chapter 10 for details.) 

Show TImeUnes 
Click the Show TimeUnes icon to display the TimeLines window. 

(Refer to the TimeUnes section later in this chapter for details.) 

Bring To Front 
Select an Actor or Prop, then click this icon to move the object to the 
front of the appropriate layer. There is no keyboard equivalent for 
this tool. 

NOTE: Actors reside in their own layer and are always placed in front of 
Props. 

Bring Closer 
Select an Actor or Prop, then click this icon, or Command-Plus (+), to 
move the object one position forward in the appropriate layer. You 
would want to move an object forward when a second object is 
covering it, not allowing you to select the object. You can also use 
this command to move an object to a desired position in the layer. 
Keep using the command until the object is in the layer that you 
want. If the object is in the top of the layer the command has no 
effect. 
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NOTE: Actors reside in their own layer and are always placed in front of 
Props. 

Send Farther 
Select an Actor or Prop, then click this icon, or Command-Minus(-), 
to move the object back one position in the appropriate layer. The 
Send Farther command moves the selected object one layer further 
back in its layer, relative to the other objects in the layer. You would 
want to move an object further back when it's covering a second 
object, not allowing you to select the object. You can also use this 
command to move an object to a desired position in the layer. Keep 
using the command until the object is in the layer that you want. If 
the object is in the furthest position in the layer the command has no 
effect. 

NOTE: Actors reside in their own layer and are always placed in front of 
Props. 

Send to Back 
Select an Actor or Prop object, then click this icon to move the object 
to the back of the appropriate layer. There is no keyboard equivalent 
for this tool. 

Media Controller in Path Mode 
With the Media Controller still in Build mode, click the Path tool 
icon. Ten different Media tool icons appear. These icons are dimmed 
until you select an Actor with the Path tool. 

"o",;""·"·;;·",;;·;;,,,·,,,',','e;E',i.i#il!l'ii 
PalhTool 11 I ~ ~ ObjeclSelectionTool 

Smoothing 1~1El~~~gJ~[E)~~U~.~.R-Polh Scaling 
Path Porllnformalion --I ~ ,,,. Distributing 

IT] a i.!.J :1 .& 
P-'hOption° -IJ.Y eel Sequencer 

'" "~ @] IJ!] [}~ Il!IW Revel'3e Path Points 
Pal h Inr ormation Tr~~~~~· .. j·1~61~:r'~ 

~ ~ ':!oo.,J FipHorizontally 

~ Flip Vertically 
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Path Tool 
Use the Path tool to add, create, or change points on an Actor'S path. 

To create a path for an Actor: 

1. Click the Path tool icon. 

2. Select an Actor. 

The Actor's default single-point path appears. 

3. Click new points for the path of action or drag the mouse with 
the Command key held down to rapidly add points to the 
Actor's path. 

NOTE: Path points are added after the currently selected path point. 

NOTE: If an Actor is locked (see Actor Information Dialog in Chapter 9), 
you must first select it with the Object Selection tool, then click the Path 
tool icon before using any of the following path editing tools. 

Smoothing 
To smooth the points on a path: 

1. Click on an Actor with the Path tool. 

The Actor'S path appears. 

2. Click the Smoothing icon. 

Each time you click the icon the path becomes smoother. 
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Path Scaling 
To scale a path: 

1. Click on an Actor with the Path tool. 

The Actor's path appears. 

NOTE: The path must have at least two points for Path Scaling to work. 

2. Click the Path Scaling icon. 

The Scale Path dialog appears, allowing you to set a desired 
number of path points to scale the path to. The default value is set 
to the number of frames that the Actor is employed in the 
animation. 

SeDle PIth ... 

[ur-,...nt number of pOints: 32 

Desired number of points: 1[g1f~1I. 

~I OK ] 

3. Enter a number in the Desired Number of Points field. 

4. Click OK. 

Path Point Information 
To get information on a selected path point: 

1. Click on an Actor with the Path tool. 

The Actor's path appears. 

2. Click the Path Point icon or double-click the point 

The Path Point Information dialog appears, giving you the point's 
screen coordinates and allowing you to change its location. 

3. Enter new horizontal or vertical screen positions if you want to 
move the point to a specific screen location. 

4. Check the Loop to Here box, if you want the point to be the 
loop point on a path. 
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5. Click OK. 

Distributing 

Palh Polnl Informallon ••• 

Polnl Number: 4 

horlz: _I 0 Loop Te Here 

uerl: 183 1 

( Cennl J I OK I 

To equalize the distance between all points on a path: 

1. Click on an Actor with the Path tool. 

The Actor'S path appears. 

2. Click the Distributing icon. 

When you click the iron the points on the path become equally 
distributed. 

NOTE: Smoothing, Salling and Distributing also work on a range 0/ 
selected ~th points. 

Path Options 
To change the Path Options: 

1. Click on an Actor with the Path tool. 

2. Click the Path Options icon. 

The Path Options dialog appears. 

Potll o,Uons ... 

o Rnow Rulo Serell Window 

o Grid Rnimatlon 

181 Shaw From. for Currenl Palh Polnl 

Path Size: [1:!] 
( cencel) I OK J 
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3. Check Allow Auto Scroll Window if you want the contents of 
the window to scroll when you drag path points near the edge 
of it. 

This allows you to make Actors animate on and off the screen. 

4. Check Grid Animation to see each path point snap to an 
invisible grid. 

To set the size of the grid and to tum it on, choose Animation 
Options from the Media menu. 

5. Check Show Frame for Current Path Point to display the 
animation frame for the path point that is currently selected. 

This allows you to see exactly where your Actor is on that frame. 

6. Select a size from the Path Size pop-up menu. 

On a large monitor, a wider path is easier to "grab." 

7. Click OK. 

eel Sequencer 
Click on an Actor with the Path tool, then click the Cel Sequencer 
icon to set which cel of an Actor is shown on each frame, as well as 
adjust its size and opacity. 

(Refer to Cel Sequencer later in this chapter for details). 

Path Information 
To get information on a path: 

1. Click on an Actor with the Path tool. 

The Actor's path appears. 

2. Click the Path Information icon or double-click the Actor. 

The Path Information dialog appears. 
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Path Inform.tion ... 

P.th 

Number of Points: 23 
Selection R.nge: I to I 

[Smooth ... ] 

[ Sc.I .... ] [C ... c.1 I OK I 

3. To change the path's name, type a new name into the box. 

4. Choose Smooth to bring up the Smooth Path dialog. 

There are three degrees of smoothing: None, Slight, and Nonnal. 
Check Disbibute Points to space points evenly along the path. 
OickOK. 

Smooth Path ... 

rDegree of Smoothing l 
I ® None 0 Norml' 0 (Htreme 

o Distribute Points 

( Cente. I I OK I 

5. Choose Scale to bring up the Path Scaling dialog. (See Path 
Scaling earlier in this chapter for details). 

6. Click OK. 

Reverse Path Points 
To reverse the direction of points on a path: 

1. Click on an Actor with the Path tool. 

The Actor's path appears. 

2. Click the Reverse Path Points icon. 

All points on the path are reversed, with the first point becoming 
the last. The Actor will now move in the opposite direction on the 
path. 
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To reverse a range of path points: 

1. Click on an Actor with the Path tool. 

2. Select a range of points in the path. 

3. Click the Reverse Path Points icon. 

The range of points is reversed. 

Flip Vertically 
To flip a path vertically: 

1. Click on an Actor with the Path tool. 

2. Click the Flip Vertically icon. 

The path is flipped top to bottom. 

To flip a range of path points vertically: 

1. Click on an Actor with the Path tool. 

2. Select a range of points in the path. 

3. Click the Flip Vertically icon. 

The range of points is flipped top to bottom. 

Flip Horizontally 
To flip a path horizontally: 

1. Click on an Actor with the Path tool. 

2. Click the Flip Horizontally icon. 

The path is flipped right to left. 

To flip a range of path points horizontally: 

1. Click on an Actor with the Path tool. 

2. Select a range of points in the path. 

3. Click the Flip Horizontally icon. 

The range of points is flipped right to left. 
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eel Sequencer 
The eel Sequeneer gives you full control of the appearance of your 
Actors during an animation. With the Cel Sequencer, you can select 
which cel of an Actor will appear on any given frame, as well as its 
size and opacity. 

In its default mode, the eels of an Actor cycle over a series of path 
points with each frame or point representing one eel. For example, 
an Actor with four cels automatically has its first eel assigned to the 
fifth path point and so on. 

Frame: 
eel to Show: 

1 234 5 6 7 8 
1 234 1 234 

This sequence gives a steady rhythm and repetition to the Actor's 
movements. When an animation cans for irregular rhythms, you can 
achieve this by repeating a cel over several path points, reversing the 
cel cycle, skipping cels in the cycle, and so on. For example, when 
animating an Actor with four eels you might have the Actor remain 
motionless over a few path points, then move in reverse. 

Frame: 
eel to Show: 

1 234 5 678 
1 1 143 2 1 4 

The Sequeneer has three modes: 

• eel Size (to set the scale of the cel on a frame from 0-100%) 

• eel to Show (to set a specific cel to show on a frame) 

• eel Opacity (to set the opacity of a cel on a frame from 0-100%) 

ISet Range ... I The eel Sequenee Editor dialog is displayed when you choose Set 
Range from within the Cel Sequencer, providing shortcuts in setting 
size, sequence and opacity over defined ranges of cels. 

Follow these steps to open the Cel Sequencer: 

1. Click on an Actor with the Path tool. 

2. Click the eel Sequencer icon. 

The eel Sequencer window appears. 
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3. Click the window's zoom box to extend the Cel Sequencer to 
display more frames of the animation. 
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The zoomed window allows you to quickly sequence and modify 
cels over eight frames at a time. To display more frames of the 
animation, use the scrollbar. The preview box shows you the 
selected cel. 

SeHing eel Size 
1. Click the Cel Size mode button to set the size of individual eels. 

2. Click on a frame number. 

3. Use the control arrows to adjust its size. 

Full size is 100% and 1 % is the smallest visible size. The size scale 
goes up and down in increments of 1 % (unless you hold down 
the Shift key to move in increments of 5%). 

4. Use the scroll bar to move to more frames, then repeat steps 2 
and 3. 

With the eel Sequencer you can set the cel size to give the effect of an 
Actor moving toward or away from the viewer. This is otherwise 
known as creating a perspective view. 
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In this example the dog appears to move from the background to the 
foreground because its eel size enlarges frame by frame. 

12 13 14 15 

7:5 80 85 90 

Cel Size Ranges 
For a shortcut in setting eel size over a defined range of cels: 

1. Click the Set Range button while the Cel Sequencer is in Cel 
Size mode, or double-click the Cel Size mode button. 

The eel Sequenee Editor dialog appears. 

Cel Sequence Editor ••• 

Rctor. note (bOwl 

Hum Cels: 8 

J Stert Frome: 1 

End Frome: 118 

I Small to lerse .... 1 
Freme: 53 

Renge: from frame 0 to IT!D 
Ualul 81 frame I, is:f.!!I.!.l!;l 

( Rpply II Done » 
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2. Choose one of the size options in the pop-up menu. 

The Cel Sequence Editor can display the range of cels at Full Size, 
Small to Large, Large to Small, Medium to Large, Large to 
Medium, Constant or Random. You can choose a different option 
for each series of cels whose numbers you enter in the Range 
boxes. 

3. Define a range of cels. 

4. If you set the size option at Constant, you can adjust the size of 
the range of cels by setting the percentage size of its first frame 
in the Value box. 

5. Click Apply. 

6. If you want to apply additional size sequences, repeat steps 2 to 
5. 

7. Click Done when you have made all your choices. 

NOTE: You must click the Apply button each time you set a size aption and 
a selection range. This allows you to sequence several ranges at one time. 

Setting Cel to Show 
IijlI 1. Click the Cel to Show button to assign cels to frames. 

When an Actor is selected, you can change the cel sequence on 
any frame the Actor appears on. 

2. Click on a frame number. 

3. Use the cel control arrows to select the desired cel to show. 

The cel preview allows you to see the current cel. You also see the 
cel displayed on the specific path point in the animation window. 

4. Use the scroll bar to move to more frarnes, then repeat steps 2 
and 3. 

You can modify an Actor's movements by changing the sequence of 
cels to show. Reverse the cel cycle to make the Actor move back­
wards. Show the same cel over two or more frames to make the 
Actor appear motionless. In this example, the cheetah's leap is 
lengthened by repeating cel 4 over frames 4,5 and 6. 
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eel to Show Ranges 
For a shortcut in setting the cel sequence over a selected range of 
cels: 

1. Click the Set Range button while the Cel Sequencer is in Cel to 
Show mode, or double-click the Cel to Show button. 

The Cel Sequence Editor dialog appears. 

2. Choose one of the eel sequence options &om the pop-up box. 

The Cel Sequence Editor can display the range of cels in Cycle 
Forward, Cycle Reverse, Ping Pong, Still, Slow Forward, Slow 
Reverse, Slow Ping Pong or Random. You can choose a different 
option for each series of eels whose numbers you enter in the 
Selection Range boxes. 

3. Select a range of eels. 

4. Select the eel you want the eel sequence to start on in this range, 
or accept the default eel in the Value at frame box. 

5. Click Apply. 

6. If you want to apply additional eel sequences, repeat steps 2 to 
5. 

7. Click Done when you have made all your choices. 

NOTE: You must click the Apply button ellCh time you set an action and a 
selection range. This allows you to sequence several ranges at one time. 

Chapter 7: Creating an Animation 133 



SeHing Opacity 
1. Click the bottom mode button in the Cel Sequencer to set the 

opacity of individual eels. 

2. Click on a frame number. 

3. Use the control arrows to adjust its opacity. 

Fully opaque is 100% and fully transparent is 0%. The opacity 
scale goes up and down in increments of 1 % (unless you hold 
down the Shift key to move in increments of 5%). 

4. Use the scroll bar to move to more frames, then repeat steps 2 
and 3. 

NOTE: Set the Actor's drawing mode in the Actor lnfonnation dialog to 
Sequence Opacity in order to see any changes made here. 

NOTE: You must be working in color mode for the adjustments in opacity 
to show in your animation. 

You can use the Cel Sequencer to set cel opacity to make an Actor 
appear to fade in or out over a range of frames. In this example, you 
can see the percentage settings on each frame. 
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Opacity Ranges 
Follow these steps for a shortcut in setting cel opacity over a selected 
range of cels. 

1. Click the Set Range button while the Cel Sequencer is in Cel 
Opacity mode, or double-click the Cel Opacity mode button. 

The Cel Sequence Options dialog appears. 

2. Choose one of the opacity options from the pop-up box. 

The Cel Sequence Editor can display the range of cels at Fully 
Opaque, Fade In, Fade Out, Constant and Random. You can 
choose a different option for each series of cels whose numbers 
you enter in the Selection Range boxes. 

3. Select a range of eels. 

4. If you set the option at Constant, you can adjust the opacity 
value for the range of eels down towards transparent, or leave 
the value at 100 (fully opaque) in the Value at frame box. 

5. Click Apply. 

6. If you want to apply additional opacity sequences, repeat steps 
2 to 5. 

7. Click Done when you have made all your choices. 

NOTE: You must click the Apply button tIlCh time you set an action and a 
selection range. This allows you to sequence several ranges at one time. 

Creating a New Path 
Creating a Path for an Actor is as easy as clicking points on the 
screen. When an Actor is placed in an animation, it is placed at a 
specific location on the screen and is given a one-point path. To add 
more points to its path, select the Path tool in the Media Controller, 
select the Actor, then click a number of new points. When the anima­
tion is played back, the Actor animates or moves along the points on 
the path. 

The Actor's speed is dependant upon the distance between the path 
points. The closer together the points, the slower the Actor moves; 
the further apart the points, the faster the Actor moves. 

This example shows a 24-point path. The last point (inverted rectan-
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gle) automatically defaults to being the loop point. The. Actor ani~ 
mates from the first point, along the path to the last pomt. When It 
reaches the last point, the Actor loops, until it reaches the Actor end 
frame. If the end frame is the same frame that the last point is on, the 
Actor disappears, and does not loop. 

If there is no loop point and there are fewer points in the path than 
the number of frames the Actor is employed for, then the Actor will 
disappear after the last point. 

,.._.-. 
,/ / ............ • r .... 

Q-."-' ~ ! \ 
't \ ~ " • ..... -. 

Using the Command Key to Add Points 
There is a quicker way to create a path than clicking individual 
points. Hold down the Command key and drag the mouse around 
the screen, adding points as you move it around. To stop adding 
pOints, release the mouse button. 

SeHing a Path Loop Point 
Loop points are useful when you want an Actor to animate on the 
spot or to repeat a sequence over and over. Any point on the path 
can be designated as the loop point. If you designate a point in the 
middle of the path, the Actor animates along the path from the start 
point to the end point, then starts at the loop point and animates 
until it reaches the end point, when it will go back to the loop point. 

To set a Loop point, double-click a point and check Loop To Here, 
then click OK. The path segment between the end point and the loop 
point will be drawn in gray. 
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Moving Points on a Path 
To move a point, select it and drag it to a new location on the screen. 
The point and the interconnecting lines become grayed as you drag. 
You can see the point's original location until you release the mouse 
button. 

The path is updated to reflect the new location of the point. 
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Adding Points to a Path 
New points can be added anywhere on the path. To add a new point, 
select a point and click a new point after it. Points are always added 
after the selected point. The loop point is always a rectangle, and all 
other points are circles. 

Deleting Points on a Path 
To delete or remove points on a path, select a point, then press the 
Delete key. One point is removed every time you press the delete 
key and the points arc removed back towards the start point. 
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Selecting a Range of Points on a Path 
To select a range of points in a path, click on the first point that you 
want selected, hold the shift key down and then click on the last 
point that you want selected, and the inbetween points are selected 
as a range of points. The selected points can be moved to a new 
screen location, and they can be deleted, scaled, smoothed, distrib­
uted, cut, copied and pasted. 

Path Informallon ••• 

Pith: 

Number of Poinls: 25 

Selection Ringe: ito 16 
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Deleting a range of path points: 
To delete a selected range of points, press Delete. 

Smoothing a path: 
To smooth a path, select an Actor with the Path tool, then click the 
Smoothing icon. For greater control on how the path is smoothed, 
select an Actor with the Path tool, then click the Path Information 
icon. When the Path Information dialog appears, click the Smooth 
button and choose a smoothing method, then click OK. 

Scaling points in a path: 
To scale points in a path, select the Actor with the Path tool, then 
click the Scale Path icon. The Scale Path dialog appears. Enter the 
desired number of points to scale, then click OK. 
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Moving a range of path points: 
To move a selected point or a selected range of path points, click and 
hold down the mouse button while you drag the point or points to 
the desired location. 

NOTE: You can move a selected point or range of points, by pressing the 
left arrow, right arrow, up arrow and down arrow keys on the keyboard. 
Hold down the Shift key to move selected points by 5 pixels at a time. 

Grid Size 
You can use ADDmotion II's invisible grid to help you create uni­
form, straight lines in a path. All points in the path snap to the grid. 
To set the Grid Size, choose Animation Options from the Media 
menu. Choose the Grid Size pop-up menu and select a new grid size. 

In the following example, the Grid Size is set to 20 pixels. When you 
add a point to the path, it snaps to the closest 20th pixel. 

Path Size 
The Path size can be changed in the Path Options dialog. The Path 
size can be 4,6,8,10 or 12 pixels in size. To set the Path size, click the 
Path Options button in the Media Controller. Choose the Path Size 
pop-up menu and select a new path size. 

In the following example, the Path Size is set to 10 pixels. Changing 
the point size makes points more visible when making path point 
adjustments and easier to "grab" too. 
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Quick View of Object's Start and End Frames 
You can view an object's name, start and end frames without access­
ing the TimeUnes window or Get Info dialog. Hold down the 
Command and Option keys until the cursor changes to a question 
mark, then click on the object until a small information pop-up 
appears displaying the object's name, start and end frame informa­
tion. The pop-up remains visible until you release the mouse button. 

This example shows an Actor's name, start and end frames. 

StirtFn'M 1 
End FrllM 200 

You can get the same information for Actors and Props using System 
7's Balloon Help. Tum on Balloon Help by choosing Show Balloons 
from the Help menu, then move the cursor over an Actor or Prop. 

TimeLines 
ADDmotion II's TimeLines feature lets you see the various elements 
that make up an animation and perform editing functions. 

There are two methods to display the TimeUnes window: 

• Select the Object Selection tool in the Media Controller, then 
click the Time Lines icon. 
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• Choose Show TimeLines from the Media menu. 
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Resizing the TimeUnes Window 

You can resize the TimeLines window by clicking the grow box in 
the bottom right hand comer and dragging the window to a new 
size. You can also use the zoom box in the upper right hand corner to 
expand the window and show the animation's total frame count. 
When you click the zoom box, the zoomed window appears at the 
bottom of the screen. 
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Placement of Objects in the TimeLines Window 

Every object in the animation appears with a descriptive icon beside 
it. The object has a name and a "timeline" that represents the number 
of frames that the object is employed in the animation. Items that 
appear in bold are locked. Items in italic are not in memory. 

Using Object Icons to Change Usts and Frame Scale 

The six icons in the top left area of the TimeLines window let you 
temporarily hide objects from the list and change the scale of the line 
representing the frames in your animation. 

The first five icons represent the Actors, Props, Sounds, Cues and 
Events in your animation. When an icon is highlighted, all the objects 
in that category appear in the TimeLines window. If you click the 
icon to deselect it, the objects in that category are temporarily hidden 
from the list. 

The sixth icon is useful in changing the scale of the frame line. When 
the TimeLines Scale icon is highlighted, the scale equals one mark for 
every five frames, regardless what size the TimeLines window is. If 
you click the icon to deselect it, the scale automatically adjusts to 
include all the frames of your animation within the TimeLines 
window. 

Tuming Objects Off and On 
The checkbox to the left of each object's descriptive icon allows you 
to tum that object off and on. This makes work on complex 
animations easier by temporarily removing objects from the screen. 

NOTE: You cannot check or uncheck these boxes if the Media Controller is 
in Path Edit mode. 

Adjusting the Start and End Frame for an Object 

To adjust an object's start frame: 

1. Move the cursor near the start frame handle on the object's 
timeline. 

The cursor changes to a on~irectional arrow when it is over the 
start frame handle. 
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2. Drag the handle to a new start frame. 

The object's start frame number at the bottom of the window 
changes as you drag the handle horizontally along the frame 
counter. 

3. Release the handle when the Start Frame number appears at the 
frame you want. 

The object's timeline is updated to reflect the changes to the start 
frame number. 

You can adjust the End Frame for the object using the same 
technique as illustrated for the Start Frame. 

Moving the Whole TImeLine 

An object's whole timeline can be moved left and right to a new 
position in the TimeLines window. 

To move a whole timeline: 

1. Move the cursor near the middle of the time line. 

The cursor changes to a two-directional arrow. 

2. Click and drag the time line to a new position. 

144 ADDmo/ion /I Manual 

The object's start and end frame numbers at the bottom of the 
window change as you drag the line horizontally. 



3. Release the line when you are satisfied with its new position. 

The object's timeline is updated to reflect the changes to the start 
frame and end frame numbers. 

NOTE: When you select an object in the TimeLines Winduw, it also 
becomes selected on the screen. You cannot select or deselect timelines if the 
Media Controller is in Path Edit mode. 

Checking the Animation by Moving the Play Indicator 
You can check your animation by either playing it using the Play 
button in the Media Controller or by moving the Play Indicator (the 
running stick man) forward or backward along the scale in the 
TimeLines window. 

To move the Play Indicator: 

1. Click on the Play Indicator and drag it to a new frame 
position. 

The current frame number changes as you drag the Play Indicator 
horizontally along the frame counter. As you drag the indicator, 
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the animation plays as you built it. In this example, the note 
animates along its path from left to right as the indicator is 
dragged from left to right. 

i'i' I '~ii; 

Notice that the Media Controller Frame Counter is updated as 
you drag the Play Indicator. 
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Deleting Objects from the TimeLines Window 
To delete an object: 

1. Click on the object's icon or name. 
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The object's timcline becomes highlighted. (To select more than 
one object for deleting, hold down the Shift key as you click on 
their icons.) 



2. Press the Delete or Backspace key on the keyboard to remove 
the object. 

A dialog box appears, asking you to confinn your decision. 

3. Click OK to remove the object. 

The TimeLines window updates to reflect the change. 

NOTE: To delete an object without the confinnation dialog appearing, hold 
down the Option key, then press Delete. The object is removed. 

Memory Meter 
Every time you add a new object to an animation, memory is used. 
The memory meter informs you of available memory before you add 
objects. The higher the meter, the more memory being used. 

Memor., meter 

If an object is used once, then added again in the same animation, 
the available memory does not change much. 
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ChapterS: Sound Editing 

This chapter tells you how to modify the sounds you have recorded 
or created following the instructions in Chapter 6: Cretlting Actors, 
Props and Sound Effects or imported from a media library or other 
animations. 

Sound Information 
The Sound Information dialog lets you adjust a Sound once it has 
been added to your animation. To display the Sound Information 
dialog, double-dick the icon of a Sound in the TimeLines window or 
select the Sound in the TimeUnes window, then choose Get Info 
from the Objects menu. 
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Sound 
Every Sound is given a unique name when it is created. This name 
appears beside the Sound Selection icon. To change a Sound, click 
the Sound Selection icon. This lets you select another Sound to play 
this part. Select a new Sound from the Select a Sound dialog and 
click the Add button to replace the previous Sound. 

Playing TIme 
The Playing Time displays the Sound's length in seconds and in the 
number of frames. 
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Start Frame 
The start frame defaults to the frame number that the animation was 
on when the Sound was added. The start frame can be changed at 
any time as long as it is not a number larger than the end frame 
number. When added to the animation, the Sound starts to play on 
the start frame until it is finished, or the end frame is reached. 

End Frame 
The end frame defaults to the last frame of the animation. A Sound 
can stop before its end frame is reached. 

If Repeat Sound is checked, when the animation plays the Sound 
repeats until its end frame in the animation is reached. If Repeat 
Sound is not checked, the Sound stops at the end frame, if it is still 
playing. 

Priority 
The Priority pop-up menu lets you set the sound priority from 1 to 
16. More than one sound can be played simultaneously, depending 
on the type of Macintosh and the amount of memory available. 

The priority setting is used to determine which sounds will actually 
be heard when the animation is played. If you have 4 Sounds set to 
play on frame 10 and your Macintosh only supports 2 channels of 
Sound, then the 2 Sounds with the highest priority (lowest number) 
will be heard. It is best to create background noises (like an insect 
Sound) with low priority (possibly 16). With this scenario, temporary 
Sounds like a bird singing will override the insect Sound. If a Sound 
is interrupted by a high priority Sound, it will continue to play after 
the interrupting Sound is finished only if it is a repeating Sound. 
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The Volume pop-up menu lets you set the volume for the selected 
Sound. 7 is the loudest setting, 0 the quietest. 

Channel 
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Channel lets you choose a channel for the Sound. AIl Macs can play 
on left or center. The right channel can only be heard with stereo 
equipment connected to the sound output jack of those Macintoshes 
that support stereo sound. 
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Fade In 
Check the Fade In box if you want the Sound to fade in. If you set the 
volume to 5, the Sound will fade in over five frames. 

Fade Out 
Check the Fade Out box if you want the Sound to fade out before its 
end frame. If you set the volume to 5, the Sound will fade out over 
five frames. 

Repeat Sound 
Check the Repeat Sound box if you want the Sound to play over and 
over until its end frame is reached. 

Editing a Sound Effect Waveform 
A wavefonn is a graphic representation of a sound, with time along 
the x-axis and volume along the y-axis. You can modify a Sound by 
altering its waveform using a variety of tools. 

First open the Edit WaveFonn for Sound dialog: 

1. Click the Add Sound icon in the Media Controller or choose 
Add Sound from the Objects menu. 

2. Select a Sound. 

3. Click Add. 

4. Click Edit Sound. 

The Edit WaveForm for Sound dialog appears. 

The Edit WaveForm dialog has the following tools to let you modify 
the Sound: 
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Zoom In 
The Zoom In button displays more and more detail of the waveform 
for editing by zooming in to it. 

Edit Wllleronn 'Dr Sound: Sq ..... t 
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Zoom Out 
The Zoom Out button displays less and less detail of the waveform 
by zooming out from it, eventually displaying the whole waveform 
in the edit window. 

Edit W.uero .... 'Dr Sou.1I: Squ .... t 
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Louder 
The Louder button amplifies the whole wavefonn or the selected 
portion of the wavefonn making the Sound louder when it is played 
back. 

Softer 

Edit W.u.Form for Sound: Squ.wk 
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The Softer button will soften or decrease the amplification of the 
whole waveform or the selected portion of the waveform making the 
Sound quieter when it is played back. 
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Echo 
The Echo button echoes or repeats the whole waveform or the 
selected portion of the wavefonn with a decay. When played back, 
the sound will echo. aick the Echo button a number of times to 
increase the echo effect. 
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Backwards 
The Backwards button reverses the whole waveform or the selected 
portion of the waveform. When played back, the sound will play in 
reverse. 
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Play 
The Play button plays the whole waveform or the selected portion 
of the waveform. 

NOTE: You can interrupt playing at any time by clicking the mouse. 

lower Hz/Raise Hz 
Holding down the Option key causes the zoom buttons to change to 
Lower Hz and Raise Hz. Lower Hz makes the frequency of the 
Sound lower while Raise Hz makes the frequency higher. 

Ramp Up/Ramp Down 
Holding down the Option key causes the Louder and Softer buttons 
to change to Ramp Up and Ramp Down. Ramp Up makes the 
current selection or entire Sound start at a volume level of 0 and 
increase to a maximum volume. Ramp down does the opposite. 

Sound Details 
Details pertaining to the Sound are displayed in the bottom left 
corner of the dialog. 

Compression 
You can reduce the memory used to store the Sound by selecting 3:1 
or 6:1 from the Compression pop-up. The Sound will be com­
pressed when it is saved. The quality of a Sound is higher if it is not 
compressed. 

Undo, Cut, COPY, Paste and Clear 
To perform Undo, Cut, Copy, Paste and Clear, use the keyboard 
equivalents, as the menus are not available while you are in the 
Sound Editing dialog. Press Command-Z to Undo an action. 
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Cut 

To Cut a section of a sound, highlight the area by clicking the mouse 
down until an insertion line appears. Drag the mouse in either 
direction to select a section of the sound. Press Command-X to cut 
the selection to the Oipboard. The selected portion of the sound will 
be removed and placed in the Clipboard. 

[dll WI .. rlml 'Ir Sound: SquI .. k 

Size: a..... ~ [ Cincil I I SIUI I 
I ... ~ •• 
22l1li. 

Copy 

To copy a section of a Sound, highlight the area by clicking the 
mouse down until an insertion line appears. Drag the mouse in either 
direction to select a section of the Sound. Press Command-C to copy 
the selection to the Clipboard. 

Edit WIU.rlrm 'or S.und: Squlwk 

Slzl: 6411..... ~ [ ClnCiI I I SIUI I 
2 ... ~ •• 
221i11. 
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Paste 
To paste a section of a Sound from the Clipboard, click the mouse 
down in any area of the wavefonn until an insertion line appears. 
Press Command-V to paste the portion of the Sound from the Clip­
board into the waveform. The pasted portion of the Sound will 
appear in the waveform and the size of the sound will change 
because you are adding to the Sound. 

Clear 

£dil WoveForm for Sound: Squawk 

. ,; ~. . 
--~~~~ ~1~·." ~~::--"""""+-~'.~~~ :p'"',.~~r.;' .. ",~ 

Zoom'" Zoem Out 

Size: 6~bJt.s 
2,,,, 
22 "" 

" ", 

Loucifor Soft.,. Echo 8.ckw....-ds Pl~ 

To remove a section of a Sound, highlight the area by clicking the 
mouse down until an insertion line appears. Drag the mouse in 
either direction to select a section of the Sound. Press the Delete key 
to remove the selection. The selected portion of the Sound will be 
removed. 

Select All 

There are two methods for selecting all of the sound waveform: 

1. Drag the mouse from the start of the sound waveform to the 
end, or 

2. Press Command-A. 

NOTE: Most sound editing operations affect the entire sound if there is no 
selection. If you select part of the waveform, only that area is affected by the 
editing operation. 
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Chapter 9: Menus and Dialogs 

This chapter provides comprehensive infonnation about ADDmotion 
11'5 menu items and commands used to create animations. It also 
describes dialogs not covered elsewhere in the manual. 

ADDmotion II and HyperCard's File Menu 

. Edit lio Tools 
New Statk ... 
Open Stlltk... XO 
Close Statk XW 
SllIe II Copy ... 

New Animation .. . 
Open Animation .. . 
Link Animation .. . 

Compllct Stick 
Protect StIck ... 
Delete stack ... 

Pllgi Sltup .. . 
Print Fllld .. . 
Print Cllrd XP 
Print StIck .. . 
Print Report .. . 

Quit H perCllrd XQ 

ADDmotion II is designed to run as an integrated animation tool for 
creating animations in HyperCard 2.1. Animations can be created in 
any HyperCard stack as long as ADDrnotion II's New Animation 
and Open Animation menu items are available. Unk Animation 
allows you to link animations from within HyperCard. For informa­
tion on other File menu items, refer to your HyperCard manual. 

New Animation ... 
Choose New Animation to create a new animation in the current 
HyperCard stack. 
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New Rnimlltion •.• 

Nllme:~~ 
[lIncel OK 

When a new animation is created it is given the default name of 
Untitled. To give the animation a new name, type in a new name, 
then click OK. The HyperCard menu bar changes to reflect 
ADDmotion II's menus and the Media Controller appears. 

If you click Cancel, you remain at the HyperCard level. 

Open Animation ... 

Choose Open Animation to open an existing animation. When the 
Open Animation dialog appears, select an animation, then click 
Open. 

Selecliln Rnlmlltlon •.. 

EHdmple RmmdtJOn m New ••• 

[OuPllcllte 1 

[ RemoLJe 1 

L--______ l.-"..J0 t open) 

[ el'InCel 1 

If you click Cancel, you remain at the HyperCard level. From within 
the dialog you can also create a new animation, or duplicate or 
remove an existing onc. 

New ... 

Click the Ncw button to create a new animation. The New Animation 
dialog appears. 

160 IIDDmo/ion /I Manual 



Duplicate 
Click the Duplicate button to duplicate the animation in the current 
stack. Type in a name for the duplicate, then click Save. 

Remove 
Click the Remove button to remove an animation from the Hyper­
Card stack. A warning dialog appears asking whether you want to 
proceed with the command. If you click OK, the animation will be 
deleted. 

Unk Animation ... 
Choose Link Animation to link animations using Stack Script, Card 
Script or Buttons. When the Choose an Animation to link dialog 
appears, select an animation from the list, then click one of the 
buttons. The three linking methods are described later in this chap­
ter's Link hierarchical menu section. 

Choose In Inimltion to Lillk ... 

! IIdlflVlp HlllllldilUIl m 
[ StIck Script 1 

[ ClnI Script 1 

Button 

I Clneel I 
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ADDmotion II's Menus 

File Menu 

New Animation 

[dlt Go Objects 
New Animation... XN 
Open Animation... XO 
Close Animation XW 
Saue Animation XS 
Saue a Copy ... 

Import... ~ 
[Hport... ~ 

Link... ~ 

Page Setup ••• 
Print Cord XP 
Print Animation ... 

Quit HyperCllrd aeQ 

Choose New Animation to create a new animation in the current 
HyperCard stack. When the New Animation dialog appears, enter a 
name for the animation, then click OK. 

Open Animation ... 

Choose Open Animation to open an existing animation. When the 
Select an Animation dialog appears, select an animation, then click 
Open. From within this dialog you may also create a new animation, 
or duplicate or remove an existing one. 

Close Animation 

Choose Close Animation to close the current animation. 

Save Animation 

Choose Save Animation to save changes to the current animation. It 
is good practice to save your animations frequently so you don't lose 
any changes. Animations are saved automatically when they are 
closed. 
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Save a Copy ... 
Choose Save a Copy to save a copy of the current HyperCard stack, 
plus any animations contained within that stack. 

Import 

Choose Import and use any of the seven available hierarchical menu 
items to import objects into the current animation from stacks that 
contain animations or from Macintosh standard file types. 

Impoll • 

Actor, Prop, Sound, Path 

IIctor .. . 
Prop .. . 
Sound ... 
Pith ... 

Actor from PICS .. . 
Prop from PICT .. . 
Sound from SND .. . 

Choose the Actor, Prop, Sound or Path hierarchical menu item to 
import one of these objects from another ADDmotion II animation. 

Actor from Pies ••• 
Choose the Actor from PICS hierarchical menu item to import and 
create an Actor from a PICS file. 

Prop from PICT ... 
Choose the Prop from PICf hierarchical menu item to import and 
create a Prop from a PICf file. 

Sound from SND ... 
Choose the Sound from SND hierarchical menu item to import and 
create a Sound from a SND file. 

Export 
Choose Export and use any of the 12 available hierarchical menu items 
to export the current animation or objects to other file formats. 
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[npor I.. • 

New Stock ... 

New Stllck ..• 

SllIck Script... 
Bllckground Scrip!. .• 
Cord Script ... 

Relor lIS PICS ... 
Prop lIS PICT ..• 
Sound liS SND •.. 

PICS ... 
Maule ... 
SllInd Rlone Pillyer .. . 
Arter Dark Module .. . 

PROmo lion file ... 

Choose the New Stack hierarchical menu item to create a new stack 
and pre-script the current animation into that stack. You are asked to 
name the new stack. 

Stack Script ... 

Choose the Stack Script hierarchical menu item to pre-script the 
current animation into a stack script. You are asked for the stack to 
export to and the name of the handler to be created. The animation 
will play when this handler is called. 

Background Script... 

Choose the Background Script hierarchical menu item to pre-script 
the current animation into a background script. You are asked for the 
stack to export to and the name of the handler to be created. When 
this handler is called, the animation plays. You can scroll through the 
backgrounds in the stack to be exported to be positioning the cursor 
near the left or right sides of the card. Positioning the mouse near the 
left side will display the previous background, while positioning the 
mouse at the right side of the card will display the next background. 

Card Script... 

Choose the Card Script hierarchical menu item to pre-script the 
current animation into a card script. You are prompted for the stack 
to export to and the name of the handler to be created. When this 
handler is called the animation will play. You can scroll through the 
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cards in the stack to be exported to by positioning the cursor near the 
left or right sides of the card. Positioning the mouse near the left side 
will display the previous card, while positioning the mouse at the 
right side of the card will display the next card. 

Actor as Pies ... 
Choose the Actor as PIes hierarchical menu item to export an Actor 
as a PICS file. 

Prop as Pier... 
Choose the Prop as PICf hierarchical menu item to export a Prop as 
a PICT file. 

Sound as SND ... 

Choose the Sound as SND hierarchical menu item to export a Sound 
as a SND file. 

Pies ... 
Choose the PIes hierarchical menu item to create a PIes file from 
the current animation. 

Movie ... 
Choose the Movie hierarchical menu item to create a QuickTirneTN 

Movie from the current ADDmotion II animation. For more informa­
tion, see Chapter 10: Tips and Tochn;ques. 

Stand Alone Player ... 

Choose the Stand Alone Player hierarchical menu item to create a stand 
alone file from the current ADDmotion II animation. Select a destination 
for the file, type in a name for the Stand Alone Player, then click Save. 
The name defaults to the current animation name with a .MW exten­
sion. 

When running the Stand Alone Player in color, you need 3,(xx)K of 
memory. When running in black and white, l,500K should be sufficient. 
To reduce the memory required, click the Stand Alone Player's icon, 
choose Get Info from the File menu and change the memory figure. 

After Dark Module ... 

Choose the After Dark Module hierarchical menu item to create an 
After Dark module from the ADDmotion II animation. When the dialog 
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appears, select the folder that holds your After Dark modules (inside 
the System folder) as the destination. Type in a name for the module, 
then click Save. A constantly looping module is created. Its name 
appears in the After Dark list of possible modules to choose from. 

PROmotion file ... 

Choose the PROmotion file hierarchical menu item to create a 
PROmotion file from an animation in the current ADDmotion II stack. 
When the dialog appears, select the animation, then click Save. 

Link ... 

Lmk... • New Button 

SIlicic Script... 
Bllckground Script... 
[lIrd Script. .. 

Choose Link to link the current animation to the currently open stack as 
a pre-scripted Button, Stack script, Background script or Card script. 
Use any of the four hierarchical menu items to link the current anima­
tion. 

New BuHon 

Choose the New Button hierarchical menu item to pre-script the current 
animation to play from a HyperCard button that is added to the current 
card. You can place this button by dragging it to where you want it then 
clicking the mouse button. Clicking the button will play the animation. 

Button Script example: 

on mouseUp 

AMLoad "Birds Flying" 

put the result into Animation 

AMPlay Animation 

AMRelease Animation 

end mouseUp 

(Refer to Runtime Animation in Chapter 10 to learn more scripting 
with ADDmotion II.) 
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Stack Script ... 

Choose the Stack Script hierarchical menu item to pre-script the 
current animation to play when the stack is opened. 

Stack Script example: 

on OpenStack 

Global Animation 

AMLoad "Bird" 

put the result into Animation 

AMPlay Animation 

end OpenStack 

on CloseStack 

Global Animation 

AMRelease Animation 

put empty into Animation 

end CloseStack 

In this example, the stack script is executed on OpenStack. First a 
global variable named Animation is declared. The animation 
named "Bird" is then loaded into memory (AMLoad "Bird"). The 
result contains a reference to the animation which is put into Anima­
tion. The AMP lay Animation command plays the "Bird" 
animation. Finally, the animation is released from memory when the 
stack is closed (AMRelease Animation). It is a good idea to set the 
reference to the animation (Animation) to empty when the anima­
tion is released. 

Background Script ... 
Choose the Background Script hierarchical menu item to pre-script 
the current animation to play when the current background card is 
opened. 
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Background Script example: 

on OpenBackground 

Global Animation 

AMLoad "Bird" 

put the result into Animation 

AMPlay Animation 

end OpenBackground 

on CloseBackground 

Global Animation 

AMRelease Animation 

put empty into Animation 

end CloseBackground 

lbis script works similarly to the example shown for linking a Stack 
Script. 

Cord Script. •. 

Choose the Card Script hierarchical menu item to pre-script the 
current animation to play when the current card is opened. 

Card Script example: 
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on OpenCard 

Global Animation 

AMLoad "Bird" 

put the result into Animation 

AMPlay Animation 

end OpenCard 

on CloseCard 

Global Animation 

AMRelease Animation 

put empty into Animation 

end CloseCard 



This script works similarly to the example shown for linking a Stack 
Script. 

Page Setup ... 
Page Setup lets you set certain specifications for printing. You can set 
the paper size, orientation of the printout and various other effects for 
printing. 

LlllrWrlllr Plge Selup 7.0 

PIper. @ US Letter 0114 Litter 
o USLeg11 015 Leller 0 I 'lblDld ... 1 
lIeduce Dr ." (nllrge: 

Orllntillon 

II~ 

Prlnler Ufecll: 
181 Flnl Subllllullon? 
181 '1.1 Smoolhlng? 
1815repllics SmDolhing? 
181 Filler Iltmlp Prlnllng? 

The following dialog is displayed when you click the Options button 
in Page Setup. 

~LI~le~~~rI~I~lr~O~PI~lo~nl~ ______________ ~7~.D __ ~ [8 o Flip Horlzonlll ~ Clncel o Flip Ulrtlell 
~ 0 Inuert Imlge 

o Precision Iltmlp Illgnmenl14\ reduction) 
o Llrger Prlnl lrellFllI/lr DOII/nioldlilie Fonls) 
o Unlimited DOII/nioldibie Fonllin I Documlnl 

Print Card 
Choose Print Card to print the current card using the specifications 
you gave in Page Setup. 

Print Animation ... 
Choose Print Animation to print items in the current animation. 
When the Print Animation dialog appears, check any or all of the 
items that you want printed, then click OK to print out summaries. 
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Quit HyperCard 

'rlllt 1"lmltlo" ... 

o 'rI"t n.1 U,," 
o 'rlnt IItllr Summlrll 
o .rlnl 'np SUmml,!! 
o PrIIIt Sound summlry 
o 'rlllt .. III SUmmlry 
o 'rlllt CUI Sum .. I'!! 

O'rI"t [ulnt Su .. mlry 

Choosing Quit from the file menu closes ADDmotion II and Hyper­
Card. Any changes you have made to the current animation are 
saved automatically. 

Edit Menu 

Cut XN 
Copy X[ 
Peste xu 
[leer X8 

New Card 
Delete [erd 

Select fUi XR 
Ouplicete .0 

In.ert [el .... 
Remoue [el 
Rellerse [el. 

The Edit menu lets you make changes to your work. Most items 
listed work with Paint whi1e only a few are avai1able in the Media 
Controller. 
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Undo 
Choosing Undo undoes your last operation. 

Cut 
Choose Cut to remove the selection to the Clipboard. Use Cut when 
you want to move a selection from one place to another. 

Copy 
Choose Copy to copy the active selection to the Clipboard. Use Copy 
when you want to copy a selection to place it somewhere else. 

Paste 
Choose Paste to paste the contents of the Clipboard. 

Clear 
Choose Clear to remove the active selection without putting it on the 
Clipboard or affecting what is already on the Clipboard. Pressing 
Delete has the same effect. 

New Cord 

Choose New Card to add a new card to the current stack. 

(Refer to your HyperCard manual for more information.) 

Delete Cord 
Choose Delete Card to delete the current HyperCard card. 

(Refer to your HyperCard manual for more information.) 

Select All 
Choose Select All to select all visible artwork in the currently active 
Paint window. In the Media Controller, all visible objects on the 
current frame will be selected. Once selected, you can move the 
objects around, delete or duplicate. 

Duplicate 
Choose Duplicate to duplicate a selected area of artwork in the 
currently active Paint window or to duplicate a selected object in the 
Media Controller. 

NOTE: The following Edit menu items do not affect items in the Media 
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Controller: Undo, Cut, Copy, Paste and Clear. Choosing Duplicate dupli­
cates the selected objecl(s). Undo, Cut, Copy, Paste and Clear do not affect 
the items in the TimeLines window. 

Insert eels ... 
Choose Insert Cels to insert one or more cels into an Actor. Type in a 
number, then click OK. The insert cel dialog defaults to 1. 

Insert [els ... 

Number of [els to Insert:lllli 

D Dupllnte (el [ontenl$ 

[ [en tel 1 ( OK I 

When cels are inserted into an Actor the document window appears 
blank and the cel count changes to reflect the number of cels added 
to the Actor. As a short-cut for inserting cels, double-click the cel 
counter (eg. 1 of 4) of the Paint palette. The Insert Cels dialog ap­
pears. Insert the desired number of cels. If you want the new cels to 
have the same artwork as the current cel, click the Duplicate Cel 
Contents checkbox, then click OK. The Actor's cycle speed depends on 
the number of cels and the image size in each eel. 

NOTE: The more eels you insert into an Actor the slower it will animate. 
For best performance keep the number of eels under 10 unless you have 
large amounts of memory available. 

Remove eel 

Choose Remove Cel to remove the current eel from an Actor. 

NOTE: Once a eel is removed it cannot be recovered. 

Reverse eels 

Choose Reverse Cels to reverse the order of an Actor's cels. 
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Go Menu 

Objects 
First X. 
PreD X2 
HeNt X3 
Last X4 

Find... XF 
Me 

Commands in the Go menu allow you to navigate through cards in the 
current HyperCard stack. You can browse through the stack using the 
First, Previous, Next, or Last menu ronunands. You can use these 
commands to view and test your animated sequences on different 
cards. 

First 
Choose First to go to the first card in the current stack. If you are 
already on the first card, choosing First does nothing. 

Previous 
Choose Previous to go to the previous card in the current stack. If 
you are at the first card in the stack, choosing Previous takes you to 
the last card. 

Next 
Choose Next to go to the next carde in the current stack. If you are at 
the last card in the stack, choosing Next takes you to the first card. 

Last 
Choose Last to go to the last card in the current stack. If you are 
already on the last card, choosing Last does nothing. 

Find ... 
Choose Find to search for text in fields of the current stack. The 
HyperCard Message box with the find command pre-scripted in it 
appears. 

<_* __ 1 
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(Refer to your HyperCard manual for more information on Find.) 

Message 
Choose Message to send a message to HyperCard. The HyperCard 
Message box appears. 

(Refer to your HyperCard manual for more information on Mes­
sages.) 

Objects Menu 

"1~Media 

Get Info... XI 

Cord Info .. . 
Bkgnd Info .. . 
Stack Info .. . 

- ...... --. 
Bring Closer X. 
Send Farther X-

- .......... - .. 

Place Actor .. . 
Place Prop .. . 
Add Sound .. . 
Add Cue ... 
Add [lJent... 

New Aclor\Prop .. . 
Open Actor\Prop .. . 

Use the Objects menu to get information, relayer, place, add or edit 
objects - Actors, Props, Sounds, Cues and Events. 

Get Info ... 

Choose Get Info to bring up information on the currently selected 
object. You are presented with either the Actor Infonnation, Prop 
Infonnation, or Paint Document Information dialog, depending on 
whether you are using the Media Controller or Paint editor. For 
more information on these dialogs refer to the Actor Information, 
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Prop Information, or Paint Document Information sections of this 
chapter. 

Card Info ... 

Choose Card Info to bring up information about the current Hyper­
Card card. You can see and change the card's name, find out the 
number of cards, card fields and card buttons in the stack. 

(Refer to your HyperCard manual for more information on Card 
Info.) 

Bkgnd Info ... 

Choose Bkgrnd Info to bring up information about the current 
HyperCard background. You can see and change the background's 
name, find out the number of cards that share the background, and 
find out how many fields and buttons this background has. 

(Refer to your HyperCard manual for more information on Bkgnd 
Info.) 

Stack Info ... 

Choose Stack Info to bring up information about the selected stack. 
You can see and change the stack's name, learn the number of cards 
in the stack and amount of disk space the stack uses, and read the 
name of the folder and disk the stack resides on. The card size can 
also be changed to a different size using the Re-size button. 

(Refer to your HyperCard manual for more information on Stack 
Info and resizing the stack card,) 

Bring Closer 
To bring an Actor or Prop one layer closer, first select it, then choose 
Bring Closer from the Objects menu. 

NOTE: Actors reside in their own layer sqxuate from Props and are alUXlYS 
placed in front of Props. You can use the four object layering tools in the Media 
Controller palette to move objects within their own layers. 

Send Farther 
To send an Actor or Prop one layer, first select it, then choose Send 
Farther from the Objects menu. 



NOTE: Actors reside in their own layer separate from Props and are always 
placed in front of Props. You am use the four object layering tools in the Media 
Controller palette to move objects within their own layers. 

Place Actor ... 
Choose Place Actor to place an Actor on the current frame of an 
animation. This brings up the Select an Actor dialog. Select the Actor 
you want, then click Place. (Refer to the section on the Select an 
Actor dialog in this chapter for information on the other buttons 
available.) 

Select lin Rctor ... 

note Ib&w) 

pillno teyslbltw) 

181 Preulew None 

,---- -----1 

:.:::..) I " ~ I 
(Renllme) I \Y~ I 

IQ 

Iri 
!,:,:.r L _____ J 
I Pillee I Ao ... IS ... :IO....,n 

_.ft. .. :8 
) • ( Cllneel ) Sin: 2K 

The Actor is placed at the center of the screen, with a marquee 
border around it. The Actor can be moved to any area of the screen. 

r"'~ 
dJ 

Once you place an Actor, you can change its Actor Information by 
either double-clicking it with the Object Selection tool (Pointer) or by 
selecting it and choosing Get Info from the Media menu. The Actor 
Information dialog appears. 

NOTE: Please refer to the section in this chapter that discusses Actor 
Information and changing placed Actors. 
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Place Prop ... 
Choose Place Prop to place a Prop on the current frame of an anima­
tion. This brings up the Select a Prop dialog. Select a Prop, then dick 
Place. (Refer to the section on the Select a Prop dialog in this chapter 
for information on the other buttons available.) The Prop is placed at 
the center of the screen with a marquee border around it. Once you 
place a Prop, you can change its Prop information by either double­
clicking on it with the Object Selection tool or by selecting it and 
choosing Get Info from the Media menu. The Prop Information 
dialog appears, allowing you to set information for the Prop. 

NOTE: Please refer to the Prop Information section of this cluzpter for more 
information on adjusting placed Props. 

Add Sound ... 

Choose Add Sound to bring up the Select a Sound dialog. From here 
you may select or create a Sound to add. After the sound is added, the 
Sound Information dialog is displayed, allowing you to adjust the 
Sound. Sounds added to an animation appear in the TImeLines win­
dow. 

NOTE: Refer to the sections on the Select a Sound and Sound Information 
dialogs later in this chapter for more information. 

Add Cue ... 

Choose Add Cue to control the playback of the animation. You can 
use cues to add interactivity and to control other devices or pro­
grams. The cue mechanism establishes a condition that must be met, 
then sets an action to take place when this condition is met. To help 
you to create cues, ADDmotion II presents you with pop-up menus 
listing all possible cue choices. 

To add a cue to your animation: 

1. Choose Add Cue from the Objects menu. 

The Cue Information dialog appears. 
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000 lIe'or-. frame I. drown 

I .Iway. ....1 [
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-comml~on~d~=======~ I TIIen: I Conllnue ... 1 

l __ _ 

2. Enter a name for the cue in the Name field. 

3. Enter numbers in the Start Frame and End Frame fields to 
indicate the period in which the cue is active. 

4. Click the Do Before Frame is Drawn box if you want the cue 
activated before the frame is drawn on the saeen. 

S. From the Condition pop-up, choose Always, Wait For, or If . 
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This sets a condition for the cue. 

If you choose Always, then no condition need be met and no 
further information is requested. The cue will always be executed. 

If you choose Wait For, the animation will stop until the cue 
executes. You are requested to specify one of four other 
conditions: Time, Mouse Oick On, Key Down and Sound Done. 
These choices allow you to set the type of event to wait for before 
executing the command set in the cue. The Time setting gives you 
a place to enter a value for how much time (in 60ths of a second) 
to wait for. The Mouse Oick On setting allows you to use two 
other pop-ups to set what the user has to click the mouse on. It 
could be an Actor or a Prop or simply a mouse click anywhere. If 
you set these pop-ups for an Actor or Prop, then two checkboxes 
will appear, allowing you to further define how these mouse 
clicks will be handled. If you click the Act Like Button checkbox, 
the Actor or Prop will work like a dialog button. If you click the 
Use Bounding Box checkbox, the mouse click can take place 



within an invisible rectangle enclosing the Actor or Prop. The 
Key Down setting allows you to enter a character that the user 
has to type. You can simply type the character on the keyboard 
or enter the ASCII code for untypeable characters with ASCII 
codes less than 32 (such as the Return key, ASCII 13). The Sound 
Done setting allows you to select a Sound from the pop-up menu 
that will be checked to see if it is still playing. 

If you choose If, the cue will be executed only if the condition 
that you set is met. You can choose from the same conditions as 
Wait For. 

These are the possible choices for setting a condition: 

Aw.Iys 
WuFor nme Nutrber II 6O!hs all8COIId 
Wait For Mouse Click On AnyIhing 
Wait For Mouse ClIck On AaDlNamed AaDI 
Wait For Mouse Click On Prop Named Prop 
Wait For ScUldDane Somd 
Wait For KeyOown CIlaracl8r/ASCIl Code 

nnl1l8 Nurrber i1601hs aI seoJnd 

n Mouse Click On Anyt/lilg 
n Mouse Click On AaDlNamed AaDI 
n Mouse ClIck On Prop Named Prop 

n KeyOown Characlar/ASCIl Code 

n ScIII'Id Done ScUId 

6. From the Command pop-up, choose Continue, Goto Frame, 
Send HC Message, Send Frontier Message, Send Control 
Tower Message, Pause Until, End Animation, Change Frame 
Rate or Play Movie. 

The command you choose results in a specific action whenever 
the condition above occurs. 

If you choose Continue, the animation continues to animate. 

If you choose Goto Frame, you are asked to enter a frame number 
from which the animation will continue. You can usc this to 
cause loops in an animation. 

If you choose Send He Message, you are asked to enter a 
message that will be sent to HyperCard. 

NOTE: For more information on messages, see your HyperTalk 
manUili. 

If you choose Send Frontier Message, you are asked to enler an 
Apple Event message that will be sent to Frontier. 
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NOTE: Apple Events can be sent using ADDmotion II, but not 
received. 

If you choose Send Control Tower Message, you are asked to 
enter an Apple Event message that will be sent to Control Tower. 

NOTE: Apple Events can be sent using ADDmotion II, but not 
received. 

If you choose Pause Until, the animation will pause until the 
condition statement becomes true again. For example, you could 
have a Prop that says ''Press me to Pause," then set the condition 
to If Mouse Click On Prop Name Then Pause Until ... and 
whenever the Prop is clicked the animation will pause until the 
Prop is clicked on again. 

If you choose End Animation, the animation will stop. 

If you choose Change Frame Rate, you are asked to enter a new 
frame rate for the animation. This allows you to make different 
parts of your animation play at different speeds. 

If you choose Play Movie, you are asked to select a QuickTime 
movie file to play. If this command is executed in response to a 
Mouse Click on an Actor or Prop condition, the movie will play 
centered on that Actor or Prop. Otherwise it will play centered in 
the animation window. 

NOTE: You must have QuickTime installed for movies to play. Contact 
your Apple dealer for more information on QuickTime. 

7. Click OK. 

In the following example, the note 2 Actor will act like a button and 
the animation will go to frame 1 each time it is clicked. 

NOTE: See Chapter 10: Tips and Techniques for further emmples of 
cues. 
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This cue makes the note 2 Actor act like a Rewind button: 

Cue I nfo,..allon •.. 

Hllme: INolllullon 

o Do before frlme Is drawn 
181 Rcllike Bullon 0 Use Bounding bOM 

~[ondililln 

I I I' .... 11 Mouse Click On .... 1 

i I Rctor Named .... 1 I nole 2 .... 1 
J 

Slart frame: D 
[ndfrlml: ~ 

I 
: 
! 

r[omml~an~d~;=======::::::;r:===l--11 rc.ruil ! Then: I 6010 frame .... '1 ~ 

~I ___________________ ~I I OK g 

NOTE: Cues are exported to the stand-alone player only; they are not 
executed or exported to PICS files, QuickTime movies or After Dark 
modules. 

Add Event... 
Choose Add Event to add Load and Stamp Events to your anima­
tion. For information on Events, see Chapter 10: Tips and Techniques. 

New Actor/Prop ... 

Choose New Actor/Prop to create a new Actor or Prop. The default 
state is set to create an Actor, however, you can create a new Prop by 
clicking the Prop radio button. Type a name for the new Actor or 
Prop, then click OK. The following are examples of the New Actor 
and Prop dialogs. 

New Rctor •.• 

®Rctor 
o Prop [?ii«iJ I 01( I 

New Prop._ 

[CUUiJ1 01: I 

When you create an Actor, a new document window appears. Actors 
may consist of more than one eel, therefore the Paint palette for an 
Actor has a eel counter and cycle arrows which allow you to advance 
or go back through the eels for viewing and editing purposes. 
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When you create a Prop, a new document window appears. Props 
consist of only one cel, therefore the Paint palette does not include a 
cel counter or the cycle arrows. 

(Refer to Chapter 6: Creating Actors, Props and Sound Effects for more 
details.) 

Open Actor/Prop ... 
Choose Open Actor/Prop from the Object menu to open an existing 
Actor or Prop for editing. The default state is set to select an Actor, 
however, you can open a Prop by clicking the Prop radio button. 

Select an Actor or Prop, then click Open. Click the Preview 
checkbox, if it is not already checked, to show a picture preview of 
the selected Actor or Prop. Actors cycle in the preview window if 
they contain more than one cel. 

The following are examples of the Select an Actor/Prop to Edit 
dialogs: 

Selecl en IIclor 10 (dll ... 

Illip Ildjwl 

nole edlled Ibl'w) <!lllclor 
pleno teys (betw) ornp 

~ 

~I 'pen J $"':31( ~":I 

181 Pre.,lew I Concol I 
...... IS ... :I05~70 
......... fc.ll::. 

Selod 0 Prop 10 UII ••• 

lO\trUlllLlo ILl/wi ~ 
mondol~l'w) Ollclor 
qull Ibl'.,) @)Prop 

INSTRUCTIO~ so ••• (DlI'w) 
serulce (bltw) 

~I .pen I s".:(J( ~":I 

181 Pre.,lew ( Concel I '-bMII .. : ,,. ... It 
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Media Menu 

Xy 
31M 

Show TimeLines XT 

Show Frame Number ... XG 

Rnimation 

The Media menu items allow you to show or hide ADDmotion IJ's 
windows and palettes, and to execute various commands and 
functions that are specific to these windows and palettes. 

Hide All 
Choose Hide All to hide all visible windows and palettes. The Hide 
All menu item changes to Show All. Choosing Show All brings all 
hidden windows and palettes back into view. 

Show Paint Tools 
Choose Show Paint Tools to display the Paint palette. The item 
remains dimmed until you choose to edit or open an Actor or Prop. 

(Refer to Chapter 4: Paint Tools for more information). 

Show Media Controller 
Choose Show Media Controller to display the Media Controller. The 
Media Controller appears in the last screen position that it appeared 
before it was hidden. 

(Refer to the Media Controller section in Chapter 7: Creating an Anima­
tion for more infonnation). 

Show TimeLines 
Choose Show TimeLines to display the TimeLines window. The 
TimeLines window provides for a dynamic view of all the objects 
within the animation. An object's information can be accessed and 
manipulated from within the TimeLines window. 
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tl~.~11111 .... 5.0 ... 100 :1 
rill ~:,~ •••• ( ...... ",) 1 {)-

: :':::~ I TI 
rill "'_do (~&",) I ;ii' 
131 ~ ..... ( ...... "')0 
~ ~s .... y .. (~y) :n 

SI.d End IQ1 J2l£; 

Show Frame Number ... 

Choose Show Frame Number to go to or show a specific frame 
number and display the contents of that frame. 

NOTE: For a short cut to the menu item, double-click the Media Controller 
Frame Counter to display the Move To Frame dialog. 

Moue to Frame ... 

Show Frame Number l.iItIIIIl 

( (encel 1 t OK ] 

Animation Options ... 

Choose Animation Options to set options for the animation such as its 
length, playing speed, mouse or keyboard control and how the anima­
tion should end (or replay) etc. For more infonnation, see Animation 
Options Dialog later in this chapter. 

Paint Menu 
Refer to Chapter 4: Paint Tools for information on Paint functions. 

Options Menu 

Refer to Chapter 5: Paint Options for information on the Options 
menu. 
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Dialogs 

Select an Actor Dialog 
The Select an Actor dialog allows you to not only select an Actor, but 
also to perfonn many operations on the Actors located in the Actor 
Library. To display the dialog, choose Plaee Actor from the Objects 
menu or click the Place Actor icon in the Media Controller. 

Preview 

Sellet II letor _. 

lIuh- Ibliwl rn 
notl .dlt.d (blhu' 
pllno keys (bit.,' 

[ 1011111_. ) 

[IUPI"t.) 
[ "Ineml) 

[ ...... u.) 

~ 
L-_____ = I PII" I 
181 Preulelll ~ [c •• eel) 

...... Is..:.~"' 
_.IC:.~ .• 
" .. ,a 

To display an image of the selected Actor, click the Preview 
checkbox. Once selected, the Actor will cycle in the Preview window 
if it contains more than one eel. 

Actor Details 
Infonnation pertaining to the selected Actor appears directly below 
the picture preview to give you an idea of the contents of the selected 
Actor before you place it. 

New ... 
To create a new Actor from within the Select an Actor dialog, click 
New. The New Actor dialog appears. Type in a name for the Actor, 
then click OK. 

Neme: 
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Duplicate 
To duplicate an Actor, select the Actor from the list, then click 
Duplicate. The Duplicate Actor dialog appears. Type in a name for 
the duplicate, then click OK. 

Oupllule Rttor ... 

Name: I I. iinmtj'1f1!1) 

[ Cantel ) I OK I 

Rename 
To rename an Actor, select the Actor from the list, then click Rename. 
Type in a new name, then click OK. 

Remove 
To remove an Actor, select the Actor from the list, then click Remove. 
The following dialog appears. Once an Actor has been removed,it 
cannot be recovered. 

Import", 

Are you sure you went to remoue the 
ector celled 'note (b&wl'? 

[ Cencel ) t OK I 

To import an Actor from another stack, click Import. The following 
dialog appears. 

1 ~ HyperCard .... 1 

D [Hample Stalk m 
[) Stltk 1 
[) Stltk 2 

[ 

~ ____________ ~O K 

=Hllrd Disk 

Desktop 

Cancel 1 

Open J 

Select a stack from the list, then click Open. The Select an Actor to 
Import dialog appears. 
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Select In .ctor to Import ... 

IOltlltG ull 

note e.lted (bltwl 
pllno keys (bltwl 

L.-_____ --'-'" (Impart I 
I8IPreulew ( Clncel I 

",,",I Sa •.• ", 46 
_"'Colo:, 
' .. :21( 

Select an Actor from the list, then click Import. (If the stack contains 
no Actors, this dialog will be blank.) IT you want to import more than 
one Actor from the same stack, hold down the Option key when you 
click the Import button. 

Place 

To place an Actor in the animation, select the Actor from the list, 
then click Place. The Actor appears in the center of the animation. 

None 

Click None to place an undefined Actor in the animation. This 
undefined Actor appears on the screen as an Actor icon, which you 
can later replace with a new or imported Actor. 

Select a Prop Dialog 
The Select a Prop dialog lets you not only select a Prop but also perform 
many operations on the Props located in the Prop Library. To display 
the dialog, choose Place Prop from the Objects menu or click the Place 
Prop icon in the Media Controller. 

Select I Prup ... 

moodo (bltwl 
~ 
(Duplicate) 

( Rlname) 

( Remoue I 
~ 

r-------, 

INSTRUCTIO 

"-_____ = I Piece I 
181 Preview ~~ 
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Preview 
To display an image of the selected Prop, click the Preview checkbox. 

Prop Details 
Information pertaining to the selected Prop appears directly below 
the Prop preview to give you an idea of the contents of the selected 
Prop before you place it. 

New ... 
To create a new Prop from within the Select a Prop dialog, click 
New. The New Prop dialog appears. Type in a name for the Prop, 
then click OK. 

New Prop ••• 

Heme: lI"'m!iiiniiil~~!~!!~ 
[ Cencel I I OK I 

Duplicate 
To duplicate a Prop, select the Prop from the list, then click Duplicate. 
The Duplicate Prop dialog appears. Type in a name for the duplicate, 
then click OK. 

Dupllce'e Prop ••• 

Neme: 

[ Cencel ) I OK I 

Rename 
To rename a Prop, select the Prop from the list, then click Rename. 
Type in a new name, then click OK. 

Remove 
To remove a Prop, select the Prop from the list, then click Remove. 
The following dialog appears. Once a Prop is removed, it cannot be 
recovered. 
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Import", 

o Ire you lure you wI.1 10 remolle Ihe 
prop cilled 'Inltructlon (blt..,l'? 

To import a Prop from another stack, click Import. The following 
dialog appears. 

10 HyperCard ... 1 

J EHample Stillk m 
D StlCIe 1 
D StlCIe 2 

=H.rd Disk 

I [jpcf 

[ Desletop 

Cencel 

I Open I 

Select a stack from the list, then click Open. The Select a Prop to 
Import dialog appears. 

Select a Prop to Import ... 

~ -~ ..... 
Instruction (b&wl ~ , , , 
quit (b&wl c .... 

!"'I~ 
Illel (b&wl .. 
serulce (b&wl 

.~ .' ':;-:-m 

,- . J 

t;; (Import I ..... "". In.., J34 

181 Preulew I Clnctl 1 
s... JI( 

Select a Prop from the list, then click Import. (If the stack contains no 
Props, this dialog will be blank.) If you want to import more than 
one Prop from the same stack, hold down the Option key when you 
click the Import button. 

Place 
To place a Prop in the animation, select a Prop from the list and click 
Place. 



None 
Click None to place an undefined Prop in the animation. This unde­
fined Prop appears on the screen as a Prop icon, which you can later 
replace with a new or imported Prop. 

Select a Sound Dialog 
The Select a Sound dialog lets you not only select a Sound, but also 
perform many operations on the Sounds in the Sound Library. To 
display the dialog, choose Add Sound from the Objects menu or click 
the Add Sound icon in the Media Controller. 

Preview 

Select e lound ... 

~I!II •••• ~ I Npw ... 

[Dupllcete] 

I Rlnlme ] 

[ lIemoue ) 

[Import ... ] 

:;; I IIdd I 
~I8I;:p:re:ul:elll::---;::;:No:::ne~] [ Ceneel ) 

... "" .... :7 ...... 
1.:2IK 
L..,...:I_ 

To display an image of the selected Sound's waveform and to hear 
the Sound, click the Preview checkbox. 

Sound Details 
Information pertaining to the currently selected Sound appears 
directly below the image of the Sound's waveform to give you an 
idea of what the Sound is like before you add it. 

New ... 

To create a new Sound from within the Select a Sound dialog, click 
New. For information on how to record a new Sound, see Chapter 6: 
Creating Actors, Props and Sound Effects. 

If the New button is dimmed, the Macintosh might not have an 
available recording device. 
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lJuplicare 

To duplicate a Sound, select the Sound from the list, then click 
Duplicate. Type in a name for the duplicate, then click OK. 

Rename 
To rename a Sound, select the Sound from the list, then dick Re­
name. Type in a new name, then dick OK. 

Remove 
To remove a Sound, select the Sound from the list, then click Remove. 
The following dialog appears. Once a Sound is removed, it cannot be 
recovered. 

Import ... 

'"' Ire you lure yoa IIIlnllo remo" til. 
y lound clUed 'mullc"? 

To import a Sound from another stack, click Import. The following 
dialog appears. 

10 HyperCeni ... 1 

D [Hample Stack :!: 
[) Stack I 
[) Stack 2 

=Hard Disk 

( [j'ct I 
I DesktoP) 

I Cancel) 

I Dpea I 

Select a stack from the list, then dick Open. The Select a Sound to 
Import dialog appears. 
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Select 8 Sound to Import. .. 

U\IC 

L--______ --'-= I Import J 
181 Preuiew [ cancel) 

Sarr.,I'"9 Rili. 7 kHz 

Siz. 150 I( 
If'l''l9th 20 sf'COOds 

Select a Sound from the list, then click Import. (If the stack contains 
no Sounds, this dialog will be blank.) If you want to import more 
than one Sound from the same stack, hold down the Option key 
when you click the Import button. 

Add 
To add a Sound to the animation, select the Sound from the list and 
click Add. The Sound Infonnation dialog appears. For details on 
how to define and modify Sounds, see Chapter 8: Editing Sounds. 

Animation Options Dialog 
To display the Animation Options dialog, choose Animation Options 
from the Media menu. 
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Animation Name 

The name of the animation is highlighted when the dialog first 
appears. You can change the name by typing in a new name. 

Contains 
This area lists the types and number of objects in the current anima­
tion. 

Frames 
This field indicates the number of frames in the animation. To 
change the number of frames, type in a new number. The length of 
an animation can be 1 to 5000 frames. 

Speed 
The animation playback speed is measured in frames per second. The 
available speeds range from .25 fps. to 60 fps. An additional value, 60+, 
tells the computer to play the animation at the maximum possible 
speed. The animation speed will vary from one Macintosh to another as 
it is dependant on the amount of available RAM, the processor, and the 
access time of the hard disk. 

To change the playback speed of an animation, choose a new value 
from the pop-up menu. 

FF /REW Speed 
If you are working on a particularly long animation, it would be time 
consuming to play it through frame by frame to see the overall 
results. You can set the skip of the Fast Forward or Rewind mode by 
putting a skip value into this box. For example, if you set the skip 
value to 6, the animation will play the 1st, 7th, 13th, 20th frames etc., 
when the Fast Forward button is pressed. To set the skip speed, click 
the Up arrow or Down arrow until the desired number appears in 
the skip counter. You can enter a skip number between 2 and SO. The 
default number is 5. 

Grid Size 
Use the Grid Size pop-up menu to set an invisible grid to add points 
on a path in a unified manner or move Actors and Props on the 
screen. If you choose 5 from the pop-up menu, the points will be 
placed to the nearest 5th pixel from the top left of the window. The 
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grid is invisible, with a range of every 5 pixels to every 200 pixels. If 
you want to tum off the grid, choose OFF from the pop-up menu. 

Background Color 
If you are working in black and white, click in the box to set the 
background at black or white. If you are working in color, click in the 
box to display the palette dialog and select a color. 

Checkbox Items 

The options listed on the right side of the dialog determine how the 
animation will appear when it is played. Select any items that are 
appropriate to the animation by checking the adjacent checkbox. 

Hide Palettes 

Click Hide Palettes to hide all palettes while the animation is play­
ing. 

NOTE: If you hide the palettes and the menu bar while the animation is set to 
auto replay, you can stop the animation by pressing Command - (.). If Mouse 
Button to Stop and Command Period (.) to Stop are unchecked, you can creJlte 
an endless looping animation. To stop this endless loop, hold the Shift-Com­
mand-Option keys down, then click the mouse button. 

Hide Menu Bar 
Click Hide Menu Bar to hide the menu bar while the animation is 
playing. Pressing Command - space bar hides and unhides the menu 
bar. 

Hide Cursor 
Click Hide Cursor to hide the cursor while the animation is playing. 
If you are running under MultiFinder, the cursor will appear when 
you switch to another application and disappear when you switch 
back to the animation. 

Auto Replay 

Click Auto Replay to make the animation repeat or loop. You can 
also set this option by clicking the Loop Animation button on the 
Media Controller. 

Mouse Button to Stop 

Click Mouse Button to Stop to make the animation stop when the 
mouse button is clicked. 
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Command-(.) to Stop 

Click Command-(.) to make the animation stop whenever Command 
- period (.) is pressed. 

Show Frame Count 

Click Show Frame Count to display the animation's current frame 
number in the frame counter box at the top left comer of the Media 
Controller. 

Show Frame Rate 

Click Show Frame Rate to display the actual playback speed in 
frames per second on the right side of the frame counter box of the 
Media Controller. 

Leave Last Frame 

Click Leave Last Frame to cause the last frame of the animation to 
remain on the screen when the animation ends. 

Preserve Image 

When checked, Preserve Image allows a newly loaded animation to 
be played over the screen image of the card graphic. This feature 
requires a specific amount of RAM to store the image of the card at 
the same time that it is processing data to run the animation. For 
example, on a Mac Plus in black and white, ADDmotion II will 
allocate 30K of RAM to store the card's image in memory. In 8 bit 
color ADDmotion II will use 300K and 24 bit color requires up to 
1 MB to store the card's image in memory. 

MultiFinder Animation 

Click MultiFinder Animation to allow the animation to animate in 
the background under MultiFinder. 

Allow Card Clicks 

Click Allow Card Clicks to make all items on the HyperCard card 
active. This allows for interaction with card buttons, fields, etc. 

Actor Information Dialog 
The Actor Information dialog lets you adjust an Actor once it has 
been placed. To display the dialog, double-dick a placed Actor while 
using the Object Selection tool or select a placed Actor, then choose 
Get Info from the Objects menu. 
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"ctor Name: 

Llbrllry Actor. B~noe _=--~: __ ~-:-:-:-~~-:=~_=-l 
Llbrllry Path: B~lIth I for nD!.!~~~-___ ~~_] 
Start Frame: 1- Start Position -- - I 

I horlz l!!::J I 
I uert f""\82I, 
l __________ ~ __ ! 

End Frame: 

Path Point Start: D of: 23 

Cel Mode: LI -=o~p.::.;aq::..::u:=B ____ .... __11 

o locted 
[ [dlt Actor ... ] [ Cancel ] I OK ) 

Actor Name 

The Actor Name defaults to its library name. To keep track of placed 
Actors, give each one a unique name every time it is used. This is a 
label name and does not change the Actor's original name within the 
Actor library. 

NOTE: Giving multiple instances of the same Actor different names makes 
it easy to distinguish between Actors in the TimeLines window. 

Library Actor 

Every Actor is given a unique name when it is created. This name will 
appear beside the Actor Selection icon. To select another Actor to play 
this part, click the Actor Selection icon, select the Actor from the list, 
then click Use. The previous Actor is then replaced in the animation. 
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Library Path 
Every Actor that is placed in an animation has a single-point path. 
You can create a path of action by selecting the Path tool and adding 
new points to the single-point path. When a Path is created, it is 
given a default name (e.g. Untitled 1). Each new untitled path will be 
numbered automatically. 

If the Actor has just been placed, the name of the Library Path will be 
blank. You can add a pre-defined path or change the Path that an 
Actor uses by clicking the Library Path icon. This allows you to select 
another Path (path of action) for the Actor to follow. Select a Path 
from the list and click Use. 

Slllct • '1111 ... 

I PlIII I fDr noll 

[OUlllltlle] 

~ [ .... ml] 

( .11lI0II1 ] 
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Start Frame 
The start frame defaults to the current frame number when the Actor 
was placed. The start frame number can be changed at any time as 
long as it is not larger than the end frame number. 

End Frame 
The end frame defaults to the last frame of the animation. The end 
frame number can be changed at anY,time as long as it is not larger 
than the last frame number of the animation. 

Path Point Start 
Every Actor that is placed in an animation has a single-point path. If 
the Actor has more than one point in its path, the first path point is 
also the starting point to animate from unless you change the 
number in this box. You can change the start point for the path to 
any number as long as it does not exceed the number of points in the 
path. For example, if there are 23 points in a path, you can start at 
any point from 1 to 23. 
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Start Position 

When an Actor is placed in an animation it is placed at a specific 
location on the screen. If you move the Actor, these numbers change 
to reflect the new horizontal and vertical position. You can change 
the location of the Actor by typing a number into the horiwntal and 
vertical fields. 

eel Mode 

When an Actor is first placed in an animation, its default cel mode is 
Opaque. You can use the pop-up menu to change the cel mode to 
Transparent, Sequence Opacity or Matte Effect. For information on 
Sequence Opacity, see the eel Sequencer section in Chapter 7: Creat­
ing an Animation. 

Matte Effect allows you to choose a Prop that the Actor will use to 
create the matte. The Actor will act like a cookie cutter, cutting a 
section out of the Prop and displaying that where the Actor would 
normally appear. Matte Effect is most effective if you disable the 
Prop that the Actor is passing over. You can disable a Prop by 
clicking its checkbox in the TimeLines window. 

locked 

Click the Locked checkbox if you want to lock the Actor in this 
position on the screen. You will not be able to move it with the 
Object Selection tool while this box is checked. 

Edit Actor 

Click Edit Actor to edit or modify the Actor using the Paint tools. 
The Paint palette and a Paint document window containing the 
currently active cel of the Actor appear. The Paint tools work in all 
bit depths-black and white or color. 

Prop Information Dialog 
The Prop Information dialog lets you adjust a Prop once it has been 
placed. To display the dialog, double-click a placed Prop while using 
the Object Selection tool or select a placed Prop, then choose Get Info 
from the Objects menu. 
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The Prop Name defaults to its library name. To keep track of placed 
Props, give each one a unique name every time it is used. This is a 
label name and it does not change the Prop's original name within 
the Prop library. 

NOTE: Giving multiple instances of the same Prop different names makes it 
easy to distinguish between Props in the TimeLines window. 

Library Prop 
Every Prop is given a unique name when it is created. This name will 
appear beside the Prop Selection icon. To select another Prop to play 
this part, click the Prop Selection icon, select the Prop from the list, 
then click Use. The previous Prop is then replaced in the animation. 

Start Frame 
The start frame defaults to the current frame number when the Prop 
was placed. The start frame number can be changed at any time as 
long as it is not larger than the end frame number. 

End Frame 
The end frame defaults to the last frame of the animation. The end 
frame number can be changed at any time as long as it is not larger 
than the last frame number of the animation. 

Position 
When a Prop is placed in an animation, it is placed at a specific 
location on the screen. If you move the Prop, these numbers change 
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to reflect the new horizontal and vertical positions. You can change 
the location of the Prop by typing a number into the horizontal and 
vertical fields. 

Drawing Mode 
When a Prop is first placed in an animation, its default Drawing 
Mode is Opaque. You can use the pop-up menu to change the mode 
to Transparent. 

NOTE: For more information, see Cel/Drawing Modes later in this 
chapter. 

Locked 
Click the Locked checkbox if you want to lock the Prop in this 
position on the screen. You will not be able to move it with the 
Object Selection tool while this box is checked. 

Transitions 
Click Transitions to change the way Props enter and exit animations. 
(A short-cut to display the Transition dialog is to hold down Com­
mand-Shift and double-click on one or more Props.) The following 
dialog appears. 

Transillons for Prop 'mondo lbO-wI' .•. 

-~~~1-1 
4!!1 zJ t! I ; •• i 

__ ~ __ ~_r __ . _____ ._ j 

® [nler Transillon 
o [HII Transillon 

Melhod 

I Slamp ..... 1 

Sleps: I 4 ..... 1 

Speed: &0- ..... 1 

[ Cancel ) I OK I 

The preview window shows you the frame that you are currently 
working on and the selected Prop within it. 

Enter/Exit Transition 

The Enter and Exit Transition radio buttons determine which transi­
tion you are editing. Enter Transitions are shown when the Prop first 
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appears and Exit Transitions are shown when the Prop leaves. You 
can set both enter and exit transitions. 

Method 

The Method POJrup menu selects the type of transition to be used 
for the transition. The following is a description of each. 

Stamp: This is the default setting. The Prop stamps on the screen 
with no transition. The Steps and Speed selectors are not active. 

Scroll: The Prop scrolls in from the direction that you specify. When 
choosing Scroll you can drag the entry box to anywhere within the 
preview window. Where you position the entry box is the Prop's 
transitional starting position. The Prop will then scroll to the position 
that you placed it on the screen. You can also control a Prop's transi­
tional starting size by clicking and dragging the lower right comer of 
the entry box. Changing the size of this box scales the Prop during its 
transition. 

Another method of setting the Prop's starting position and size is to 
double-dick it in the preview window. The Enter Rectangle Dimen­
sions dialogs appears, letting you enter this information. 

Enter Rectangle Dimensions ... 

horlz: 11" I width: ~ 
uert: ~ height: ~ 

[ Restore 1 [Cancelli OK I 

Dissolve: The Prop dissolves onto the screen. 

Zoom Rectangles: The Prop zooms open from the location that you 
specify. When choosing Zoom Rectangles you can drag the entry box 
to anywhere within the preview window. Where you position the 
entry box is the first Prop's transitional starling position. The Prop 
will then zoom from this position to where you placed it on the 
screen. 
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Entry box -C~-[lJ-i --~!--+ Preview window 

! 
I 

'--------------~, 

Angular Wipe Top Left: The Prop will wipe down from the top left 
corner. 

Angular Wipe Bottom Right: The Prop will wipe up from the 
bottom right corner. 

Angular Wipe Top Right: The Prop will wipe down from the top 
right corner. 

Angular Wipe Bottom Left: The Prop will wipe up from the bottom 
left corner. 

Checker Board: The Prop will appear or disappear in a checker 
board pattern. 

Iris: The Prop will appear in the center of the screen as an expanding 
circle, or disappear as a shrinking circle. 

Circle Wipe: The Prop will wipe on to or off the screen like a second 
hand on a watch. 

Rectangular Wipe: The Prop will wipe on to or off the screen from 
the direction you set using the entry box. Interesting effects can be 
created by setting the entry box to a point or line. 

Fade: The Prop will fade on or off the screen. 

Pixelize: The Prop will appear with large pixels that become regular 
pixels or disappear by fonning into increasingly large pixels. 

Steps 
The Steps pop-up menu controls the speed of the transition. The 
greater number of steps, the more fluid the transition will be. 

Speed 

The speed sclector controls the speed of the transition. The higher 
the number, the faster the steps of the transition will be played. 
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Edit Prop 
Click in the Prop Infonnation dialog to edit or modify the currently 
selected Prop using the Paint tools. The Paint Palette and a Paint 
document window containing the Prop appear. The Paint tools work 
in all bit depths-black and white or color. 

Paint Document Information Dialog 
To display the Paint Document Information dialog, select the Paint 
document window of interest, then choose Get Info from the Objects 
menu. The following dialog appears. 

Inf. fIr Itlu 'Cln .. ' ... 

tel Slze:1 WlndolU .... 1 

[Regillrellon: J 
N: a 
U: a 

The cel size may be changed by using the eel Size pop-up menu or 
by re-sizing the eel size box. If it is an Actor document, you wiIl be 
able to set the registration point for the Actor by dragging the 
registration lines. 

eel/Drawing Modes 
Opaque 
Opaque is the default drawing mode for all Act~rs and .Prop~. White 
areas completely outlined with anothe~ colo~ w~ll. remain whIte, 
White areas not completely outlined wdl be inVISIble. 
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Transparent 
All white areas become transparent, allowing objects behind to show 
through. 

The level of transparency can be set on Props. In color mode, setting 
the level of transparency blends the Prop's colors (including com­
pletely outlined areas of white) with the colors of any objects behind 
it. Fully opaque is 100% and fully transparent is 0%. Setting the level 
of transparency at any value other than 100% with a black and white 
monitor setting results in an opaque effect. 

NOTE: To set an Actor's tranparency, see Sequence Opacity below. 
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Sequence Opacity 

The level of Opacity can be set on Actors using the Sequence Opacity 
Mode and the Cel Sequencer. In color mode, setting the level of 
opacity blends the Actor's colors (including completely outlined 
areas of white) with the colors of any objects behind it. Fully opaque 
is 100% and fully transparent is 0%. Setting the level of opacity at 
any value other than 100% with a black and white monitor setting 
results in a fully opaque effect. For information on using the Cel 
Sequencer to define opacity levels, see Setting Opacity in Chapter 7: 
Creating an Animation. 

NOTE: Opacity Changes made in the Cel Sequ~er will only display if the 
drawing mode is set to Seq~e Opacity. 

Matte Effect 
Matte Effect lets you choose a Prop that the Actor uses to create the 
matte. The Actor acts like a cookie cutter, cutting a section out of the 
Prop and displaying it where the Actor would normally appear. 
Matte Effect is most effective if you disable the Prop by clicking its 
checkbox in the TirneLines window. 

In the example below, the circle is the Actor to be matted to the 
Pattern Prop. 
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The Drawing mode for the circle Actor is set to Matte Effect, and the 
Pattern Prop is selected in the pop-up menu. The Pattern Prop 
should be disabled in the TimeUnes window. 

eel Mode: I Matte Effect ... 11 Pettern ... 1 

;;Di;;;;~;~;;;;;m~;m;;;;g;;;~;;g;;;;;~g;g~;m;;;~;:;~;~;i;~;~:~;m;:;;l~;;;;;;;;;;;;;g;;;~~;;;~;;;;;~;i;;;;;~;;;m;;;;;ll;g;;;mll;;;;;;;;;ml;;;gmi;;;m;;;;e];; 

TimrLinrs for [x.mDlr 

R!~m~1I111 ~""",,?,~ ....... l.?? .... l.r? ....... ~~~I 
181 ~!C;rcJ. Q 
o "P~ttt'rn 

Start: End: ¢I 
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Chapter 10: Tips and Techniques 

This chapter explains some of ADDmotion II's more advanced 
features. 

Load and Stamp Events 
Load and Stamp events can help advanced users of ADDmotion II 
save memory and increase speed in their more complex animations. 

A Load event loads any currently unloaded Actors, Props and 
Sounds whose start frames occur between the event's start frame 
and the next Load event. If you add no Load events to your anima­
tion, ADDmotion II loads all Actors, Props and Sounds at start up. 
(There is an implicit Load event at the first and last frames of every 
animation.) If your animation is complex, this initial loading can be 
time consuming. 

You can take advantage of natural pauses in your animation, such 
as when the viewer is reading text on the screen, by adding Load 
events which load objects at these times. These Load events save 
memory and make your animation flow more smoothly. 

A Stamp event can save production time by taking all Actors and 
Props on a screen at a specific frame and freezing them in place in 
the background or prop layer of the animation until the end frame 
specified. You can then add Actors which move in their own layers 
in front of the "stamped" background layer. Adding new Props to 
the animation during this period invalidates the stamp event; the 
stamped background disappears as soon as new Props appear. 

Two or more Stamp events can have different start frames and 
"overlap" on a number of frames. 

A Continuous Stamp event is the same as a Stamp event except that 
it occurs on every frame from the start to the end frame, rather than 
just on the start frame. 

To create a load or stamp event: 

1. Choose Add Event from the Edit menu, or click the Event icon 
in the Media Controller. 
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The Event Information dialog appears. 

Euent Information .•• 

Name: 

Start frame D 
( Cancel 1 

® lOlld Euent 
o Stllmp Euent n OK D 
o Continuous Stllmp Euent 

2. Enter a name for the event in the Name field. 

3. Enter a number of the Start Frame field. 

4. Click Load Event if you want to load an Actor or Prop that will 
appear later in the animation. 

S. Click Stamp Event if you want to freeze all Actors and Props on 
screen in the start frame specified. If you select Stamp Event 
you must also enter a number in the End Frame field. 

6. Click Continuous Stamp Event if you want a stamp event on 
each frame that it is active. If you select Continuous Stamp 
Event, you must also enter a number in the End Frame field. 

7. Click OK. 

Once added to your animation, these events can be changed using 
TimeLines. Open the TimeLines window, then click the Events icon 
which appears as a clock. 

Making QuickTime™ Movies 

ADDmotion II lets you tum your animations into QuickTime Mov­
ies. You must have QuickTime installed on your hard disk for the 
necessary menu item to be enabled. 

1. Choose Export - Movie from the File menu. 

2. Enter a name for the QuickTime movie, then click Save. 

The Enter Window Size dialog appears. 
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Enter Window Slz .... 

Width @D 
Height ItMI 

3. Type in new dimensions for the movie window or 
accept the default size, then click OK. 

A QuickTirne file is created. Double-dick its icon to play 
it. Once running, you can move through the movie frame 
by frame by clicking the forward and backward step 
buttons, or by clicking and dragging in the play bar at the 
bottom of the window . 

..- Rnlmated Rbout BOM.QT 

.011 .. 110111 

ADDmotion II 
VERSION 1 

~nDIIII: .. _,CI. ... predu,t. uu t.ur UI~ II UIIU 1 t . 
• '1~i' 'i'i'lIllOTIOfJVI'OIUCS '=CII'OIIi.1I0f4 

r .... ·lllli ...... "'.,."...,. "0,""4 •• "'''', ~r .. 

NOTE: You must have one of the QuickTime Players installed for this to 
function. 

Runtime Animations in Stacks 
In this section you willleam how ADDmotion II installs the Runtime 
XCMDs into the stacks that you create and some suggestions and 
tricks on how to script animations. These new tasks include: 

• understanding the ADDmotion II Runtime package and its 
components 

• applying scripting techniques to create effective animations 
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These XCMDs are automatically copied into any stack in which you 
create animations or export to. This is done to ensure that all of your 
stacks will be able to play the animations that you create. 

NOTE: This section assumes that you are familiar with HyperCard script­
ing and HyperTalk. If you are unfamiliar with scripting or HyperCard, 
please read the HyperCard Script language guide published by Claris 
Corporation or a third party book related to scripting. 

USing ADDmotion II to Create Color Cards and Buttons 
The ADDmotion II Runtime can be used to colorize cards easily and 
effectively by creating an animation that lasts only one frame and by 
setting Preserve Card Image and Leave Last Frame to true. 

The ADDmotion II Runtime Package 
The ADDmotion II Runtime package is composed of three separate 
XCMDs: AM Load, AMPlay and AMRelease. These XCMDs, syn­
taxes, examples and descriptions are: 

1. AMLoad 

Syntax: AMLoad "AnimationName" 

put the result into variable 

Example: AMLoad. "Desert Macaw" 

put the result into myanimation 

Description: AM Load loads an animation into memory and puts a 
pointer to that animation into the result (the pointer is a number that 
is used by AMPlay and AMRelease). You then put the result into a 
variable. You need only load an animation once; loading more than 
once is a waste of time and memory. the result will contain an 
error message if the animation was not loaded. Errors occur when 
the animation name is misspelled, HyperCard does not have enough 
memory allocated to it, or the animation is corrupted. If you want to 
play the animation from another script, you must declare the vari­
able used as a global variable. 

Syntax: global variable 

AMLoad "AnimationName" 

put the result into variable 
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Example: global myanimation 

AMLoad "Desert Macaw" 

put the result into myanimation 

2. AMPIay 

Syntax: AMPlay variable 

Example: AMPlay myanimation 

Description: AMPlay plays animations that have been previously 
loaded with AMLoad. Animations can be played more than once 
and are not released from memory after being played. If you are 
playing the animation from a different handler than the one that 
loaded the animation, be sure that the variable is declared as being a 
global variable. 

3. AMReleose 

Syntax: AMRelease variable 

Example: AMRelease myanimation 

Description: When AMRelease is called, the animation is released 
from memory. This is useful when memory is low and you want to 
load another animation or you no longer need the animation. If you 
are playing the animation from a different handler than the one that 
loaded the animation, be sure that the variable is declared as being a 
global variable. 

NOTE: If an animation does not play, load or reletlSe, check the scripting. 
There are times when an animation might not load. If you try to load and 
play an animation and it just beeps, there could be a problem with the way 
HyperCard cached the runtime XCMDs. To solve this problem, quit 
HyperCard to the Finder, then Open the stack that the animation is in. 

Loading, Playing and Releasing an Animation 
An example script for loading, playing and then releasing an anima­
tion could be: 

On MouseUp 

AMLoad "Desert Macaw" 

put the result into Macaw 
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AMPlay Macaw 

AMRelease Macaw 

End MouseUp 

Scripting Techniques for Creating Animations 
Since the ADDmotion II Runtime is composed of three separate 
XCMDs and is based in HyperCard, the animations and inter­
activity that you can create are limitless. This section gives you a 
few ideas on how to use the ADDmotion II Runtime most effec­
tively. 

Preloading Multiple Animations at One Time 

It is sometimes advantageous to load animations when the user first 
enters a stack, background or card. One way around this is to load 
the animation before the user needs it. The number of animations 
that you can preload is based on the amount of RAM that you have 
and the size of the animations. An example script could be: 

On OpenStack 

this script executes when the user enters 

the stack, loads the animations into memory 

and puts pointers to' the animations into 

-- global variables 

global bird, fish, buffalo 

AMLoad "Bird" 

put the result into bird 

AMLoad "Fish" 

put the result into fish 

AMLoad "Big Animal" 

put the result into buffalo 

End OpenStack 
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On MouseUp 

this script plays the animations previously 

loaded 

global bird, fish, buffalo 

AMPlay bird 

AMPlay fish 

AMPlay buffalo 

End MouseUp 

On CloseStack 

-- this script releases the animations and 

-- global variables from memory 

global bird, fish, buffalo 

AMRelease bird 

AMRelease fish 

AMRelease buffalo 

put empty into bird 

put empty into fish 

put empty into buffalo 

End CloseS tack 

If you load animations in one handler and play them in another, it is 
important to release that animation when you no longer need it. If 
you do not, you will have less memory available to use. 

linking and Exporting Animations 
ADDmotion II automatically scripts your animations when you 
choose Link or Export from ADDmotion II's File menu or Link 
Animation from HyperCard's File menu. If the Link Animation 
menu item is disabled, there are no animations in this stack to be 
linked. 
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Unk - New Buffon 

Choose Link - New Button (or choose Link Animation from Hyper­
Card's File menu, then click Button) to create a button with the same 
name as the current animation. You can place the button wherever 
you want on the card. 

Unk - Stack Script 

Choose Link - Stack Script (or choose Link Animation from Hyper­
Card's File menu, then click Stack Script) to create a script with a 
script level handler that you specify. The default handler name is 
"OpenStack" . 

Unk - Background Script 

Choose Link - Background Script to create a script with a back­
ground level handler that you specify. You can select which back­
ground you want the handler in by moving the cursor to either the 
left or right side of the card. Moving the cursor to the left side of the 
card displays the previous background and moving the cursor to the 
right side of the card displays the next background. The default 
handler name is "OpenBackground". 

Unk - Card Script 

Choose Link - Card Script (or choose Link Animation from Hyper­
Card's File menu, then click Card Script) to create a script with a 
card level handler that you specify. You can select which card you 
want the handler in by moving the cursor to either the left or right 
side of the card. Moving the cursor to the left side of the card dis­
plays the previous card and moving the cursor to the right side of 
the card displays the next card. The default handler name is 
"OpenCard". 

Export - New Stack 

Choose Export - New Stack to create a new stack with a name that 
you specify and copies the animation and the ADDmotion II 
Runtime into it. The default name for the stack is the same as your 
animation. 
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Export - Stack Script 

Ch~ Export - Stack Script to select a stack to export to, and copy 
the arumation and the ADDmotion II Runtime into it. The default 
name for the handler created to run the animation is "OpenStack". 

Export - Background Script 

Choose Export - Background Script to select a stack to export to, and 
copy the animation and the ADDmotion II Runtime into it. You can 
select which background you want the handler in by moving thc 
cursor to either the left or right side of the card. Moving the cursor to 
the left side of the card displays the previous background and 
moving the cursor to the right side of the card displays the next 
background. The default name for the handler created to run the 
animation is "OpenBackground". 

Export - Cad Script 

Choose Export - Card Script to select a stack to export to, and copy 
the animation and the ADDmotion II Runtime into it. You can select 
which card you want the handler in by moving the cursor to either 
the left or right side of the card. Moving the cursor to the left side of 
the card displays the previous card and moving the cursor to the 
right side of the card displays the next card. If there is only onc card 
in the stack, this feature is disabled. The default name for the han­
dier created to run the animation is "Open Card". 

Using Cues to Create More Interaction 
Cues allow you to control the flow of your animation, to add 
interactivity and send messages to other applications. It is possible 
when one animation is playing to call another animation. This new 
animation can call other animations and so on and so on ... If you 
want to create an animation that waits for the user to do something 
before continuing, or branch out and play another animation, you 
can create a couple of Cues to do this. Here's how: 

At any frame you can send a Cue to HyperCard to do anything that 
HyperTalk or other XCMDs can do. For example, if at a certain 
frame, say 100, you want the user to select something on the card, 
you can create a Cue that calls a handler that waits for a specific 
condition to occur. In this instance, the Cue would be WaitForUser. 
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on WaitForUser 

wait until the mouse is down and the mouseloc ~ 

is within the rect of card button "continue" 

end WaitForUser 

Once frame 100 is reached, ADDmotion II would wait until the user 
clicked on the button "continue". 

If you want to play another animation at this point, or want the user 
to make a choice to play another animation, the above script could 
be modified as follows: 

on WaitForUser 

wait until the mouse is down 

if the mouseloc is within the rect of ~ 

card button "continue" then 

AMLoad "Bird" 

put the result into bird 

AMPlay bird 

AMRelease bird 

end if 

end WaitForUser 

At frame 100 the current animation will stop and wait for the user to 
click the mouse. If the user clicks on the button "continue", the bird 
animation will load, play and then release. If the user does not click 
on the "continue" button, the current animation will continue. When 
the bird animation is finished, the previous animation will continue 
where it left off. 

A way to achieve the above without waiting for the user to click 
would be to check" Allow Card Clicks" in the Animation Options 
dialog. With this feature checked, the user can interact with any 
buttons or fields on the card. If you had set the MouseUp handler of 
the "continue" button to the following, the bird animation would 
play and the current animation would continue if the user clicked on 
it. 
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On MouseUp 

AMLoad "Bird" 

put the result into bird 

AMPlay bird 

AMRelease bird 

End MouseUp 

Another way is to send Cues throughout the animation by setting 
the Start and End Frames of the Cue for a range. An example of this 
could be as follows. 

on WaitForUser 

if the mouseloc is within the rect of ~ 

card button "continue" then 

AMLoad "Bird" 

put the result into bird 

AMPlay bird 

AMRelease bird 

end if 

end WaitForUser 

If a Cue was added to be sent starting from 1 to 100, the bird anima­
tion would playas soon as the mouse was within the button "con_ 
tinue". 

Advanced Cues 
Below are some common applications designed to give you more 
exposure to the concept of Cues. The possibilities are endless. You 
should be familiar with the Add Cue section of Chapter 9: Menus and 
Dialogs. 

Sending Messages to HyperCard 
One of the most important commands to become familiar with is 
Send HC Message. Messages allow your animation to communica te 
with HyperCard, increasing user interactivity. 
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This Cue sends a INextAnim" message to HyperCard on frame 5 of 
the animation. The animation will pause as the NextAnim handler 
executes. 

Cue Informallon ... 

Name: I SEND TO HC 

t8I Do before frllme is drllwn 

,- Condition - ----- - ----- - --- ----- - . 

! I Rlways "'1 

Start Frllme: ~ 
End Frllme: ~ 

. _ .. _ ..... - - - ... -- "j 

I 
j 
I 
I 
I 
I 

-- - - ~- - -- ---- ---- - ----_._-- --_ .. -- ---_. -- - - -- -- ----_ ... _-_.j 

Create a NextAnim handler at the card level to read a card field and 
run another animation based on its contents. 

Here is an example of if card script: 

On NextAnim 

if card field "Toggle" contains "Two" then 

AMLoad "Two" 

put the result into T 

AMPlay T 

AMRelease T 

else 

AMLoad "Three" 

put the result into T 

AMPlay T 

AMRelease T 

end if 

end NextAnim 

218 ADDmotion II Manual 



NOTE: For more information on HyperTalk messages, see your HyperTalk 
manual. 

Once a message has been sent to HyperCard, the handler can do 
anything HyperTalk or other XCMD's can do. Although our example 
ran other animations, it could have pre-loaded animations, called 
other XCMD's or updated a card field. 

Creating Loops in Your Animation 
Creating a loop allows animations to be broken up into segments, 
repeatedly playing a segment until another condition is met. If you 
want to wait for the user to press an animated button, or let an intro 
animation play repeatedly until a Sound completes, looping is a 
valuable tool. 

In this example Cue, the animation segment will play frames 1 to 24 
repeatedly. The Cue is placed on frame 24 and does an Always Coto 
Frame 1 command. 

CUB Informlltion .•• 

Nllme:~IL_oO_P __________________ ~ 

o Do before frllme Is drllwn Stert Frame: ~ 
[ndFrllme: ~ 

~[ondition 

: I Rlweys ... 1 
i 

-.~ 

~---------------------

-[omm~lIn~d~;=======~~==~------~ 
i lh." I ,.,. lnom. y r=J I 

Exiting Loops 

[cencel) 

I OK I 

When you have set up a loop as in the previous example, you will 
likely want to exit the loop and continue with the animation. The Cue 
below constantly checks to see if the "music" Sound has completed 
playing, then advances the animation to frame 26. The result of this 
and the previous Cue is an introduction that will wait for the Sound 
to complete before continuing to the next segment. 
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Cue Information ... 

Name: 1~I_n_tr_o ______________________ ~ 

o Do before frame Is drllwn Start Frame: ~ 
End Frame: EJ 

r Condition - ... , ... __ ..... , ..... __ ... 

I I r ..... 11 Sound Done 

I music ..... 1 

,··Command .. --_ .... , ....... --- .......... ---. 

Then: I 60to Frame ..... I~ 

I 

. ........ ---.... -l ( Cancel) 

t OK J 

Time Outs 

When designing presentations that users can interact with, include a 
Time Out Cue that will give the user a reasonable period of time to 
respond. After that time, the Cue will send the animation back to the 
beginning. In this way, the presentation can reset if the user walks 
away. 

An If Time 600 Goto Frame 1 Cue gives the user a period of time to 
respond before sending the animation to frame 1. Time is measured in 
ticks, with 60 ticks per second, thus this Cue waits 1.5 minutes. If at 
any time the animation jumps outside of the Start Frame-End Frame 
range of the Cue, the Cue becomes inactive. 
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Nllme: ITime Out 

o Do before frame is drawn 

,Condition -

I I If ..... 11 Time 

Start Frame: ~ 

End Frame: ~ 

" Command ._. _ ... - .. _,._ .... _ .... _ ... _._ .. _ ... _ . __ .... _ .. ,_, 

: Then: I (iolo frame "'I~ I [ Cllncel 1 
, , n OK J 
-- ~.- _ .... _- ~.-. - - "-- "-"- - ._- "-, --. _ .. ,,_. __ .. .1 
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selection 89 

Anticipation 22 
Appeal 25 
Articulate Systemsnl 29, 115 
AutoExtractorni 7, 9 
Auto Replay 194 
Auto Scroll 126 

B 
Background Colors 194 

editing 81 
selecting 80 

Background pop-up pal-
ette 80 

Backing up 6 
Bring Ooser 121,175 
Bring to Front 121 
Brush Shape 

editing 73 
selecting 100 

Brush Shape dialog 100 
Brush tool 73 

C 
CD-ROM 30 
Cel Counter 82 
Cel Cycle Arrows 81 
Cel modes 203 

matte effect 198,205 
opaque 198, 203 
transparent 198,204 

Cel Sequencer 52, 126, 129 
controlling eels 54 
modes 53 

Cels 27 
anti-alias all 83 
controlling individual 54 
controlling range of 54 
fill all 82 
flip all 84 
flipping 85 
editing all 59 
editing individual 58 
inserting 57,82,1'72 
invert all 82 
opacity ranges 135 
removing 1'72 
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rotate all 84 
scale all 59,84 
scaling 85 
sequencing 129 
setting mode 198 
setting opacity 134 
setting size 130,203 
setting to show 132 
size ranges 131 
show first 81 
show last 82 
show next 81 
show previous 81 
tint all 83 
trace all edges 83 
tweening 84 

Clearing 171 
Color Buttons 210 
Color Pick-up tool 69, 76 
Color Wheel dialog 98 
Colors 

background 194 
editing 80,97 

Continuous Stamp 
Events 207 

Copying 171 
images 71, 72 
Sounds 157 

Cue Info dialog 120 
Cues 28, 30 

adding 120,177 
advanced 217 
defining 60 
deleting 146 
interactivity 215 
naming 61, 64 
setting command 61, 65 
sctting condition 61, 64 
Time Outs 220 

Cursor 
hiding 194 

Curve tool 78 
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Cutting 171 
Sounds 157 

Cycle arrows 57 

D 
Disabling objects 66 
Disinfectant 2.}TloI 4 
Distributing 125 
Draw Centered 77,101 
Draw Filled 77,101 
Draw Multiple 77, 101 
Drawing modes 

opaque 203 
sequence opacity 205 
transparent 204 

Duplicating 171 
cel contents 109 

E 
Edit Brush Shape 73 
Edit Colors 80 
Edit Gradient 99 
Edit Pattern dialog 100 
Edit Patterns 79 
Edit WaveForm for Sound 

dialog 152 
Enabling objects 66 
End Frame 31 

adjusting 144 
Ending animation 64 
Eraser tool 76 
Event Information dialog 121, 

208 
Events 30 

adding 121 
Load 121 
Stamp 121 

Exaggeration 25 
Example Animation 34 
Example Stack 34 
Exporting 

animations 213 
Background Script 215 

Card Script 215 
graphics 95 
New Stack 214 
PICS 165 
Props 165 
QuickTime movies 165 
Sounds 165 
Stack Script 215 
stand alone player 165 

F 
Fast Forward 119 

speed 193 
Fast Rewind 119 
Fatbits mode 72, 73, 97 
Fill All Cels 82 
Fill Selection 88 
First Frame 173 
Flip All Cels 84 
Flip Horizontally 128 
Flip Selection 91 
Flip Vertically 128 
Font 

selecting 75 
size 76 
styles 76 

Foreground Colors 
selecting 80 

Foreground Fill Color pop­
up 80 

Forward 
step frame 119 

Frame Counter 118 
Frames 

changing number 193 
go to last 118 
go to previous 173 
leave last 195 
show count 195 
show number 184 
show rate 195 
start 197 



G Interactivity 215 Path mode 122 
GetInfo 174 Invert All eels 82 Play 119 
Gradient Invert Selection 88 Play Only mode 117 

editing 99 
K show 183 

shaping 99 Keep Paint 59,95 Media menu 183 
Graphics Media Sampler disk 3 

exporting 95 L Memory meter 147 
importing 93 Lasso tool 71,75 Menu Bar 

Grid Animation 126 Last Frame 173 hiding 194 
Grid Size 140,193 Layers Movies, QuickTime 

H Bring Ooser 121, 175 exporting 165 

Help 15 Bring to Front 121 MultiFinder 195 
Send Farther 122 operating with 5 Animated Help 16 
Send to Back 122 Multimedia Balloon Help 15 

Leave Last Frame 195 uses 17 Hide AI1183 line tests 20 Hide Cursor 194 line tool 77 N 
Hide Menu Bar 194 line Width pop-up 77, 81 New Actor dialog 105, 107 
Hide Palettes 194 New Actor/Prop 181 
HyperCard 

linking 
Next Frame 173 animations 214 linking to 68 Background Scripts 214 0 sending messages to 217 buttons 214 Object Selection tool 119 HyperCard link 64 Card Scripts 214 Objects 

I Stack Scripts 214 deleting 146 
Importing Load events 121, 207 disabling 66 

Actors 163, 186 Locking 198 enabling 66 
content 38 Loop point 136 Onion Skin 26,57, 101, 109 
graphics 93 Looping animation 62, 124, Opacity ranges 135 
MacPaint 93 136,219 Open Actor/Prop 182 
paths 163 exiting 219 Options menu 97 
PICS 94,163 on/off 118 Oval tool 78 
PICTs 93, 163 stopping 63 p 
Props 163, 189 M Page Setup 169 
SND files 163 MacRecorder 115 Paint 26 
Sounds 163 Marquee tool 70, 75 effects 82 

INITs 4 Matte Effect 198,205 information 203 
Ink Effects Media Controller 28 tools, show 183 

opaque 92 Fast Rewind 119 Paint Bucket tool 74 
transparent 93 First Frame 118 Paint Editor 56 

Insert Cels 172 Frame Counter 118 Palettes 
dialog 57,82, 109 Loop 118 hiding 183,194 

Installation 6 
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Pasting 171 
Sounds 158 

Path Information 47,126 
Path Information dialog 47 
Path Library 47, 197 
Path Options dialog 48,125 
Path points 

deleting 138 
distributing SO, 125 
information 124 
moving off-screen 48 

Path tool 123 
Paths 27,29 

adding 138 
adding points 136, 138 
creating 45, 135 
deleting range 139 
flip horizontally 128 
flip vertically 128 
importing 163 
information 126 
looping 51, 124, 136 
moving 137 
moving range 140 
options 125 
point distributing 125 
point information 124 
plotting 47 
refining 50 
reverse points 127 
scaling 50, 124, 139 
selecting range 139 
size 126, 140 

. smoothing 127, 139 
Patterns 

editing 79,100 
selecting 79 

Pause animation 60, 119 
Pencil tool 58, 72 
PICS 

exporting 165 
Place Actor 176 
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Place Prop 177 
Play animation 118 
Play Indicator 145 
Points 29 
Polygon tool 79 
Preserve Image 195 
Previous Frame 173 
PROmotion 

creating file 166 
Principles of Animation 

disk 22 
Prop Information dialog 198 
Props 28 

creating 115 
duplicating 188 
exporting 165 
importing 163,189 
information pop-up 141 
locking 200 
naming 199 
new 181,188 
opening 182 
placing 40,120, 177, 189 
previewing 188 
renaming 188 
sample 3 
start frame 199 
transitions 42, 121, 200 

Q 
QuickTime movies 208 

exporting to 65 
Quitting 170 

R 
Recent Colors 81 

changing 81 
Recent Colors palette 76 
Rectangle tool 77 
Registration 

changing 103 
of Actors 102 

Remove eel 172 

Resouree files 4 
Reverse 

animation 118 
path points 127 
step frame 119 

Revert Paint 95 
Rewind 

speed 193 
Rotate 90 

all eels 84 
selection 90 

Rounded Rectangle tool 78 

S 
SAM lIn! 4 
Scale Path dialog 50 
Scaling 

all eels 84 
points in a path 139 

Script 19 
Scroll 201 
Select a Prop dialog 120 
Select All 171 
Select an Actor dialog 120 
Select a Sound dialog 149, 190 
Selection tools 

Lasso 71 
Marquee 70 

Send Farther 122, 172 
Send to Back 122 
Sequency Opacity 205 
Shape tools 77 
Shapes 

borderless 77 
constraining 77 
Draw Centered 77 
Draw Filled 77, 101 
Draw Multiple 77 
gradient 99 

Show 
First Cel 81 
Frame Count 195 



Frame Number 184, 195 
LastCei 82 
Media Controller 183 
NextCel81 
Paint Tools 183 
Previous Cel 81 
TimeLines 183 

Show Frame Number 
dialog 118 

Smoothing 123, 127 
apath 139 

Sound Infonnation 
dialog 149 

Sounds 26, 29 
adding 4, 120, 177 
changing 149 
channelling 151 
clearing 158 
compressing 156 
copy 157 
cutting 157 
deleting 146 
duplicating 191 
echo 155 
editing 152 
end frame 150 
exporting 165 
fade in 152 
fadeout 152 
importing 163,191 
length 149 
louder 154 
lower frequency 156 
on/off 118 
pasting 158 
previewing 190 
raise frequency 156 
ramping down 156 
ramping up 156 
recording 115 
removing 191 
renaming 191 

selecting 190 
replacing 149 
reversing 155 
sample 3 
setting priority 150 
softer 154 
start frame 150 
volume 151, 156 
wavefonn 152 

Soundtrack 20 
Speed 193 
Spray Can tool 75 
Stacks 

creating new 3S 
Staging 24 
Stamp events 121, 2fJ1 

Continuous 2(11 
Stand alone player 

exporting 165 
Start frame 

adjusting 143 
Step frame 

forward 119 
reverse 119 

Stop animation 118,194 
Storyboard 20 
Stretch 22 
System 6 

T 
Technical support 1 
Text 

attributes 75 
Text tool 7S 
Time Lines 31 

adjusting 65,67,143-144 
checkboxes 143 
deactivating objects in 66 
moving whole 144 
object icons 143 
resizing window 66,142 
show 183 

Timing 2S 
Tint 

all eels 83 
selection 88 

Tools 
Brush 73 
Color Pick-up 69, 76 
Curve 78 
Eraser 76 
Lasso 71 
Une 'il 
Marquee 70 
Object Selection 120 
Oval 78 
Paint Bucket 74 
Path 123 
Pencil 72 
Polygon 79 
Rectangle 77 
Rounded Rectangle 78 
SprayCan 7S 
Text 7S 

TraeeEdges 
all eels 83 
selection 89 

Transitions 42 
methods 201 
speed 202 
steps 202 

Tutorial 33 
TwecnCeI84 
Tweening 84 

Undo 171 
Upgrading 

U 
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V 
Video 83 
Videodisc 30 
Visual effects 28 
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w 
WaveForm 

copying 157 
cutting 157 
pasting 158 
preview 190 
select all 158 
zooming in 153 
zooming out 153 

Windows 
hiding all 183 

XCMD 210 

ZoomIn 97 
ZoomOut 97 

X 

z 
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